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FOREWORD 

Since its establishment in 1976, Acharya Nagarjuna University has been 

forging ahead in the path of progress and dynamism, offering a variety of courses 

and research contributions. I am extremely happy that by gaining ‘A+’ grade from 

the NAAC in the year 2024, Acharya Nagarjuna University is offering educational 

opportunities at the UG, PG levels apart from research degrees to students from 

over 221 affiliated colleges spread over the two districts of Guntur and Prakasam.  

The University has also started the Centre for Distance Education in 2003-

04 with the aim of taking higher education to the door step of all the sectors of the 

society. The centre will be a great help to those who cannot join in colleges, those 

who cannot afford the exorbitant fees as regular students, and even to housewives 

desirous of pursuing higher studies. Acharya Nagarjuna University has started 

offering B.Sc., B.A., B.B.A., and B.Com courses at the Degree level and M.A., 

M.Com., M.Sc., M.B.A., and L.L.M., courses at the PG level from the academic 

year 2003-2004 onwards.  

To facilitate easier understanding by students studying through the distance 

mode, these self-instruction materials have been prepared by eminent and 

experienced teachers. The lessons have been drafted with great care and expertise 

in the stipulated time by these teachers. Constructive ideas and scholarly 

suggestions are welcome from students and teachers involved respectively. Such 

ideas will be incorporated for the greater efficacy of this distance mode of 

education. For clarification of doubts and feedback, weekly classes and contact 

classes will be arranged at the UG and PG levels respectively.  

It is my aim that students getting higher education through the Centre for 

Distance Education should improve their qualification, have better employment 

opportunities and in turn be part of country’s progress. It is my fond desire that in 

the years to come, the Centre for Distance Education will go from strength to 

strength in the form of new courses and by catering to larger number of people. My 

congratulations to all the Directors, Academic Coordinators, Editors and Lesson-

writers of the Centre who have helped in these endeavors.  

Prof. K. Gangadhara Rao 

M.Tech., Ph.D., 

Vice-Chancellor I/c  

Acharya Nagarjuna University. 
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LESSON-1 

HISTORY OF COMPUTERS 
 

LEARNING OBJECTIVES 
 
At the end of this lesson, the learner should be able to: 

1. Explain the historical evolution of computers from early calculating devices to 
modern systems. 

2. Analyse the technological characteristics of different generations of computers. 
3. Distinguish between various types of computers based on size, purpose, and data 

processing methods. 
4. Apply knowledge of computer evolution to healthcare and hospital information 

systems. 
5. Evaluate the impact of computer development on healthcare management and service 

delivery. 
 
Structure 
 
1.0 INTRODUCTION 

1.1 A BRIEF HISTORY OF COMPUTERS 

1.2 GENERATIONS OF COMPUTERS 

1.3 TYPES OF COMPUTERS 

1.4 SUMMARY 

1.5 KEYWORDS 

1.6 SELF-ASSESSMENT QUESTIONS 

1.7 SUGGESTED READINGS 

 
1.0 INTRODUCTION 
 
Necessity is the mother of invention. The saying holds true for computers too. Although 
computers seem like a modern invention, computing dates back to the early 1800s. Computers 
were invented because of human’s search for accurate and fast calculating devices. Basic 
Pascal invented the first mechanical adding machine in 1642. Later, in 1671, Keyboard 
machines originated States around 1880, and we use them even today. Around the same period, 
Herman Hollerith came up with the concept of punched cards that were extensively used as an 
input medium in computers even in the late 1970s. 
 
A nineteenth-century Professor at Cambridge University, Charles Babbage, is considered the 
father of modern digital computers. Today computers are different from earlier days based on 
appearance and performance. However, present-day computers have undergone significant 
changes for the last seven decades. 
 
1.1 A Brief History of Computers 
Primitive people used the first counting device. Earlier, people used their fingers, stones, bones, 
and pebbles as counting tools to do calculations. More computing devices were developed as 
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the human mind and technology improved with time. The first use of the word “Computer” 
was documented in 1613, referring to an individual who carried out calculations or 
computations, and the term persisted in being used in that sense until the middle of the 20th 
century. 
Some of the popular computing devices, starting with the first to recent ones, are described 
below: 
1. Tally Sticks 

Tally 
Sticks. 

A tally stick (or tally) was an ancient memory aid device to record quantities, numbers, or 
messages. Tally sticks first appear as animal bones carved with notches during the Upper 
Palaeolithic (also known as Late Stone Age). Tallies have been used for numerous purposes, 
from messaging and scheduling, especially in financial and legal transactions, to being a 
currency. 
2. Abacus 
The Abacus, which appeared about 5,000 years ago in Asia Minor and is still in use today, is 
one of the first mechanical calculating devices that lets users do computations using a system 
of sliding beads arranged on a rack. Early traders used Abacus to keep trading transactions. An 
image of the Abacus is shown below. 

Abacus. 
3. Napier’s Bone 
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Napier’s Bone was invented in 1614 by a Scottish Mathematician, John Napier of Merchiston 
(1550-1617). He also played a crucial role in the development of Logarithms. Napier’s Bone 
was a manually operated calculating device that let the operator multiply, divide, and calculate 
square and cube roots by moving the rods around and placing them in specially made boards. 

Napier’s Bone. 
He used 9 different ivory strips or bones marked with numbers to multiply and divide in this 
calculating tool. So, the device became known as Napier’s Bones. It was also the first machine 
to use the decimal point. 
 
4. The Slide Rule (1620-1230 AD) 
The slide rule was invented around 1620–1630 AD, shortly after John Napier publicized the 
concept of the logarithm. In 1620 Edmund Gunter of Oxford developed a calculating device 
with a single logarithmic scale. In 1622, William Oughtred of Cambridge combined two 
handheld Gunter rules to make a device that is recognizably the modern slide rule. 

The Slide Rule. 
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The slide rule is considered the first analog computing device that works on the logarithms 
principle. The slide rule was used until the mid-1970s, when the first handheld calculators and 
microcomputers appeared. 
 
5. Pascaline (1623-1662 AD) 
 In 1642, Blaise Pascal, a French mathematician, invented the first mechanical machine, a 
rectangular brass box called Pascaline (also known as Pascal’s calculator or arithmetic 
machine) which could perform the addition and subtraction on whole numbers. Pascal invented 
this device to help his father, a tax accountant.  
Pascal’s device was a wooden box with a series of gears and wheels with 10 teeth each. It 
represents the numbers 0 to 9. As each gear made one turn it. When a wheel is rotated one 
revolution, it rotates the adjoining wheel. A series of windows is given on the top of the wheels 
to read the totals. An image of Pascaline is shown below. 

A Pascaline signed by Pascal in 1652 
A computer programming language, Pascal, was later named to honor his contribution. 
 
6. Stepped Reckoner or Leibnitz Wheel 
In 1694 AD, a German mathematician-philosopher, Gottfried Welham Von Leibniz, enhanced 
the Pascaline by creating a machine called Stepped Reckoner (also known as Leibnitz 
calculator) that could add, subtract, multiply and evaluate square roots by series of stepped 
additions. Leibniz was the first to support the use of a binary number system. 
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Replica of Leibniz’s stepped reckoner in the Deutsches Museum. 
Leibniz got the idea for a calculating machine in 1672 in Paris from a pedometer. Later he 
learned about Blaise Pascal’s device when he read Pascal’s Pensees. He focused on expanding 
Pascal’s mechanism so it could multiply and divide. 
7. Jacquard’s Loom Machine 
In 1804, Joseph Marie Jacquard, a French silk weaver, invented a device fitted to an automated 
loom that used punched cards as a pattern to weave complex designs and patterns. The resulting 
ensemble of the Jacquard machine and the loom is then called a Jacquard Loom.  

Jacquard Loom Machine. 
A chain of cards controlled the machine; several punched cards laced together into a continuous 
sequence. Numerous rows of holes were punched on each card, with one complete card 
corresponding to one design row. This use of replaceable punched cards to control a series of 
operations is considered an essential step in the history of computing hardware, having inspired 
Charles Babbage’s Analytical Engine. 



Centre for Distance Education                         6                    Acharya Nagarjuna University 
 

 
8. Difference Engine & Analytical Engine (Babbage’s Engine) 
A British mathematician at Cambridge University, Charles Babbage, invented the 
first Difference Engine or Analytical Engine.  
In 1822, Charles Babbage conceptualized and began inventing the Difference Engine, 
believed the first automatic computing machine could approximate polynomials. The 
Difference Engine was adept at computing several sets of numbers and making hard copies of 
the results. Babbage received some help with inventing the Difference Engine from Ada 
Lovelace, considered the first computer programmer for her work.  
Unfortunately, Babbage could never finish a full-scale functional version of this machine 
because of funding. In June 1991, the London Science Museum completed the Difference 
Engine No 2 for the bicentennial year of Charles Babbage’s birth and later finished the printing 
mechanism in 2000. 

Difference Engine & Analytical Engine. 
In 1837, Charles Babbage proposed Analytical Engine, the first general mechanical computer. 
The Analytical Engine contained: 

 An Arithmetic Logic Unit (ALU). 
 Punch cards (inspired by the Jacquard Loom). 
 Integrated memory. 
 Basic flow control. 

It is the first general-purpose computer concept that could be used for multiple things and not 
only one particular computation.  
Unfortunately, this computer was also never built while Charles Babbage was alive because of 
budget issues. In 1910, Charles Babbage’s youngest son, Henry Babbage, completed a portion 
of this machine and performed some basic calculations. 
Charles Babbage is known as ‘the father of the modern digital computer’ for his 
contributions.   
 
9. Lady Augusta Ada Lovelace (First Computer Programmer ) 
Lady Augusta Byron, Countess of Lovelace (1815 – 1852 AD), was an English mathematician 
mainly known for her work on Charles Babbage’s proposed mechanical general-purpose 
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computer, the Analytical Engine. She advised Charles Babbage to use a binary number system 
to feed programs and data into an analytical engine. 
She was the first to acknowledge that the machine had applications beyond pure calculation 
and posted the first algorithm intended to be carried out by such a machine. As a result, she is 
often considered as the first computer programmer. A programming language named “Ada” is 
named after her. 
10. Scheutzian Calculation Engine 
Pehr (Per) Georg Scheutz (1785 – 1873 AD) was a Swedish lawyer, translator, and inventor, 
who is now best known for his excellent work in computer technology. He is most known for 
the Scheutzian Calculation Engine, invented in 1837 and finalized in 1843. This machine, 
which he made with his son Edvard Scheutz, was based on Charles Babbage’s Difference 
engine. 

Scheutzian Calculation Engine. 
In 1851 they received funds from the government to build an improved model, built-in 1853 
(roughly a piano’s size) and subsequently demonstrated at the World’s Fair in Paris, 1855. The 
device was used for creating logarithmic tables. 
11. Tabulating Machine 
In 1890, Herman Hollerith, an American statistician, invented the Tabulating Machine. It was 
a mechanical tabulator based on punch cards that could tabulate statistics and record or sort 
data or information. The machine was also used to tabulate the 1890 US census in a record 
time. Hollerith’s machine was approximately ten times faster than manual tabulations and 
saved the census office millions of dollars. 
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Herman Hollerith 1890 tabulating machine with sorting box. 
Hollerith also started Hollerith’s Tabulating Machine Company in 1896 AD, which later 
became International Business Machine (IBM) in 1924 AD. 
12. Havard Mark 1 
Harvard Mark I is also known as IBM Automatic Sequence Controlled Calculator 
(ASCC). Howard Aiken of Harvard University designed the first fully automatic calculating 
machine in collaboration with IBM. It was the first programmable digital computer. 
Harvard Mark I was an electronic relay computer as Electromagnetic signals were used for the 
movement of mechanical components. It could perform basic arithmetic and complex 
equations. Although this device was highly reliable, it was very slow (it took about 3-6 seconds 
per calculation) and was large in size and complex in design. 

Harvard Mark I 
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On 29 March 1944, one of the first programs to run on the Mark I was initiated by John von 
Neumann. Mark I also computed and printed mathematical tables, which had been the initial 
dream of Charles Babbage for his “Analytical Engine” in 1837. 
13. The Z1 – First Programmable Computer 
Konrad Zuse invented the Z1 in his parent’s living room from 1936 to 1938. It is considered 
the first modern computer and the first electromechanical binary programmable computer. It 
was a binary electrically operated mechanical calculator with limited programmability, reading 
instructions from punched celluloid film. 

Replica of the Z1 in the German Museum of Technology in Berlin. 
It was completed in 1938 and funded entirely from private funds. This computer was 
demolished in the bombardment of Berlin in December 1943, during World War II, together 
with all construction plans. 
Konrad Zuse would also later invent the Z3, the first functioning programmable computer that 
could be fully automated. 
14. Atanasoff-Berry Computer (ABC) – The First Digital Computer 
Short for Atanasoff-Berry Computer, the ABC was the world’s first general-purpose 
electronic digital computer that began development by Professor John Vincent Atanasoff and 
his student Cliff Berry in 1937. Its evolution continued until 1942 at the Iowa State College. 
The ABC was an electrical computer that used more than 300 vacuum tubes for digital 
computation, including Boolean logic and binary math, and had no CPU (it was not 
programmable). It made use of vacuum tubes for internal logic and capacitors for storage. 
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Atanasoff-Berry Computer (ABC). 
On October 19, 1973, US Federal Judge Earl R. Larson signed his judgment that the ENIAC 
patent by J. Presper Eckert and John Mauchly was invalid. In conclusion, Larson named 
Atanasoff, the sole inventor. 
15. Osborne 1 – The First Portable Computer 
The Osborne 1 is the first portable computer, developed by Adam Osborne and designed by 
Lee Felsenstein, released on April 3, 1981 AD, by Osborne Computer Corporation. It weighs 
11.1 kg, costs $1,795 and runs the CP/M 2.2 OS. It is powered from a wall socket, as it has no 
battery, but it is still tagged as a portable device since it can be hand-carried when the keyboard 
is closed. 

Osborne 1 Portable Computer. 
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The computer shipped with a bundle of software that was equivalent in value to the machine 
itself. The Osborne 1 is about the size and weight of a sewing machine and was publicized as 
the only computer that would fit under an airline seat.  
16. Electronic Controls Company – The First Computer Company 
Founded in 1949 by J. Presper Eckert and John Mauchly, Electronic Controls Company was 
the first computer company. The company was founded by the same individuals who helped 
create the ENIAC computer. Later, the company was renamed Eckert-Mauchly Computer 
Corporation (EMCC) and released a series of mainframe computers under the UNIVAC name. 
In 1950, the company was sold to Remington Rand, which later joined with Sperry Corporation 
to become Sperry Rand and survives today as Unisys. 
 
Introductory Case Study: Computerisation Journey of AIIMS, New Delhi 
Background of the Organisation / Sector 
The All India Institute of Medical Sciences (AIIMS), New Delhi, established in 1956, is 
India’s premier public healthcare institution providing tertiary care, teaching, and research. 
For decades, AIIMS relied heavily on manual record-keeping systems for patient 
registration, clinical documentation, laboratory reports, and administrative processes. 
Contextual Trigger / Problem Situation 
By the late 1990s and early 2000s, AIIMS faced severe challenges: 

 Overcrowded outpatient departments 
 Delays in retrieving patient case sheets 
 Manual billing and reporting errors 
 Inefficient coordination between clinical, diagnostic, and pharmacy services 

The increasing patient load highlighted the limitations of non-computerised systems in a 
modern hospital. 
Stakeholders Involved 

 Hospital administrators 
 Doctors and nursing staff 
 IT professionals 
 Patients and caregivers 
 Government health authorities 

Behavioural / Managerial Issues 

 Resistance to technology adoption among senior medical staff 
 Training gaps in computer usage 
 High initial investment concerns 
 Data accuracy and security apprehensions 

Importance of the Case for the Lesson 
AIIMS gradually transitioned from standalone computers to networked systems, adopting: 

 Mainframe and server-based systems 
 Database-driven patient records 
 Integration of laboratory and radiology systems 

This transformation was possible only because of progressive developments in computer 
generations, from bulky vacuum-tube machines to microprocessor-based and network-
enabled computers. 
Linkage to Lesson Concepts 
This case directly links to: 

 Evolution of computers 
 Generations of computers 
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 Types of computers used in healthcare 
 Importance of computing power, storage, and speed 

It demonstrates why understanding the history of computers is essential for hospital 
administrators managing modern healthcare institutions. 

 
Activity 1: Reflective Learning Task 
Task: 
Identify one department in a hospital (OPD, laboratory, pharmacy) and describe how 
computer evolution has changed its functioning. 
......................................................................................................................................................
......................................................................................................................................................
......................................................................................................................................................
...................................................................................................................................................... 
Expected Learning Outcome: 
Learners relate theoretical evolution of computers to real hospital practices. 
 
1.2 Generations of Computers 
Computer generation is a classification of computers into different groups according to their 
manufacturing date, memory device, software and hardware technologies. There are five 
generations of computers. They are as follow: 

1. First Generation (1942-1955)  
2. Second Generation (1955-1964)  
3. Third Generation (1964-1975)  
4. Fourth Generation (1975-1989)  
5. Fifth Generation (1989-Present) 

Generation 
Features 

First 
Generation 

Second 
Generation 

Third 
Generation 

Fourth 
Generation 

Fifth 
Generation 

Time 
Period 

1945 – 
1956 AD 

1956 – 
1963 AD 

1964 – 
1971 AD 

1971 – Present Present – 
Future 

Processing 
Device 

Vacuum 
Tube based 

Transistor 
based 

Integrated 
Circuit 
based 

Microprocessor 
based 

Artificial 
Intelligence 
based 

Memory Magnetic 
Drum 

Magnetic 
Tape 

High 
Memory 
Devices 

CD, DVD & 
Hard Drive 

Artificial 
Intelligence 

Language Machine & 
Assembly 

COBAL & 
FORTRAN 

COBOL, 
FORTRAN 
& C 

C++, PERL, 
PYTHON & 
SQL 

MERCURY, 
LISP, OPS5 & 
PROLOG 

Operating 
System 

Batch 
Processing 
OS 

Time 
Sharing OS 

Real Time 
OS 

Micro Kernal, 
Multiple 
Windows 

KIPS 

Example ENIAC, 
EDVAC & 
UNIVAC 

IBM 1401, 
IBM 1620 
& CDC 
3600 

IBM 360 
SERIES, 
IBM 370, 
UNIVAC 
1108 & 
UNIVAC 
AC 9000 

MAC 
Notebook, 
IBM-PC & 
Pentium I, II & 
III. 

Robots 
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1. The First-Generation Computers (1945-1956 AD) 
First-generation computers bore little resemblance to today’s computers, either in appearance 
or performance. The first generation of computers occurred from 1940 AD to 1956 AD and 
was extremely large in size. The internal workings of the computers at that time were 
unsophisticated. These early machines required vacuum tubes that worked as switches, 
amplifiers, and magnetic drums for memory. The paper tapes and punch cards were used for 
input and printouts for output. 
The vacuum tubes were primarily responsible for the large size of the devices and the enormous 
amounts of heat that they released despite large cooling units. First-generation computers also 
used a very basic programming language that is referred to as machine language. 
Features of First Generation Computers 
Following are some of the features of first generation computers − 

 It was a large mainframe built with vacuum tube technology. 
 It occupied large space, was low efficiency and unreliable due to low accuracy. 
 The power consumption was very high, and it produced massive heat. 
 The operation of speed was in milliseconds. 
  It was used only for scientific or research purposes. 
 Low-level programming language was used in computers. 
 They were very slow. 

Limitations of First Generation Computers 
Following are some of the limitations of first generation computers − 

 The computer needed an air conditioner room, and constant maintenance.  
 They were not portable. 
 It was expensive commercial product. 
 They have minimum programming capabilities. 
 The computers have limited uses only. 

Examples of First Generation Computers 
Some of the examples of the first generation computer are as follows: 

1. ENIAC (Electronic Numerical Integrator and Calculator) 
2. EDVAC (Electronic Discrete Variable Automatic) 
3. UNIVAC (Universal Automatic Computers) 
4. IBM-701 
5. IBM-650 

ENIAC (Electronic Numerical Integrator and Calculator) (1943-46 AD) 
The Electronic Numerical Integrator And Calculator (ENIAC) was the first all-electronic 
computer. It was constructed at the Moore School of Engineering of the University of 
Pennsylvania, U.S.A., by a design team led by Professors J. Presper Eckert and John Mauchly. 
The team developed ENIAC because of military needs. It was used for many years to solve 
ballistic-related problems. ENIAC took up wall space in a 20 x 40 square feet room and used 
18,000 vacuum tubes. It could add two numbers in 200 microseconds and multiply them in 
2000 microseconds. 
 
EDVAC (Electronic Discrete Variable Automatic) (1946-52 AD) 
A major disadvantage of ENIAC was that its programs were wired on boards which made it 
difficult to change the programs. Dr. John Von Neumann later introduced the ―stored program 
concept that aided overcome this problem. The basic idea after this concept is that a sequence 
of instructions and data can be stored in a computer’s memory to direct operations flow 
automatically. This feature largely influenced the development of modern digital computers 
because of how various programs can be loaded and executed on the same computer. Because 
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of this feature, we usually refer to modern digital computers as stored-program digital 
computers. 
The Electronic Discrete Variable Automatic Computer (EDVAC) used the stored’ program 
concept in its design. Von Neumann also has a share of the credit for introducing the idea of 
storing both instructions and data in binary form (a system that uses only two digits – 0 and 1 
to represent all characters), instead of decimal numbers or human-readable words. 
 
UNIVAC (Universal Automatic Computers) (1951) 
The Universal Automatic Computer (UNIVAC) was the first digital computer that was not 
―one of a kind. Many UNIVAC machines were manufactured, the first of which was installed 
in the Census Bureau in 1951 and was used continually for 10 years. 
In 1952, the International Business Machines (IBM) Corporation introduced the IBM-
701 commercial computer. In quick succession, improved models of the UNIVAC I and other 
IBM 700-series machines were introduced. In 1953, IBM produced the IBM-650 and sold over 
1000 computers.   
 
2. Second Generation Computers (1956-1963 AD) 
The interest in computer technology got fast after the first-generation computers. It was the 
generation of Transistorized Computers. Transistors replaced vacuum tubes from the first-
generation computers. As a result, first-generation computers were replaced by second-
generation computers.  
The transistors were more reliable than vacuum tubes, smaller in size, faster in speed, and 
cheaper than first-generation computers. Magnetic drums are replaced by magnetic disks and 
magnetic tape for secondary storage. As a result, the size of the machines began shrinking.  
The first transistorized computer was TX-0. The first large-scale machines that took advantage 
of the transistor technology were the early supercomputers, LARC by Sperry Rand and Stretch 
by IBM. These machines were specially developed for atomic energy laboratories. IBM 1400 
and IBM 7000 series, General Electric, and Honeywell 200 were the typical computers of the 
second generation.  
IBM 1401 was accepted throughout the industry, and most prominent businesses routinely 
processed financial information using second-generation computers. The machine language 
was replaced by assembly language. Thus, the long and challenging binary code was replaced 
with abbreviated programming code, which was relatively easy to understand.  
The programming languages and stored program concept gave the computers flexibility to be 
cost-effective and productive for business use. The stored program concept implied that the 
instructions to run a computer for a specific task were held inside the computer’s memory and 
could quickly be modified or replaced by a different set of instructions for a different function.  
High-level languages like FORTRAN, COBOL, and AL- GOL were developed. Computers 
started finding varied and vast applications. The entire software industry began with second-
generation computers.  
 
Features of Second-Generation Computers 
Following are some of the features of second-generation computers − 

 This generation’s most significant feature was introducing transistors that make the size 
smaller than the first-generation computer. 

 The computer was much faster, more reliable, and better speed and could handle 
enormous data than first-generation computers. 

 The machine-level language was replaced by assembly language and machine-
independent language such as COBOL FORTRAN to simplify programming. 

 The significant change is in speed from millisecond to microsecond. 
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 The computer consumes less electrical power than a first-generation computer. 
 The computer is widely used in commercial areas. 

Limitations of Second-Generation Computers 
Following are some of the limitations of second-generation computers − 

 It still used a cooling system to cool down the computer. 
 It needs constant maintenance. 
 Punch cards are still used for inputs. 
 It was still costly and versatile. 

Examples of Second Generation Computers 
Some of the examples of the second generation computer are as follows: 

1. IBM 1401 (Used in Bussiness Application)  
2. IBM 1620 (Used for Scientific Purposes) 
3. CDC 3600 (Used for Scientific Purposes) 
4. IBM 7000 
5. Honeywell 200 

3. Third Generation Computers (1964-1971 AD) 
Its period was around 1964 to 1971. Third-generation computers were characterized by the 
invention of Integrated Circuits (ICs). IC is a silicon chip made from quartz where multiple 
transistors were placed over it. Robert Noyce and Jack Kilby developed IC at Texas Instrument 
in 1958-1959. Later, even more components were rigged onto a single chip, called 
a semiconductor. It reduced the size even further in the third-generation computers. 
Computers’ weight and power consumption decreased, and the speed boosted.  
Operating systems were created, allowing the machine to run many different programs 
simultaneously. Multiprogramming was made possible, whereby the device could perform 
several jobs simultaneously.  
Computers gained the speed of executing millions of instructions per second. Commercial 
production became more accessible and cheaper. Higher-level languages like Pascal and 
Report Program Generator (RPG) were introduced. And applications-oriented languages like 
FORTRAN, COBOL, and PL/1 were developed. Keyboards and mouse were introduced for 
the input of data. The monitor was introduced for the output of data. 
Features of Third Generation Computers 
Following are some of the features of third generation computers − 

 IC was used in the computer, replacing transistors. 
 The mass audience was using computers. 
 The computers were highly reliable, relatively inexpensive, faster, and more accurate. 
 It can be operated with low energy, and maintenance cost was low also. 
 The keyboard and monitor were introduced for data input and output. 
 It had a more prominent space capacity. 
 A computer has more high-level computer language such as ALGOL-68, FORTRAN-

II TO IV, BASIC, COBOL, PASCAL PL/1. 
 They were produced commercially and was cheaper than both generations of computer. 

Limitations of Third Generation Computers 
Following are some of the limitations of third generation computers − 

 Still, the air conditioner is used for cooling purposes. 
 Highly sophisticated technology was required for the maintenance of the ICS chip. 
 For third-generation computers, formal training was needed. 

Examples of Third Generation Computers 
Some of the examples of the third generation computer are as follows: 

1. IBM 360 SERIES 
2. IBM 370 
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3. UNIVAC 1108 
4. UNIVAC AC 9000 
5. PDP-8, PDP-11 
6. ICL 2900 series, and so on. 

 
4. Fourth Generation Computers (1971 – Present) 
The fourth-generation computers were developed from 1971 to 1990 AD. The present-day 
computer we see is the fourth generation of computers. The third-generation computers used 
Integrated Circuits with 10-20 components on each chip; this was Small Scale Integration 
(SSI).  The Fourth Generation acknowledged Large Scale Integration (LSI), which could 
hold hundreds of components on one chip, and Very Large-Scale Integration (VLSI), which 
embraced thousands of components on one silicon chip. 
The Intel 4004 chip hold all the components of a computer (central processing unit (CPU), 
input and output controls, memory unit) on a single chip called a Microprocessor, and 
microcomputers were introduced. 
In this generation, the concept of computer networks and CD-ROMS come into existence. GUI 
and pointing devices facilitate easy use and learning on the computer. Many new operating 
systems like the MS-DOS and MS-Windows developed during this time. Computer production 
became affordable, and the era of Personal Computers (PCs) began.  
In 1981, IBM introduced its personal computer for home, office, and schools. In direct 
competition, the Macintosh was introduced in 1984 by Apple. Shared interactive systems and 
user-friendly environments were the features of these computers.  
Features of Fourth Generation Computers 
Following are some of the features of fourth generation computers − 

 Computer sizes change from desktop to laptop and from laptop to palmtop. 
 Electronic Mail (E-mail) and the Internet were developed in this generation. 
 The computer is used for all scientific, engineering, and commercial purposes. 
 On the computer, we can perform multiprocessing and multitasking. 
 The computer has GUI (Graphical User Interface) and is user-friendly. 
 Multiple high-level languages like PASCAL, BASIC COBOL, FORTRAN, and C 

language were developed in this generation of computers. 
 They emerged as single-board computers and a single-chip processor called 

Microprocessors. 
 
Limitations of Fourth Generation Computers 
Following are some of the limitations of fourth generation computers − 

 They were highly sophisticated. 
 The manufacturing of a Very Large-Scale Integration Chip needed very advanced 

technology. 
Examples of Fourth Generation Computers 
Some of the examples of the fourth generation computer are as follows: 

1. MAC Notebook 
2. IBM-PC 
3. Pentium I, II & III 
4. Apple II 
5. VAX 9000 
6. CRAY 1  

5. Fifth Generation Computers (Present – Future) 
 Defining the fifth generation of computers is tricky because the field is still in its infancy. 
Tomorrow’s computers would be characterized by Artificial Intelligence (AI) and ULSI (Ultra 
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Large-Scale Integration) technology that can store millions of components in a single chip. An 
example of Al is Expert Systems. Computers could be developed to think and sense much the 
same way as humans. Computers would be able to accept verbal words as input (voice 
recognition).  
Numerous advancements in the science of computer design and technology are coming 
together to enable the creation of fifth-generation computers. Two such advances are 
in superconductor technology that allows electricity flow with little or no resistance, 
significantly enhancing the speed of information flow, and advances in parallel 
processing, where many CPUs work as one.  
Scientists are now working on fifth-generation computers – a promise but not yet a reality. 
They seek to bring us machines with genuine I.Q., the ability to reason logically, and real-
world knowledge.  
Features of Fifth Generation Computers 
Following are some of the features of fifth generation computers − 

 These machines will incorporate ULSI (Ultra Large Scale Integration). 
 It can perform a large number of parallel processing. 
 The speed of this generation of computers is going to be very high. 
 Bio-chips and Gallium Arsenide (GaAs) are used as memory devices. 
 The concept of AI (Artificial Intelligence) has been introduced. 
 This generation of computers can understand human language and recognize pictures 

and graphs. 
Limitations of Fifth Generation Computers 
Following are some of the limitations of fifth generation computers − 

 The major limitation of this generation is that the computer will overtake all 
employment, creating unemployment in the country. 

 The highly advanced robots can overtake the world, which leads to destruction for 
humans. 
 

 Activity 2: Mini Application Exercise 
 Task: 

Prepare a brief note explaining which generation of computers is most relevant for 
ICU monitoring systems and why. 
…………………………………………………………………………………………
…………………………………………………………………………………………
…………………………………………………………………………………………
………………………………………………………………………………………… 

 Expected Learning Outcome: 
Enhances application-based understanding of computer generations in healthcare. 

 
1.3 TYPES OF COMPUTERS 
Computers can be classified in several ways based on size, purpose, functionality, and data 
handling capability. Understanding these classifications helps learners appreciate how 
different systems support different tasks across industries. 
 
1. Classification Based on Size and Processing Power 
1.1 Microcomputers (Personal Computers) 
Definition: 
Small, low-cost computers designed for individual use. 
Examples: Desktop PCs, Laptops, Tablets, Smartphones. 
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Characteristics: 

 Single-user systems 
 Moderate processing capability 
 Widely used for office work, browsing, education 

Applications: 
 Word processing, spreadsheets, presentations 
 Internet use 
 Personal entertainment 

 
1.2 Minicomputers 
Definition: 
Mid-range systems used by small and medium organizations to support multiple users 
simultaneously. 
 
Examples: IBM AS/400, PDP-11. 
 

 
Characteristics: 

 Multi-user system 
 Higher processing power than microcomputers 
 Support 4 to 200 users 

Applications: 
 Small enterprise servers 



MBA Hospital Administration                                   19          Information Technology for Healthcare…  

19 
 

 Manufacturing process control systems 
 Laboratory data management 

 
1.3 Mainframe Computers 
Definition: 
Large, powerful systems designed to process massive amounts of data and run multiple 
applications simultaneously. 
 
Examples: IBM Z-series. 
 

 
Characteristics: 

 Support thousands of users 
 Very high speed and storage capacity 
 Extremely reliable—designed for 24×7 operation 
 Highly secure systems 

Applications: 
 Banking transaction systems 
 Airline ticketing systems 
 Healthcare patient record systems 
 Large e-commerce platforms 

 
1.4 Supercomputers 
Definition: 
Fastest and most powerful computers designed for complex scientific and engineering 
calculations. 
 
 
Examples: Cray, Param (India). 
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Characteristics: 

 Perform trillions of calculations per second 
 Use parallel processing 
 Require advanced cooling systems 
 Extremely expensive and large in size 

Applications: 
 Weather forecasting 
 Space research 
 Nuclear simulations 
 Genome analysis 
 Artificial Intelligence model training 

 
2. Classification Based on Purpose 
2.1 General-Purpose Computers 
Designed to perform a variety of tasks. 
Examples: Laptops, desktops, tablets. 
Applications: 
Office work, communication, browsing, data analysis. 

 
 
2.2 Special-Purpose Computers 
Designed to perform one specific task. 
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Examples: 
 ATMs 
 Microwave oven controllers 
 Automatic car transmission systems 
 ECG machines 
 Industrial robots 

Applications: 
Highly specialized tasks requiring precision and consistency. 

 

 
 

3. Classification Based on Data Processing Method 
3.1 Analog Computers 
Definition: 
Computers that process continuous data (physical quantities). 
Characteristics: 

 No binary processing 
 Use electrical, mechanical, or hydraulic signals 

Applications: 
 Speedometers 
 Thermometers 
 Flow meters 
 Analog aircraft instruments 
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3.2 Digital Computers 
Definition: 
Computers that process binary data (0s and 1s). 
Characteristics: 

 Most widely used 
 Accurate, fast, programmable 

Applications: 
Used everywhere—education, business, healthcare, research. 
Examples: PCs, laptops, servers. 
 
 

 
3.3 Hybrid Computers 
Definition: 
Combine features of analog and digital computers. 
Characteristics: 

 Convert analog signals to digital 
 Offer speed + accuracy 

Applications: 
 Hospital ICU machines (BP + ECG) 
 Petrol pump flow meter systems 
 Industrial monitoring systems 
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4. Classification Based on Portability 
4.1 Desktop Computers 

 Stationary 
 High performance 
 Used in offices, hospitals, labs 

4.2 Laptop Computers 
 Portable 
 Battery-powered 
 Used by students and professionals 

4.3 Tablets 
 Touch-screen based 
 Lightweight 

4.4 Smartphones 
 Smallest portable computers 
 Multi-functional (internet, apps, communication) 

 
5. Classification Based on Functionality and Architecture 
5.1 Workstations 
High-end computers for professionals (designers, engineers, architects). 
Use cases: 

 CAD/CAM 
 Scientific simulations 
 Animation and video editing 

5.2 Servers 
Provide centralized resources and services. 
Types of Servers: 

 File server 
 Database server 
 Application server 
 Web server 

 
 



Centre for Distance Education                         24                    Acharya Nagarjuna University 
 

5.3 Embedded Computers 
Microprocessor-based systems embedded within larger devices. 
Examples: 

 Smart TVs 
 Washing machines 
 Medical devices 
 Automobiles 

 
Activity 3: Analytical Writing Task 
Task: 
Explain how limitations of first-generation computers would affect modern hospital 
operations if still used today. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………. 
Expected Learning Outcome: 
Develops critical thinking and evaluative skills. 
 
1.4 SUMMARY 
 
The evolution of computers is a journey from simple mechanical devices to highly advanced 
electronic systems. Early computing began with tools like the abacus and mechanical 
calculators, which helped in basic arithmetic operations. The first generation of computers used 
vacuum tubes, were very large in size, consumed more power, and generated a lot of heat. 
These machines were mainly used for scientific calculations and military purposes. 
The second generation introduced transistors, which made computers smaller, faster, and more 
reliable. The third generation saw the use of integrated circuits, enabling more compact designs 
and improved performance. The fourth generation introduced microprocessors, which led to 
the development of personal computers and widespread computer usage in offices and homes. 
Today, we are in the era of fifth-generation computers, focusing on artificial intelligence, 
machine learning, and quantum computing. Modern computers are highly powerful, portable, 
and connected through the internet. The evolution of computers has greatly influenced every 
field, including education, healthcare, banking, and communication, making technology an 
essential part of daily life. 
 
1.5 Keywords 
 

Abacus – An ancient manual calculating tool used for basic arithmetic operations. 
ENIAC – The first electronic general-purpose computer developed in the 1940s. 
Vacuum Tubes – Electronic components used in first-generation computers to control and 
amplify signals. 
Transistors – Small semiconductor devices that replaced vacuum tubes and made 
computers smaller and more reliable. 
Microprocessor – A single chip that contains the CPU and performs all major processing 
functions of a computer. 
 

Case Study for Self-Assessment: Evolution of Computing in Apollo Hospitals 
Background 
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Apollo Hospitals, established in 1983, pioneered corporate healthcare in India. Initially, 
administrative and clinical operations relied on manual systems, basic calculators, and 
typewriters. 
Development Over Time 

 1980s: Use of early microcomputers for billing and payroll 
 1990s: Adoption of third-generation computers with integrated circuits for hospital 

information systems 
 2000s: Fourth-generation computers enabled networking, electronic medical records, 

and telemedicine 
 Present: Fifth-generation technologies such as AI-driven diagnostics, cloud 

computing, and data analytics 
Managerial and Technological Challenges 

 Integration of legacy systems 
 Staff training and change management 
 Data security and reliability 
 High dependency on IT infrastructure 

Relevance to the Lesson 
Apollo’s journey mirrors the evolution of computer generations, illustrating: 

 Why early computers were limited 
 How advances in hardware and software improved healthcare delivery 
 The growing dependence of hospitals on advanced computing systems 

Analytical Questions 
1. How did advancements across computer generations enable large hospital networks 

like Apollo? 
2. Which types of computers are most critical for modern hospital operations and why? 
3. What managerial challenges arise when hospitals move from older to newer 

computing technologies? 
4. How does understanding computer evolution help hospital administrators make better 

IT decisions? 
 
 Self-Assessment Questions 
A. Short-Answer Questions (with Answers) 

1. What is a computer generation? 
A classification of computers based on technological development, time period, and 
hardware. 

2. Who is known as the father of modern computers? 
Charles Babbage. 

3. Name any two features of first-generation computers. 
Vacuum tubes, large size, high power consumption. 

4. What is a microprocessor? 
A single-chip CPU that performs processing operations. 

5. Give one healthcare application of hybrid computers. 
ICU monitoring systems. 

 
B. Essay-Type Questions (with Hints) 

1. Explain the evolution of computers from mechanical devices to electronic 
systems. 
Hints: Abacus → Pascaline → Babbage → Electronic computers → Modern systems 

2. Discuss the characteristics and limitations of different computer generations. 
Hints: Hardware, speed, size, applications 



Centre for Distance Education                         26                    Acharya Nagarjuna University 
 

3. Analyse the role of computers in modern hospital management. 
Hints: EMR, diagnostics, administration, decision-making 

 
C. Multiple Choice Questions (Analytical) 

1. Which technological change most significantly reduced the size of computers? 
a) Vacuum tubes 
b) Transistors 
c) Integrated circuits 
d) Punched cards 
Correct Answer: c 

2. Which generation enabled widespread hospital networking? 
a) First 
b) Second 
c) Third 
d) Fourth 
Correct Answer: d 

3. Hybrid computers are most suitable for: 
a) Office automation 
b) Continuous data processing with accuracy 
c) Gaming 
d) Word processing 
Correct Answer: b 
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LESSON-2 

COMPUTER HARDWARE 
 
LEARNING OBJECTIVES 
 
At the end of this lesson, the learner should be able to: 

1. Explain the concept and components of computer hardware systems. 
2. Distinguish between input, output, processing, and storage devices. 
3. Analyse the role of hardware components in healthcare information systems. 
4. Apply knowledge of computer hardware to hospital operational requirements. 
5. Evaluate hardware selection decisions for effective healthcare management. 

 
Structure 
 

1.0 INTRODUCTION TO COMPUTER HARDWARE 

1.1  COMPUTER INPUT DEVICES 

1.2  COMPUTER OUTPUT DEVICES 

1.3  COMPUTER STORAGE DEVICES 

1.4  COMPUTER PROCESSING DEVICES 

1.5  COMPUTER MEMORY (PRIMARY & SECONDARY) 

1.6  COMPUTER MOTHERBOARD & SUPPORTING CHIPS 

1.7  COMPUTER PERIPHERAL DEVICES 

1.8  SUMMARY 

1.9  KEYWORDS 

1.10 SELF-ASSESSMENT QUESTIONS 

1.11 SUGGESTED READINGS 

 
1.0 INTRODUCTION TO COMPUTER HARDWARE 
 
Computer hardware refers to the physical components of a computer system that you can see 
and touch. These components work together to receive input, process data, store information, 
and present output. 
Categories of Hardware 

1. Input Devices 
2. Output Devices 
3. Storage Devices 
4. Processing Unit (CPU) 
5. Memory (Primary & Secondary) 
6. Motherboard & Supporting Chips 
7. Peripheral Devices 
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Introductory Case Study: Hardware Infrastructure Challenges in a Multi-Specialty 
Hospital 
Background of the Organisation / Sector 
A leading multi-specialty corporate hospital in South India, with over 500 beds, provides 
advanced services in cardiology, oncology, neurology, diagnostics, and emergency care. The 
hospital relies extensively on computer hardware infrastructure to support electronic 
medical records (EMR), laboratory systems, radiology imaging, pharmacy automation, and 
billing operations. 
Contextual Trigger / Problem Situation 
Despite investing in hospital management software, the hospital experienced: 

 Frequent system slowdowns during peak OPD hours 
 Delays in accessing patient records 
 Breakdown of diagnostic equipment interfaces 
 Inconsistent data backup and storage failures 

An internal audit revealed that outdated hardware, insufficient server capacity, and 
incompatible peripheral devices were major contributors. 
Stakeholders Involved 

 Hospital administrators 
 IT and biomedical engineering teams 
 Doctors, nurses, and diagnostic technicians 
 Software vendors 
 Patients and insurance partners 

Behavioural / Managerial Issues 

 Underestimation of hardware importance compared to software 
 Budget constraints in upgrading servers and storage devices 
 Limited awareness among administrators about hardware configurations 
 Dependence on vendors for technical decisions 

Why This Case Is Important for the Lesson 
This case highlights that effective healthcare IT systems depend fundamentally on 
reliable computer hardware. Without appropriate input devices, processors, memory, 
storage, and output units, even advanced hospital software fails to deliver value. 
Explicit Linkage to Lesson Concepts 
The case directly connects to: 

 Components of computer hardware 
 Input, output, processing, and storage devices 
 Primary and secondary memory 
 Hardware performance and reliability in healthcare settings 

 
1.1 COMPUTER INPUT DEVICES 
1. Introduction to Input Devices 
Input devices are hardware components that allow users to enter data, instructions, and control 
signals into a computer. They serve as the primary interface between the user and the system. 
Functions of Input Devices 

 Capture raw data 
 Convert data into machine-readable form 
 Send commands for system operations 
 Enable interaction with software applications 

Classification of Input Devices 
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Input devices can be broadly classified into: 
1. Text Input Devices 
2. Pointing Devices 
3. Image/Video Input Devices 
4. Audio Input Devices 
5. Biometric Input Devices 
6. Special-Purpose Input Devices 

 
2. Text Input Devices 
2.1 Keyboard 
A keyboard is the most common text entry device. 
Types of Keyboards 

 QWERTY Keyboard – Standard layout 
 Wireless Keyboard – Uses Bluetooth/RF 
 Ergonomic Keyboard – Reduces strain 
 Virtual/On-screen Keyboard – Touchscreen based 
 Mechanical Keyboard – Uses mechanical switches 

Key Groups 
 Alphanumeric Keys 
 Function Keys (F1–F12) 
 Control Keys (Ctrl, Alt, Esc) 
 Navigation Keys (Arrow keys, Home, End) 
 Numeric Keypad 

 
3. Pointing Devices 
3.1 Mouse 
A mouse is used to control the position of the cursor. 
Types 

 Mechanical Mouse – Uses a rubber ball 
 Optical Mouse – Uses LED and sensors 
 Laser Mouse – High precision 
 Wireless Mouse – Bluetooth/RF 

Functions 
 Clicking (Left, Right) 
 Double-clicking 
 Scrolling 
 Drag and drop 

 
 
3.2 Touchpad / Trackpad 
Common in laptops; senses finger movement using capacitance. 
Features 

 Tapping 
 Multi-touch gestures 
 Two-finger scrolling 

 
3.3 Trackball 
A stationary ball rotated by the user. 
Advantages 

 Requires less space 
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 Precision input for design and gaming 
 
3.4 Joystick 
Used mostly for gaming and simulations. 
Types 

 Digital joystick 
 Analog joystick 
 Wireless joystick 

 
3.5 Light Pen 
A pen-shaped device that detects light from the screen. 
Uses 

 Computer-aided design (CAD) 
 Older graphic terminals 

 
3.6 Stylus & Graphic Tablet 
Used to draw directly into software applications. 
Components 

 Stylus pen 
 Drawing tablet surface 

Applications 
 Graphic design 
 Animation 
 Handwriting input 

 
4. Image, Video, and Object Input Devices 
4.1 Scanner 
Used to convert physical documents into digital format. 
Types of Scanners 

 Flatbed Scanner 
 Sheet-fed Scanner 
 Handheld Scanner 
 3D Scanner 

Output Format 
JPEG, PNG, PDF, TIFF 
 
4.2 Barcode Reader 
Reads printed barcodes using laser light. 
Types 

 Pen-type 
 Laser scanner 
 CCD scanner 
 2D barcode scanner (QR code readers) 

 
4.3 QR Code Scanner 
Reads Quick Response Codes; widely used in mobile payments, authentication, and inventory. 
 
4.4 Digital Camera / DSLR Camera 
Captures images and videos, stores in digital memory. 
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4.5 Webcam 
Used for video conferencing. 
Features 

 Autofocus 
 High-resolution capture 
 Microphone integration 

 
5. Audio Input Devices 
5.1 Microphone 
Captures audio signals and converts them into electrical signals. 
Types 

 Dynamic 
 Condenser 
 USB Microphone 
 Wireless Microphone 

 
5.2 Voice Recognition Systems 
Convert spoken words into text. 
Examples 

 Siri 
 Google Assistant 
 Speech-to-text tools 

 
6. Biometric Input Devices 
6.1 Fingerprint Scanner 
Uses patterns of ridges and valleys on a finger. 
Types 

 Optical 
 Capacitive 
 Ultrasonic 

 
6.2 Iris Scanner 
Captures the iris pattern of the eye; high-security applications. 
 
6.3 Face Recognition Systems 
Analyze facial features using a camera. 
 
7. Special-Purpose Input Devices 
7.1 Touchscreen 
Combines input and display; user interacts by touching the screen. 
Technology Types 

 Resistive 
 Capacitive 
 Infrared 
 Surface acoustic wave 

 
7.2 Sensors 
Used in IoT devices and smartphones. 
Examples 

 GPS 
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 Gyroscope 
 Accelerometer 
 Proximity sensor 
 Temperature sensor 

 
7.3 Magnetic Ink Character Recognition (MICR) 
Used in banks to read cheques. 
 
7.4 Optical Character Recognition (OCR) 
Converts printed text into digital text. 
 
7.5 Game Controllers 
Keyboards, joypads, and steering wheels for gaming applications. 
 
8. Future Trends in Input Devices 

 Brain–Computer Interfaces (BCI) 
 Gesture Recognition (e.g., Kinect) 
 Holographic Input Systems 
 AI-powered Voice Assistants 
 Smart Gloves for VR/AR 

 
Student Learning Activities 
Activity 1: Hospital Observation Exercise 
Task: 
Observe or recall a hospital registration counter and list the hardware devices used. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Learners connect theoretical hardware components with real hospital operations. 
 
1.2 COMPUTER OUTPUT DEVICES  
 
1. Introduction to Output Devices 
Output devices are hardware components that allow a computer to communicate information 
to the user or another machine. They convert digital data from the computer into human-
understandable form such as text, images, sound, or physical movement. 
Functions of Output Devices 

 Present information to users 
 Convert digital signals into visual, audio, or physical output 
 Support interaction with applications 
 Enable data interpretation and communication 

Types of Output Devices 
Output devices can be classified into: 

1. Visual Output Devices 
2. Audio Output Devices 
3. Print Output Devices 
4. Plotting and Drawing Devices 
5. Control / Actuator Devices 
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2. Visual Output Devices 
2.1 Monitor 
Monitors display visual information such as text, images, and videos. 
Types of Monitors 
a) CRT (Cathode Ray Tube) Monitor 

 Uses electron beams and fluorescent screen 
 Bulky and heavy 
 Rarely used today 

b) LCD (Liquid Crystal Display) Monitor 
 Thin and energy-efficient 
 Uses liquid crystals controlled by electric charge 
 Better color accuracy 

c) LED (Light Emitting Diode) Monitor 
 Advanced version of LCD 
 Uses LEDs for backlighting 
 Higher contrast, brightness, and power efficiency 

d) OLED (Organic LED) Monitor 
 Uses organic compounds to emit light 
 Superior color and contrast 
 Used in high-end displays 

e) Touchscreen Monitor 
 Acts as both input and output 
 Used in mobile devices, kiosks, ATMs 

 
2.2 Projector 
Projectors display data by projecting images onto a screen or wall. 
Types of Projectors 

 LCD Projector – Uses 3 LCD panels 
 DLP Projector (Digital Light Processing) – Uses micro-mirrors 
 LED Projector – Uses LEDs as a light source 
 Laser Projector – High clarity and brightness 

Applications 
 Classrooms 
 Seminars 
 Home theaters 
 Business presentations 

 
2.3 Smart Board / Interactive Display 
A large interactive screen combining output with touch-based input. 
Features 

 Real-time annotation 
 Video playback 
 Multi-touch gestures 
 Used in smart classrooms 

 
3. Print Output Devices 
3.1 Printer 
Printers produce hard copy output on paper. 
Types of Printers 
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a) Impact Printers 
Print by physically striking the paper. 
i) Dot Matrix Printer 

 Prints using pins and ink ribbon 
 Low cost 
 Used for receipts, invoices 

ii) Line Printer 
 Prints one line at a time 
 Used in large-scale industrial printing 

 
b) Non-Impact Printers 
Do not physically strike the paper. 
i) Inkjet Printer 

 Uses liquid ink sprayed through tiny nozzles 
 Ideal for color printing 
 Used in homes and offices 

ii) Laser Printer 
 Uses laser technology and toner powder 
 Fast, high-quality output 
 Suitable for high-volume printing 

iii) Thermal Printer 
 Uses heat-sensitive paper 
 Used in billing machines, POS machines, ATMs 

 
3.2 3D Printer 
Produces 3D physical objects layer by layer using materials like plastic, resin, or metal. 
Applications 

 Prototyping 
 Medical implants 
 Architecture 
 Engineering 
 Education 

 
4. Plotting and Drawing Devices 
4.1 Plotter 
A plotter is used to produce large-size technical drawings. 
Types of Plotters 

 Drum Plotter – Paper moves over a rotating drum 
 Flatbed Plotter – Paper is stationary; pens move 
 Inkjet Plotter – Modern version using inkjet technology 

Uses 
 Engineering drawings 
 Architectural blueprints 
 Maps and graphs 

 
5. Audio Output Devices 
5.1 Speakers 
Speakers convert digital audio signals into sound waves. 
Types 
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 Wired / Wireless 
 Surround sound systems 
 Bluetooth speakers 

Applications 
 Music playback 
 Videos, presentations 
 Alerts and notifications 

 
5.2 Headphones / Earphones 
Deliver audio directly to the user. 
Types 

 In-ear 
 Over-ear 
 Bluetooth 
 Noise-cancelling 

 
5.3 Sound Cards 
Internal hardware that processes audio input/output. 
 
6. Control Output / Actuator Devices 
These devices convert digital output into physical action. 
6.1 Motors 
Used in robotics, manufacturing, and automation. 
6.2 Robotic Arms 
Perform automated tasks like assembly, welding, and packing. 
6.3 LEDs / Indicator Lights 
Provide status indications in machines. 
6.4 Smart Home Output Devices 
Examples: smart bulbs, smart alarms. 
 
7. Softcopy vs. Hardcopy Output 
Output Type Description Examples 

Softcopy Electronic form displayed on screen Monitor, projector, VR headset 

Hardcopy Physical permanent output Printer, plotter, 3D printer 
 
9. Emerging Output Technologies 
9.1 Virtual Reality (VR) Headsets 
Provides immersive 3D visual output. 
9.2 Augmented Reality (AR) Devices 
Overlay digital information on the real world. 
9.3 Holographic Displays 
Produce 3D holograms without glasses. 
9.4 Flexible/Transparent Displays 
Used in foldable phones and modern gadgets. 
9.5 Wearable Output Devices 
Smartwatches, smart glasses (e.g., Google Glass). 
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1.3 COMPUTER STORAGE DEVICES  
1. Introduction to Storage Devices 
Storage devices are hardware components used to store digital data permanently or temporarily. 
They hold operating systems, applications, files, and system data required for computer 
operation. 
Why Storage Devices Are Important 

 Retain data even when the computer is powered off 
 Provide space for software installation 
 Enable backup, portability, and sharing of data 
 Ensure system performance through fast read/write operations 

Categories of Storage 
Storage can be categorized into three main types: 

1. Primary Storage (Main Memory) 
2. Secondary Storage (Non-Volatile Storage) 
3. Tertiary / Backup Storage 

 
2. Primary Storage (Main Memory) 
Primary storage is directly accessible by the CPU and provides temporary storage. 
2.1 RAM (Random Access Memory) 
RAM is volatile memory used to store data and instructions currently in use. 
Types of RAM 
a) DRAM (Dynamic RAM) 

 Stores data using capacitors 
 Needs constant refreshing 
 Used in main system memory 

b) SRAM (Static RAM) 
 Uses flip-flops 
 Faster and expensive 
 Used in CPU cache 

Features 
 Fast data access 
 Temporary storage 
 Volatile (data lost when power is off) 

 
2.2 ROM (Read Only Memory) 
ROM stores permanent instructions needed for system booting. 
Types of ROM 

 PROM (Programmable ROM) 
 EPROM (Erasable PROM) 
 EEPROM (Electrically Erasable PROM) 
 Flash ROM 

Uses 
 BIOS/UEFI firmware 
 Embedded systems 

2.3 Cache Memory 
High-speed memory between CPU and RAM. 
Levels 

 L1 Cache – inside CPU core 
 L2 Cache – near core 
 L3 Cache – shared between cores 
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3. Secondary Storage Devices (Permanent Storage) 
Secondary storage holds data long-term, even without power. 
 
3.1 Hard Disk Drive (HDD) 
Definition 
A mechanical storage device that uses magnetic disks (platters) to store data. 
Components 

 Platters 
 Spindle 
 Read/write head 
 Actuator arm 
 Controller board 

How HDD Works 
Data is stored magnetically on spinning platters. Read/write heads move across platters to 
access data. 
Advantages 

 Low cost per GB 
 High storage capacity 

Disadvantages 
 Slow compared to SSDs 
 Mechanical failure risks 
 Noisy and power-consuming 

 
3.2 Solid State Drive (SSD) 
Definition 
A storage device that uses NAND flash memory (no moving parts). 
Types of SSDs 

 SATA SSD – slower, compatible with HDD ports 
 NVMe SSD – faster, uses PCIe interface 
 M.2 SSD – thin, used in modern laptops 
 U.2 SSD – enterprise-level 

Advantages 
 Extremely fast read/write speed 
 No mechanical parts → durable 
 Low heat and noise 

Disadvantages 
 More expensive than HDD 
 Limited write cycles (improving with technology) 

 
3.3 Hybrid Drive (SSHD) 
Combination of HDD + small SSD cache. 
Purpose 

 Faster than HDD 
 Cheaper than SSD 

 
3.4 Optical Storage Devices 
These store data using laser technology. 
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a) CD (Compact Disc) 
 Capacity: ~700 MB 
 Used for music, software distribution 

b) DVD (Digital Versatile Disc) 
 Capacity: 4.7 GB – 8.5 GB 
 Used for movies, software 

c) Blu-ray Disc 
 Capacity: 25 GB – 50 GB 
 High-definition video storage 

Advantages 
 Cheap 
 Good for distribution 

Disadvantages 
 Easily scratched 
 Slower access speed 

 
3.5 Flash Memory Devices 
 
Flash memory is non-volatile, portable, and widely used. 
a) USB Flash Drive 

 Portable plug-and-play device 
 Capacities: 4 GB to 1 TB 

b) Memory Cards 
 SD Card 
 microSD Card 
 CF Card (CompactFlash) 

Used in cameras, mobile phones, IoT devices. 
c) Flash Chips 
Used in smartphones and embedded systems. 
 
3.6 External Hard Drives 
Portable versions of HDDs or SSDs used for data backup and transfer. 
Advantages 

 High capacity 
 Portable 

Disadvantages 
 Susceptible to drops (HDD) 

 
3.7 Magnetic Tape Storage 
Long-term, high-capacity storage used in enterprises. 
Features 

 Sequential access 
 Very cheap for bulk storage 
 Used for backups, archives 
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4. Cloud Storage (Online Storage) 
Cloud storage allows users to store data on remote servers accessible via the internet. 
Examples 

 Google Drive 
 Dropbox 
 OneDrive 
 iCloud 

Advantages 
 Accessible anywhere 
 Automatic backup 
 Scalable storage 

Disadvantages 
 Requires internet 
 Data privacy concerns 

 
5. Tertiary / Backup Storage 
Designed for data recovery, archiving, and long-term storage. 
Devices Used 

 Tape drives 
 External HDDs/SSDs 
 NAS (Network Attached Storage) 
 Cloud backup services 

 
6. Characteristics of Storage Devices 
Characteristic Description 

Capacity Amount of data stored 

Speed Read/write speed 

Volatility Whether data is retained without power 

Portability Ease of carrying 

Durability Resistance to damage 

Cost per GB Expense relative to size 
 
7. Comparison of Major Storage Devices 
Device Speed Cost Durability Capacity Used In 
HDD Medium Low Medium High PCs, servers 
SSD Very 

High 
Medium-
High 

High Medium-
High 

Laptops, gaming 
PCs 

USB Drive Medium Low Medium Low-
Medium 

Data transfer 

SD Card Medium Low Medium Medium Mobiles, cameras 
Magnetic 
Tape 

Low Very Low High Very High Archives 

Cloud 
Storage 

Variable Subscription Very High Very High Backup, sync 
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8. File Systems Used in Storage Devices 
File System Used In Features 
NTFS Windows High security, large files 
FAT32 USB drives Simple, widely compatible 
exFAT SD cards/USB Supports large files 
EXT4 Linux Reliable and fast 
APFS macOS Encryption-focused 

 
9. Modern & Emerging Storage Technologies 
9.1 NVMe Storage 
Ultra-fast PCIe-based SSDs. 
9.2 Holographic Storage 
Uses 3D holograms to store massive data. 
9.3 DNA Storage 
Stores data using synthetic DNA strands. 
9.4 Phase Change Memory (PCM) 
High-speed memory combining RAM and storage features. 
9.5 Storage-Class Memory (SCM) 
Next-generation non-volatile memory for enterprise servers. 
 
1.4 COMPUTER PROCESSING DEVICES  
1. Introduction to Processing Devices 
Processing devices are the core components of a computer responsible for executing 
instructions, performing calculations, and managing the flow of data. These devices form the 
brain of the computer system. 
Key Functions of Processing Devices 

 Execute instructions from software 
 Perform arithmetic and logical operations 
 Control data movement between memory, I/O devices, and storage 
 Manage system resources 
 Maintain synchronization of operations 

Processing devices ensure that the system works efficiently, rapidly, and accurately. 
 
2. Central Processing Unit (CPU) 
The CPU is the primary processing device of a computer. It carries out most of the 
computational and control tasks. 
2.1 Components of CPU 
The CPU consists of three main components: 
a) ALU (Arithmetic Logic Unit) 

 Performs arithmetic operations (add, subtract, multiply, divide) 
 Performs logical operations (AND, OR, NOT, compare) 
 Handles decision-making tasks 

b) CU (Control Unit) 
 Directs the operation of the processor 
 Fetches instructions from memory 
 Decodes and executes instructions 
 Controls communication between CPU and other components 

c) Registers 
Registers are small, high-speed storage locations inside the CPU. 
Types of Registers: 
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 Program Counter (PC) 
 Instruction Register (IR) 
 Accumulator (ACC) 
 Buffer Registers 
 General Purpose Registers 

 
2.2 CPU Clock Speed 
Measured in GHz (Gigahertz). 
Higher clock speed → faster processing. 
 
2.3 CPU Cores 
Modern CPUs have multiple cores like: 

 Dual-core 
 Quad-core 
 Hexa-core 
 Octa-core 
 Multi-core servers (up to 64 cores) 

Each core can execute tasks independently. 
 
2.4 CPU Architecture 

 32-bit and 64-bit Processors 
 RISC (Reduced Instruction Set Computer) 
 CISC (Complex Instruction Set Computer) 

Examples: 
 Intel Core i5, i7, i9 
 AMD Ryzen series 
 ARM processors (used in mobiles) 

 
3. Graphics Processing Unit (GPU) 
A GPU is a specialized processor designed to handle graphics and parallel processing tasks. 
3.1 Functions 

 Render 2D/3D graphics 
 Accelerate gaming performance 
 Support machine learning and AI 
 Handle video editing and rendering 

3.2 Types of GPUs 
1. Integrated GPU 

o Built into CPU 
o Low power, basic performance 
o Example: Intel UHD Graphics, AMD Vega 

2. Dedicated/Discrete GPU 
o Separate hardware 
o High performance 
o Example: NVIDIA GeForce, AMD Radeon 

3.3 GPU Architecture 
 Thousands of small cores for parallel tasks 
 Ideal for large-scale data processing 
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4. Coprocessors 
Coprocessors assist the CPU in performing specific functions more efficiently. 
Types of Coprocessors 

 Math Coprocessor for scientific calculations 
 Graphics Coprocessor (GPU) 
 Audio Coprocessor 
 AI Coprocessor / Neural Engine (used in mobile devices) 

 
5. Microprocessors 
Microprocessors are compact, complete CPUs built on a single chip. 
Applications 

 Personal computers 
 Embedded systems 
 Home appliances 
 Industrial machinery 

Examples 
 Intel Pentium series 
 ARM Cortex processors 
 Motorola 68000 

 
6. Microcontrollers 
A microcontroller is a combination of: 

 Processor (CPU) 
 Memory (RAM, ROM) 
 Input/output ports 

on a single chip. 
Applications 

 IoT devices 
 Washing machines 
 Medical instruments 
 Arduino boards 

Popular microcontrollers 
 Arduino ATmega328 
 PIC Microcontroller 
 ESP32 

 
7. System on Chip (SoC) 
An SoC integrates: 

 CPU 
 GPU 
 Memory 
 Modem 
 Sensors 

on a single chip. 
Used In 

 Mobile phones 
 Tablets 
 Smart wearables 
 Smart TVs 
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Examples 
 Apple A-series & M-series chips 
 Qualcomm Snapdragon 
 Samsung Exynos 

 
8. Digital Signal Processor (DSP) 
DSPs are specialized processors for high-speed signal processing. 
Functions 

 Audio filtering 
 Image compression 
 Wireless communication 
 Video streaming 

Applications 
 Smartphones 
 Medical devices 
 Radar systems 

 
9. AI Processing Units (Neural Processing Units – NPUs) 
Designed for artificial intelligence and machine learning tasks. 
Functions 

 Facial recognition 
 Natural language processing 
 Real-time data analysis 

Examples 
 Google Tensor Processing Unit (TPU) 
 Apple Neural Engine 
 Qualcomm Hexagon AI Engine 

 
10. Cloud Processing 
Processing is performed on remote servers. 
Advantages 

 Scalability 
 High computational power 
 Available anywhere 

Examples 
 AWS EC2 
 Google Cloud Compute 
 Microsoft Azure 

 
11. Quantum Processors (Emerging Technology) 
Quantum processors use qubits instead of bits, enabling exponential processing speeds for 
certain tasks. 
Applications 

 Cryptography 
 Molecular modeling 
 Optimization problems 

Examples 
 IBM Quantum Processor 
 Google Sycamore 
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12. Characteristics of Processing Devices 
Feature Description 
Speed Execution rate of instructions 
Cores Number of independent processors within CPU 
Architecture RISC/CISC, 32/64-bit 
Cache Size Memory close to CPU for fast processing 
Thermal Capacity Ability to handle heat 
Instruction Set Types of operations supported 

 
1.5 COMPUTER MEMORY (PRIMARY & SECONDARY)  
1. Introduction to Computer Memory 
Computer memory refers to the electronic components that store data, instructions, and 
information needed for processing. Memory is essential for the computer to function 
efficiently. 
Why Memory Is Important 

 Stores data temporarily or permanently 
 Supplies data and instructions to the CPU 
 Stores results of processing 
 Maintains smooth execution of programs 
 Enhances system performance 

Computer memory is broadly classified into: 
1. Primary Memory (Main Memory) 
2. Secondary Memory (Auxiliary/External Storage) 

 
2. Primary Memory (Main Memory) 
Primary memory is directly accessible by the CPU. It is fast and volatile. It temporarily holds 
data and instructions currently in use. 
Primary Memory Includes: 

 RAM (Random Access Memory) 
 ROM (Read Only Memory) 
 Cache Memory 

 
2.1 RAM (Random Access Memory) 
RAM is a volatile memory—data is lost when power is turned off. 
Functions of RAM 

 Stores data and instructions needed for running programs 
 Holds the operating system (temporarily) 
 Allows multitasking 

Types of RAM 
 
a) DRAM (Dynamic RAM) 

 Stores data using capacitors 
 Needs continuous refreshing 
 Slower but cheaper 
 Used in system memory of computers 

b) SRAM (Static RAM) 
 Uses flip-flop circuits 
 No need for refreshing 
 Much faster but expensive 
 Used in cache memory 
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Features of RAM 

 Volatile 
 High read/write speed 
 Measured in GB (e.g., 4GB, 8GB, 16GB) 
 Directly accessible by CPU 

 
2.2 ROM (Read Only Memory) 
ROM is non-volatile memory—data remains even when power is off. 
Functions of ROM 

 Stores permanent instructions 
 Used in the computer’s booting process 
 Contains BIOS/UEFI firmware 

Types of ROM 
 
a) PROM (Programmable ROM) 

 Can be programmed once by the user 
b) EPROM (Erasable PROM) 

 Can be erased using UV light 
 Can be reprogrammed 

c) EEPROM (Electrically Erasable PROM) 
 Can be erased electrically 
 Supports partial rewriting 

d) Flash ROM 
 Used in modern BIOS, pen drives, memory cards 

 
2.3 Cache Memory 
Cache memory is ultra-fast memory located close to the CPU. 
Why Cache Is Needed 

 Reduces data access time 
 Stores frequently used instructions 
 Improves CPU efficiency 

Types of Cache 
 L1 Cache – inside CPU core (fastest, smallest) 
 L2 Cache – near the core (larger, slower than L1) 
 L3 Cache – shared cache for all cores 

2.4 Registers 
Small, ultra-fast memory units inside the CPU. 
Examples of Registers: 

 Program Counter (PC) 
 Instruction Register (IR) 
 Stack Pointer 
 Accumulator 

3. Secondary Memory (Auxiliary Storage) 
Secondary memory is non-volatile and used for long-term storage of data and programs. 
Features of Secondary Memory 

 Permanent storage 
 Higher capacity 
 Slower than primary memory 
 Not directly accessed by the CPU 
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Examples include: 
 Hard Disk Drive (HDD) 
 Solid State Drive (SSD) 
 Optical Discs (CD/DVD/Blu-ray) 
 Flash Drives 
 SD Cards 
 Magnetic Tapes 
 Cloud Storage 

 
3.1 Hard Disk Drive (HDD) 
Definition 
A mechanical device using magnetic platters to store data. 
Characteristics 

 High capacity (500GB – 10TB) 
 Low cost 
 Slower than SSD 
 Mechanical parts may fail 

Used In 
 Desktops 
 Laptops 
 Servers 

 
3.2 Solid State Drive (SSD) 
Definition 
Stores data using NAND flash memory with no moving parts. 
Characteristics 

 Very fast read/write speed 
 Durable and silent 
 More expensive 
 Uses SATA, M.2, or NVMe interfaces 

Used In 
 Modern laptops 
 Gaming PCs 
 Enterprise servers 

 
3.3 Hybrid Drive (SSHD) 
Combines HDD + SSD (small flash memory cache). 
Balances cost and speed. 
 
3.4 Optical Storage Devices 
a) CD (Compact Disc) 

 Capacity: 700MB 
 Used for music, small software 

b) DVD (Digital Versatile Disc) 
 Capacity: 4.7GB – 8.5GB 
 Used for movies, software 

c) Blu-ray Disc 
 Capacity: 25GB – 50GB 
 High-definition video 
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3.5 Flash Memory Devices 
a) Pen Drive / USB Flash Drive 

 Portable and easy to use 
 Capacity: 4GB – 1TB 

b) Memory Cards (SD, microSD) 
 Used in smartphones, tablets, cameras 

c) SSD Flash Chips 
 Used in mobile phones and embedded systems 

 
3.6 External Hard Drives 
Used for backup and bulk storage. 
Available in HDD and SSD formats. 
 
3.7 Magnetic Tape Storage 
Used for archival storage in organizations. 
Characteristics 

 Very high capacity 
 Low cost 
 Sequential access (slower) 

 
3.8 Cloud Storage 
Data stored on remote servers accessible online. 
Examples 

 Google Drive 
 Dropbox 
 OneDrive 
 AWS S3 

Advantages 
 Accessible anywhere 
 Automatic sync 
 No hardware maintenance 

 
4. Differences Between Primary and Secondary Memory 
Feature Primary Memory Secondary Memory 
Volatility Mostly volatile Non-volatile 
Speed Very fast Moderate to slow 
Cost Expensive Cheaper per GB 
Capacity Limited (GBs) Very high (GBs to TBs) 
Access Direct by CPU Through I/O controller 
Purpose Temporary data Permanent data 

 
5. Classification of Memory Hierarchy 

1. Registers (fastest, smallest) 
2. Cache Memory 
3. Primary Memory (RAM) 
4. Secondary Storage (HDD/SSD) 
5. Tertiary Storage (Tape, cloud archive) 

This structure ensures optimal performance and balanced cost. 
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6. Modern Memory Technologies 
a) NVMe Storage 
Used in high-speed SSDs for lightning-fast performance. 
b) 3D NAND Technology 
Increases storage density in flash memory. 
c) HBM (High Bandwidth Memory) 
Used in high-end GPUs. 
d) Storage Class Memory (SCM) 
Bridges the gap between RAM and storage. 
e) DNA Storage (Future) 
Uses biological molecules for massive data storage. 
 
7. Applications of Each Memory Type 
Memory Common Applications 

RAM Running OS, apps, games 

ROM System firmware 

Cache Speeding up processing 

HDD Storing downloads, movies, files 

SSD Faster OS booting & applications 

USB Drive Portability & file transfer 

SD Cards Mobile devices & cameras 

Cloud Storage Backup & remote access 

Magnetic Tape Archiving business data 
 
1.6 COMPUTER MOTHERBOARD & SUPPORTING CHIPS  
1. Introduction to Motherboard 
The motherboard is the main printed circuit board (PCB) of a computer. It connects and 
communicates with all other hardware components such as CPU, memory, storage, 
input/output devices, and expansion cards. 
It is also known as: 

 System board 
 Mainboard 
 Logic board (in Apple systems) 

 
2. Functions of the Motherboard 

 Holds and allows communication between CPU, RAM, GPU, and other components 
 Distributes power to all components 
 Houses BIOS/UEFI firmware 
 Provides expansion slots 
 Manages data flow through chipsets 
 Interfaces with internal and external devices 

 
3. Motherboard Form Factors 
3.1 ATX (Advanced Technology Extended) 

 Standard size: 305mm × 244mm 
 More expansion slots and ports 
 Used in desktops and servers 
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3.2 Micro ATX 
 Smaller than ATX 
 Moderate expansion slots 
 Used in budget desktops 

3.3 Mini-ITX 
 Very compact 
 Low power consumption 
 Ideal for small form-factor PCs 

3.4 AT (Advanced Technology) 
 Older form factor 
 Used in early computers 

 
4. Major Components on a Motherboard 
4.1 CPU Socket 
A special slot designed to hold the CPU. 
Types: 

 LGA (Land Grid Array) – Intel 
 PGA (Pin Grid Array) – AMD 
 BGA (Ball Grid Array) – permanently soldered (laptops) 

 
4.2 RAM Slots (DIMM Slots) 
Holds the primary memory modules 
Supports DDR3 / DDR4 / DDR5 depending on motherboard design. 
 
4.3 Chipset (Northbridge & Southbridge) 
The chipset controls communication between CPU, memory, and peripherals. 
Traditional Architecture 

 Northbridge 
o Connects CPU, RAM, GPU 
o High-speed communication 

 Southbridge 
o Connects I/O devices (USB, audio, network, storage) 
o Slower communication 

Modern Architecture 
Modern CPUs integrate Northbridge functions inside the processor. 
Motherboards now use a Platform Controller Hub (PCH) instead of traditional 
Northbridge/Southbridge. 
 
4.4 BIOS/UEFI Chip 
A small ROM chip that stores the firmware. 
Functions 

 Performs POST (Power-On Self-Test) 
 Loads bootloader 
 Provides basic hardware configuration settings 

UEFI is the modern firmware standard with graphical interface and secure boot. 
 
4.5 CMOS Battery 

 A coin-cell battery (CR2032) 
 Powers the CMOS memory which stores BIOS settings (date/time, boot settings) 
 Maintains settings when PC is off 
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4.6 Expansion Slots 
Used to insert additional cards. 
Types: 

 PCI Slot – older expansion slot 
 PCI Express (PCIe) – modern, high-speed 

o PCIe x1 
o PCIe x4 
o PCIe x8 
o PCIe x16 (used for graphics cards) 

Expansion Cards Include: 
 Graphics card 
 Sound card 
 Network card 
 TV tuner card 
 RAID controller 

 
4.7 Storage Connectors 
SATA Ports 

 Connect SSDs, HDDs, and optical drives 
 SATA III offers 6 Gbps speed 

M.2 Slots 
 Used for NVMe SSDs 
 Very fast storage interface 
 Sizes: 2280, 2260, 2230 

 
4.8 Power Connectors 

 24-pin ATX power connector – main power supply 
 4/8-pin CPU power connector – supplies CPU 
 PCIe power connectors – for graphics cards 

 
4.9 USB Headers 
Provide connections for front panel USB ports (USB 2.0, USB 3.0, 3.1, Type-C). 
 
4.10 Audio Chip (Sound Card Chip) 
Often integrated on motherboard. 
Responsibilities: 

 Produces input/output audio 
 Manages microphone and speaker signals 

Examples: 
 Realtek HD Audio chipset 
 Creative Sound Core 

 
4.11 LAN Controller Chip 
Handles network communication. 

 Gigabit Ethernet controller 
 Wi-Fi/Bluetooth modules on advanced boards 

Examples: 
 Intel I219-V 
 Realtek RTL8111 
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4.12 VRM (Voltage Regulator Module) 
Ensures stable voltage supply to CPU, RAM, and GPU. 
Consists of: 

 MOSFETs 
 Chokes/inductors 
 Capacitors 

High-quality VRMs improve system stability. 
 
5. Supporting Chips on Motherboard 
5.1 Super I/O Chip 
Manages legacy devices: 

 Serial port 
 Parallel port 
 Keyboard controller 
 Fan control 
 Temperature sensors 

 
5.2 Clock Generator Chip 
Provides timing signals to synchronize components. 
 
5.3 TPM (Trusted Platform Module) 
A security chip used for: 

 Encryption 
 Secure boot 
 BitLocker functionality 

 
5.4 USB Controller Chip 
Handles USB communication and power control for: 

 Keyboard 
 Mouse 
 Storage devices 
 Printers 

 
5.5 RAID Controller Chip 
Combines multiple storage drives for: 

 Redundancy 
 Performance improvement 
 Data security 

 
5.6 Embedded Controller (EC) 
Used mostly in laptops. 
Manages: 

 Battery 
 Keyboard shortcuts 
 Thermal sensors 
 Power management 
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6. Back Panel Ports on the Motherboard 
 USB 2.0 / USB 3.0 / USB-C 
 HDMI / DisplayPort / VGA 
 Ethernet port 
 PS/2 ports (for older keyboard & mouse) 
 Audio jacks 
 Optical S/PDIF 

 
7. Front Panel Connectors 

 Power button 
 Reset button 
 HDD LED 
 Power LED 
 Audio ports 
 USB ports 

 
8. Cooling Support on Motherboard 
Types: 

 CPU fan header 
 System fan headers 
 Liquid cooling support (AIO pump header) 

Cooling prevents overheating and improves performance. 
 
9. Laptop vs Desktop Motherboards 
Desktop Motherboard 

 Larger 
 More upgrade options 
 Replaceable components 

Laptop Motherboard 
 Compact 
 Custom designed 
 Many components soldered directly 
 Difficult to replace 

 
10. Importance of Motherboard in System Performance 

 Determines the type of CPU, RAM, and expansion cards 
 Affects data transfer speed 
 Influences system stability 
 Supports overclocking features 
 Improves connectivity 

 
 
Activity 2: Mini Application Task 

 Task: 
Suggest a basic hardware configuration for a 50-bed hospital OPD. 
…………………………………………………………………………………………
…………………………………………………………………………………………
…………………………………………………………………………………………
………………………………………………………………………………………… 
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 Expected Learning Outcome: 
Develops application-oriented hardware planning skills. 

 
1.7 COMPUTER PERIPHERAL DEVICES  
 
1. Introduction to Peripheral Devices 
Peripheral devices are external hardware components that are connected to a computer to 
expand its functionality. They allow users to input data, output information, store data, 
communicate, and enhance user interaction. 
Peripheral devices are not part of the computer’s core architecture (CPU, motherboard, RAM) 
but support system operations. 
 
2. Types of Peripheral Devices 
Peripheral devices are generally classified into: 

1. Input Devices 
2. Output Devices 
3. Storage Devices 
4. Communication Devices 
5. Multifunction Devices 

 
3. Input Peripheral Devices 
Used to send data or control signals to the computer. 
3.1 Keyboard 

 Standard input device 
 QWERTY layout 
 Types: Mechanical, membrane, wireless, ergonomic 

3.2 Mouse 
 Pointing device 
 Types: Optical, laser, wireless, vertical, gaming 

3.3 Scanner 
 Converts physical documents/images into digital form 
 Types: Flatbed, handheld, sheet-fed, fingerprint scanner 

3.4 Microphone 
 Converts sound to digital signals 
 Used in calls, recordings, speech recognition 

3.5 Web Camera (Webcam) 
 Captures video 
 Used for video conferencing, surveillance 

3.6 Barcode Reader 
 Reads barcodes in retail, warehouses, libraries 

3.7 Biometric Devices 
 Fingerprint scanners 
 Retina scanners 
 Facial recognition devices 

3.8 Touchscreen 
 Both input & display 
 Used in mobiles, ATMs, kiosks 

3.9 Graphics Tablet / Stylus 
 Used for drawing, design, digital art 
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4. Output Peripheral Devices 
Used to show information to the user. 
4.1 Monitor 

 Primary output device 
 Types: LCD, LED, OLED, curved, touch monitors 

4.2 Printer 
 Converts digital text/images into paper format 
 Types: 

o Inkjet 
o Laser 
o Dot Matrix 
o Thermal printer 
o 3D printer 

4.3 Speakers 
 Produce audio output 
 Used in entertainment, alerts, communication 

4.4 Headphones / Earphones 
 Personal audio devices 

4.5 Projector 
 Displays enlarged visuals on screens/walls 
 Used in classrooms, offices, cinemas 

4.6 Plotter 
 Produces large-scale drawings (engineering, architecture) 

 
5. Storage Peripheral Devices 
They store data externally. 
5.1 External Hard Drive 

 High capacity 
 Portable 
 HDD/SSD-based 

5.2 Pen Drive (USB Flash Drive) 
 Compact storage 
 Plug-and-play device 

5.3 Memory Cards 
 SD, microSD 
 Used in cameras, mobiles 

5.4 Optical Discs 
 CD, DVD, Blu-Ray 
 Used for media distribution 

5.5 Network Attached Storage (NAS) 
 Storage accessible through a network 

 
6. Communication Peripheral Devices 
Enable communication between computers or networks. 
6.1 Modem 

 Converts digital signals into analog and vice versa 
 Used for internet connectivity 

6.2 Network Interface Card (NIC) 
 Hardware to connect a computer to a network 
 Wired (Ethernet) or wireless (Wi-Fi) 
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6.3 Bluetooth Adapter 
 Short-range wireless communication 

6.4 Wi-Fi Adapter 
 Connects computers to wireless networks 

6.5 Router (External Peripheral) 
 Directs network traffic 
 Provides Wi-Fi and LAN connections 

 
7. Multifunction Peripheral Devices 
Devices that combine multiple features. 
 
7.1 All-in-One Printer 

 Printer + Scanner + Copier + Fax 
7.2 Photocopy Machines 

 Copying + scanning + printing 
7.3 Smartboards 

 Display + input (writing/drawing) 
 Used in classrooms/offices 

 
8. Specialized Peripheral Devices 
These support specific industries. 
8.1 POS (Point of Sale) Terminals 

 Billing machines used in shops 
 Integrated with barcode scanner, receipt printer 

8.2 Medical Peripheral Devices 
 ECG reader 
 Glucometer 
 Digital stethoscopes 

8.3 Industrial Sensors 
 Temperature sensors 
 Motion detectors 
 Pressure sensors 

8.4 VR/AR Headsets 
 Virtual & augmented reality experiences 

 
9. Connectivity Ports for Peripheral Devices 
Peripheral devices are connected through: 
9.1 USB Ports 

 Most common 
 USB 2.0, 3.0, 3.1, USB-C 

9.2 HDMI 
 For monitors, projectors 

9.3 DisplayPort / VGA / DVI 
 Video output 

9.4 Audio Jacks (3.5mm) 
 Speakers, headphones 

9.5 Bluetooth 
 Wireless headphones, keyboards, mice 

9.6 Wi-Fi & NFC 
 Wireless communication 
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 Smartphones, printers 
 
10. Importance of Peripheral Devices 
Peripheral devices improve a computer’s ability to: 

 Input data faster 
 Display information better 
 Store data externally 
 Communicate with other devices 
 Expand functionality for specific industries 

 
They convert a base computer into a functional, user-oriented system. 
 
11. Characteristics of Peripheral Devices 
Feature Description 

Connectivity Wired/Wireless 

Functionality Input, Output, Storage, Communication 

Compatibility OS & port support 

Speed Transfer/data rate 

Portability Ease of carrying 

Reliability Durability & performance 
 
12. Examples of a Full Peripheral Setup 
A modern office PC may have: 

 Keyboard, mouse → Input 
 Monitor, printer → Output 
 External hard disk → Storage 
 Wi-Fi router → Communication 
 Webcam, microphone → Multimedia 

 
Activity 3: Reflective Writing Task 
Task: 
Explain why investing only in software without upgrading hardware can fail in hospitals. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Enhances evaluative and decision-making capability. 
 
1.8 SUMMARY 
 
Computer hardware refers to the physical parts of a computer system that can be seen and 
touched. It includes input devices like keyboard and mouse, processing components such as 
the CPU and motherboard, storage devices such as hard disks and RAM, and output devices 
like monitors and printers. Hardware works together with software to perform tasks, process 
data, and produce useful results. Proper functioning and maintenance of hardware are essential 
for the efficient performance of a computer system. 
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1.9 Keywords 
CPU (Central Processing Unit) – The main processing component of the computer that 
performs calculations and controls operations. 
RAM (Random Access Memory) – The temporary memory that stores data and programs 
currently in use. 
Hard Disk – A secondary storage device used to store data permanently. 
Motherboard – The main circuit board that connects and allows communication between 
hardware components. 
Input Devices – Hardware components used to enter data and instructions into a computer. 

 
Case Study for Self-Assessment: Hardware Modernisation at a Government District 
Hospital 
Background 
A government district hospital serving a largely rural population introduced a Hospital 
Information System (HIS) as part of a national digital health initiative. Initially, the hospital 
used basic desktop computers with minimal peripherals. 
Problem Development 
Over time, several operational issues emerged: 

 Old CPUs could not support updated HIS software 
 Insufficient RAM caused frequent system hangs 
 Lack of scanners and biometric devices slowed patient registration 
 Printers and storage devices failed regularly 
 No dedicated servers or backup systems existed 

Managerial and Operational Challenges 
 High patient volume with limited hardware resources 
 Budgetary approvals for hardware upgrades 
 Training staff to use new input/output devices 
 Ensuring data security and continuity 

Relevance to the Lesson 
The hospital gradually upgraded: 

 Input devices (biometric scanners, barcode readers) 
 Processing units (modern CPUs, servers) 
 Storage systems (external drives, cloud backups) 
 Output devices (network printers, display systems) 

This transformation demonstrates the critical role of computer hardware in healthcare 
service delivery. 
Analytical Questions 

1. How did inadequate hardware affect hospital service efficiency? 
2. Which hardware components were most critical for improvement? 
3. How should hospital administrators prioritise hardware investments? 
4. What risks arise when hardware upgrades are delayed? 
5. How does hardware choice influence data security and patient safety? 

 
 Self-Assessment Questions 
A. Short-Answer Questions (5) – with Answers 

1. What is computer hardware? 
Physical components of a computer system that can be seen and touched. 

2. Name any two input devices used in hospitals. 
Keyboard, barcode scanner. 
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3. What is the function of RAM? 
Temporary storage of data and instructions currently in use. 

4. Define secondary storage. 
Non-volatile storage used for long-term data retention. 

5. What is the role of output devices in healthcare? 
To present processed information such as reports and images. 

 
B. Essay-Type Questions (5) – with Guiding Hints 

1. Explain the major components of computer hardware. 
Hints: Input, output, processing, memory, storage 

2. Discuss the importance of input and output devices in hospital operations. 
Hints: Registration, diagnostics, reporting 

3. Differentiate between primary and secondary memory. 
Hints: Volatility, speed, examples 

4. Analyse the role of computer hardware in Hospital Information Systems. 
Hints: Reliability, speed, integration 

5. Evaluate challenges faced by hospitals in upgrading hardware infrastructure. 
Hints: Cost, training, compatibility 

 
C. Multiple Choice Questions (5) – Analytical 

1. Which hardware component directly executes program instructions? 
a) Hard disk 
b) CPU 
c) Monitor 
d) Keyboard 
Correct Answer: b 

2. Which memory type is volatile? 
a) ROM 
b) SSD 
c) RAM 
d) DVD 
Correct Answer: c 

3. Barcode scanners in hospitals are classified as: 
a) Output devices 
b) Storage devices 
c) Input devices 
d) Processing devices 
Correct Answer: c 

4. Which storage device offers the fastest access speed? 
a) HDD 
b) Optical disk 
c) SSD 
d) Magnetic tape 
Correct Answer: c 

5. Why are servers important in hospitals? 
a) For entertainment 
b) For centralized data processing and storage 
c) For printing only 
d) For personal use 
Correct Answer: b 
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LESSON-3 

COMPUTER SOFTWARE 
 
LEARNING OBJECTIVES 
 
At the end of this lesson, the learner should be able to: 

1. Explain the concept and categories of computer software. 
2. Distinguish between system software, application software, and utility software. 
3. Analyse the role of software in hospital information systems. 
4. Apply software knowledge to healthcare operational requirements. 
5. Evaluate software selection and usage issues in hospital management. 

 
STRUCTURE 
 
1.0 INTRODUCTION TO COMPUTER SOFTWARE 

1.2 SYSTEM SOFTWARE 

1.2 APPLICATION SOFTWARE 

1.3 PROGRAMMING SOFTWARE 

1.4 UTILITY SOFTWARE 

1.5 MIDDLEWARE SOFTWARE 

1.6 OPEN-SOURCE SOFTWARE (OSS) 

1.7 SUMMARY 

1.8 KEYWORDS 

1.9 SELF-ASSESSMENT QUESTIONS 

1.10 SUGGESTED READINGS 

 
1.0 INTRODUCTION TO COMPUTER SOFTWARE 
 
Computer software is a collection of programs, instructions, and data that tell a computer how 
to perform tasks. While hardware is the physical part of a computer, software is the intelligence 
that makes hardware functional. 
Definition: 
Software is a set of instructions written using programming languages that directs the computer 
to perform specific operations. 
 
2. Characteristics of Software 

 Intangible (cannot be touched) 
 Developed, not manufactured 
 Does not wear out 
 Easy to modify and update 
 Can run across multiple hardware platforms 
 Requires installation and configuration 
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3. Types of Computer Software 
Computer software is broadly classified into two categories: 

1. System Software 
2. Application Software 

Additionally, we also include: 
 Utility Software 
 Programming Software 
 Middleware 
 Open-source vs Proprietary Software 

 
Introductory Case Study: Software Failure and Patient Care Disruptions in a 
Corporate Hospital 
Background of the Organisation / Sector 
A well-known corporate multi-specialty hospital chain in India adopted an advanced 
Hospital Information System (HIS) to integrate patient registration, clinical documentation, 
laboratory services, pharmacy, and billing. The hospital invested heavily in hardware and 
networking infrastructure but relied on generic off-the-shelf software without adequate 
customization or staff training. 
Contextual Trigger / Problem Situation 
Within months of implementation, the hospital faced: 

 Frequent system crashes during peak hours 
 Incomplete or inconsistent patient records 
 Delays in laboratory result uploads 
 Billing mismatches and insurance claim rejections 

Although hardware performance was adequate, most problems were traced to software 
limitations and improper configuration. 
Stakeholders Involved 

 Hospital administrators 
 Doctors and nursing staff 
 IT department and software vendors 
 Patients and insurance companies 

Behavioural / Managerial Issues 

 Inadequate understanding of software capabilities 
 Poor alignment between clinical workflows and software design 
 Resistance from clinicians unfamiliar with digital systems 
 Overdependence on vendors for troubleshooting 

Why This Case Is Important for the Lesson 
The case demonstrates that software is the controlling intelligence of a computer system. 
Even the best hardware cannot function effectively without suitable system software and 
well-designed application software. 
Explicit Linkage to Lesson Concepts 
This case directly links to: 

 Meaning and types of computer software 
 System software vs application software 
 Utility software and performance management 
 Importance of software in healthcare delivery 
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1.2 SYSTEM SOFTWARE  
 
1. Introduction to System Software 
System software is a category of computer software designed to manage hardware 
components, run application software, and control overall system operations. 
Definition: 
System software is a set of programs that acts as an interface between the hardware and the 
user/application software. 
Key Functions 

 Controls hardware devices 
 Manages system resources 
 Enables application execution 
 Ensures security and stability 
 Provides user interface 
 Handles file management 

 
2. Characteristics of System Software 

 Close interaction with hardware 
 Written in low-level or assembly languages 
 Fast and efficient execution 
 Less interactive for users 
 Difficult to design and modify 
 Essential for computer functioning 

 
3. Types of System Software 
System software is broadly classified into: 

1. Operating System (OS) 
2. Device Drivers 
3. Firmware 
4. Utility Software 
5. System Management Software 
6. Compilers and Translators 

Let us understand each in detail. 
 
4. Operating System (OS) 
The operating system is the most important system software that manages hardware resources 
and provides services for application programs. 
 
4.1 Functions of Operating System 
A. Process Management 

 Controls running programs (processes) 
 Schedules tasks (multitasking, multiprocessing) 

B. Memory Management 
 Allocates and deallocates RAM 
 Manages virtual memory 

C. File System Management 
 Creates, reads, writes, deletes files 
 Organizes them into folders/directories 

D. Device Management 
 Controls input/output devices 
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 Uses device drivers for communication 
E. Security & Protection 

 Authentication (password/PIN/biometric) 
 Authorization and access control 
 Firewalls and permissions 

F. User Interface 
 GUI (Windows, macOS) 
 CLI (Linux terminal, Command Prompt) 

G. Networking 
 Supports internet, TCP/IP, Wi-Fi, LAN, Bluetooth 

 
4.2 Types of Operating Systems 
1. Single-User OS 

 Used by one person at a time 
 Example: Windows 11 Home 

2. Multi-User OS 
 Allows simultaneous users 
 Example: UNIX, Linux 

3. Real-Time Operating System (RTOS) 
 Fast response 
 Used in robotics, medical instruments, defence systems 
 Example: VxWorks 

4. Embedded OS 
 Used in embedded systems 
 Example: Android, iOS, Smart TV OS 

5. Distributed OS 
 Manages a group of computers as one system 
 Example: Amoeba OS 

6. Mobile OS 
 Used in smartphones and tablets 
 Example: Android, iOS 

 
5. Device Drivers 
Device drivers are specialized system software programs that help the OS communicate with 
hardware. 
 
 
 
Need for Drivers 

 OS cannot directly understand hardware signals 
 Driver acts as a translator 

Examples 
 Printer driver 
 Graphic card driver (NVIDIA/AMD) 
 Audio driver 
 USB driver 
 Network driver 

Types of Device Drivers 
 Kernel-mode drivers 
 User-mode drivers 
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 Virtual device drivers 
 
6. Firmware 
Firmware is a set of instructions permanently stored in ROM or flash memory. 
Functions 

 Controls low-level operations 
 Initializes hardware 
 Provides boot instructions 

Examples 
 BIOS/UEFI 
 Router firmware 
 Smartwatch firmware 
 Medical device firmware 

Characteristics 
 Non-volatile 
 Hard to modify 
 Highly reliable 

7. Utility Software 
Utility software helps in the maintenance, optimization, and security of the computer system. 
Types of Utility Software 
1. Security Utilities 

 Antivirus 
 Firewall 
 Encryption tools 

2. Storage Utilities 
 Disk cleanup 
 Disk defragmenter 
 Backup utilities 

3. File Management Utilities 
 Compression tools (WinRAR, 7-Zip) 
 File recovery tools 

4. System Monitoring Utilities 
 Task Manager 
 Performance Monitor 

5. Networking Utilities 
 Ping tools 
 Wi-Fi analyzers 
 Remote desktop 

 
8. System Management Software 
Helps administrators manage computer networks, servers, and security. 
Examples 

 Device management tools 
 Server monitoring tools 
 Patch management systems 
 Virtualization software (VMware, Hyper-V) 

 
9. Translators (Part of System Software) 
Translators convert high-level programming code into machine language. 
Types 
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 Compiler – Converts entire program at once 
 Interpreter – Converts one line at a time 
 Assembler – Converts assembly language into machine code 

Examples 
 GCC Compiler 
 Python Interpreter 
 MASM Assembler 

 
10. System Software vs Application Software 
Feature System Software Application Software 

Purpose Manages hardware Helps user perform tasks 

Runs Background As per user request 

Examples OS, drivers, utilities MS Word, browsers 

Developed using Low-level languages High-level languages 

Dependency Needed for system startup Runs on top of OS 
 
11. Installation & Maintenance of System Software 
Installation Includes: 

 OS setup 
 Driver installation 
 Firmware updates 
 Security configuration 

Maintenance Includes: 
 System updates 
 Disk and memory cleaning 
 Security patches 
 Backup scheduling 

 
12. Importance of System Software 

 Essential for system functioning 
 Provides platform for application software 
 Ensures efficient resource utilization 
 Enhances system performance 
 Protects from security threats 
 Manages hardware reliability 

 
13. Trends in Modern System Software 

 Cloud-based operating systems 
 AI-powered system monitoring 
 Container-based systems (Docker) 
 Virtualization and hypervisors 
 Edge and IoT operating systems 
 Enhanced security features (Secure Boot, TPM) 

 
14. Examples of Popular System Software 
Operating Systems 

 Windows 10/11 
 macOS Ventura 
 Linux distributions: Ubuntu, Fedora, Mint 
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Drivers 
 NVIDIA GeForce drivers 
 Realtek audio drivers 

Utilities 
 CCleaner 
 Windows Defender 
 macOS Disk Utility 

Firmware 
 UEFI BIOS 
 Router firmware (Netgear, TP-Link) 

 
1.2 Application Software  
1. Introduction to Application Software 
Application software refers to programs designed to help users perform specific tasks on a 
computer. Unlike system software (which manages hardware), application software focuses on 
enhancing productivity, creativity, and communication. 
 
Key Characteristics 

 Designed for end-users 
 Performs specific functional tasks 
 Runs on top of system software/OS 
 Can be standalone or part of a software suite 
 Regular updates to improve features and security 

 
2. Categories of Application Software 
Application software can be broadly classified into the following major categories: 
 
A. General-Purpose Application Software 
Used in day-to-day tasks across all industry sectors. 
Examples & Descriptions 
1. Word Processing Software 
Used for creating and editing textual documents. 
Examples: MS Word, Google Docs, LibreOffice Writer 
Features: Spell check, formatting, templates, mail merge, collaboration. 
2. Spreadsheet Software 
Used for performing calculations, data analysis, and visualization. 
Examples: MS Excel, Google Sheets, Lotus 1-2-3 
Features: Formulas, charts, pivot tables, macros, conditional formatting. 
3. Presentation Software 
Used to create slideshow presentations. 
Examples: MS PowerPoint, Google Slides, Keynote 
Features: Animations, transitions, templates, multimedia integration. 
4. Database Management Software (DBMS) 
Used to store, retrieve, and manage large amounts of structured data. 
Examples: MS Access, MySQL Workbench, Oracle SQL Developer 
Features: Query creation, reports, forms, relational data management. 
5. Communication Software 
Enables exchange of information electronically. 
Examples: Outlook, Gmail, WhatsApp Web, Zoom, MS Teams 
Features: Email, chat, video conferencing, file sharing. 
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6. Web Browsers 
Provide access to the internet and websites. 
Examples: Chrome, Firefox, Edge, Safari 
Features: Bookmarks, extensions, privacy controls, tab management. 
 
B. Specialized / Domain-Specific Application Software 
Designed for particular industries or professional tasks. 
Examples 
1. Accounting Software 
Used by businesses to manage financial transactions. 
Examples: Tally ERP, QuickBooks, Zoho Books 
Features: Ledger management, GST support, payroll, invoicing. 
2. Graphic Design & Multimedia Software 
Used to create images, videos, animations, and audio. 
Examples: Adobe Photoshop, Illustrator, Premiere Pro, CorelDRAW 
Features: Layer editing, color correction, rendering, timeline editing. 
3. Engineering & Scientific Software 
Used for modeling, simulation, and analysis. 
Examples: MATLAB, AutoCAD, ANSYS, SolidWorks 
Features: 3D modeling, simulation, mathematical computation. 
4. Medical & Healthcare Software 
Used in hospitals/healthcare setups. 
Examples: HIS, PACS, LIS, EMR/EHR systems 
Features: Patient data management, test results, imaging, billing. 
5. Education & E-learning Software 
Used in academic institutions. 
Examples: Moodle, Google Classroom, Byju’s 
Features: Online tests, content management, performance tracking. 
6. Project Management Software 
Used for planning, tracking, and executing projects. 
Examples: MS Project, Trello, Jira, Asana 
Features: Gantt charts, task assignments, progress tracking. 
 
C. Custom Software 
Developed specifically for an organization to meet unique requirements. 
 
Examples 

 Hospital Management Systems 
 Hotel Reservation Systems 
 Inventory Management Systems 
 Banking Systems 

Advantages 
 Tailor-made 
 Higher efficiency 
 Integration with organizational workflows 

Disadvantages 
 Higher cost 
 Longer development time 
 Requires maintenance 

D. Open-Source Application Software 
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Software whose source code is freely available for modification and distribution. 
Examples 

 LibreOffice 
 GIMP 
 Blender 
 VLC Media Player 

Advantages 
 Free to use 
 Highly customizable 
 Large community support 

Disadvantages 
 Limited official support 
 Compatibility issues sometimes 

 
3. Distribution Methods of Application Software 
1. Freeware 
Free to use but source code not editable. 
Examples: Adobe Reader, Skype. 
2. Shareware 
Initially free, but payment needed for full features. 
Examples: WinRAR, IDM trial. 
3. Commercial Software 
Paid licensed software. 
Examples: MS Office, Adobe Suite. 
4. Subscription-Based Software 
Users pay monthly or yearly charges. 
Examples: Office 365, Google Workspace. 
5. Software-as-a-Service (SaaS) 
Cloud-based, accessed over internet. 
Examples: Salesforce, Dropbox, Zoho CRM. 
 
4. Advantages of Application Software 

 Enhances productivity 
 Easy to use for specific tasks 
 Automates complex processes 
 Improves accuracy and efficiency 
 Enables professional-quality output 

 
5. Disadvantages of Application Software 

 Can be expensive 
 Needs regular updates 
 May require training 
 Compatibility issues between software versions 
 Security risks if not updated 

 
6. Trends in Application Software 

 AI-powered applications (ChatGPT, Copilot, AI writing tools) 
 Cloud-based applications 
 Mobile-first software development 
 Cross-platform and hybrid apps 
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 Low-code / No-code development tools 
 Augmented & Virtual Reality apps 

 
Activity 1: Reflective Exercise 
Task: 
List the different software applications used in a hospital OPD and explain their purpose. 
………………………………………………………………………………………………… 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
Expected Learning Outcome: 
Enhances understanding of application software in real healthcare settings. 
 
1.3 Programming Software  
 
1. Introduction to Programming Software 
Programming software refers to tools that help developers create, test, debug, and maintain 
computer programs. These tools provide an environment where programmers can write code 
efficiently, organize large projects, test logic, and correct errors. 
Programming software forms the backbone of software development and supports all stages of 
the Software Development Life Cycle (SDLC). 
 
2. Functions of Programming Software 
Programming software helps in: 

 Writing source code in programming languages 
 Editing and organizing code 
 Compiling or interpreting programs 
 Debugging errors 
 Testing software functionality 
 Documentation and version control 
 Managing large software projects 

 
3. Types of Programming Software 
Programming software consists of several tools and categories: 
 
A. Text Editors / Code Editors 
Used for writing and editing programming code. 
Features 

 Syntax highlighting 
 Auto-indentation 
 Code suggestions (IntelliSense) 
 Search and replace 
 Extensions and plugins 

Examples 
 Notepad++ 
 Visual Studio Code 
 Sublime Text 
 Atom 
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B. Integrated Development Environments (IDE) 
An IDE is a complete environment that integrates editor, compiler/interpreter, debugger, and 
project management tools. 
Components of an IDE 

 Code Editor 
 Compiler/Interpreter 
 Debugger 
 Build automation tools 
 UI designers 
 Version control support 

Examples 
 Eclipse 
 PyCharm 
 Visual Studio 
 NetBeans 
 Android Studio 
 Turbo C / Turbo C++ 

Advantages of IDEs 
 Faster development 
 Automatic error detection 
 Easy project management 
 Integrated testing and debugging 

 
C. Compilers 
A compiler translates high-level programming code into machine language (binary) in a 
single step. 
Features 

 Converts entire code at once 
 Generates an executable file 
 Provides error list after full compilation 
 Optimization of code 

Examples 
 GCC (GNU Compiler Collection) 
 Clang 
 Microsoft C++ Compiler 
 Java Compiler (javac) 

Suitable Languages 
 C, C++, Java, Go, Rust 

 
D. Interpreters 
An interpreter translates and executes code line-by-line. 
 
Features 

 Executes code step-by-step 
 Easier debugging 
 No separate executable file created 

Examples 
 Python Interpreter (CPython) 
 Ruby Interpreter (MRI) 
 JavaScript Engines (V8, SpiderMonkey) 
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 PHP Interpreter 
Suitable Languages 

 Python, JavaScript, Ruby, PHP 
 
E. Debuggers 
Used to test and detect errors ("bugs") in software. 
Functions 

 Breakpoints 
 Step-in, step-out execution 
 Variable analysis 
 Memory dump 
 Runtime behavior observation 

Examples 
 GDB (GNU Debugger) 
 Visual Studio Debugger 
 Chrome Developer Tools 
 WinDbg 

 
F. Assemblers 
Convert assembly language into machine code. 
Examples 

 MASM (Microsoft Assembler) 
 NASM (Netwide Assembler) 
 GNU Assembler (GAS) 

 
G. Linkers 
Linkers combine multiple object files into a single executable program. 
Functions 

 Resolves function calls 
 Manages libraries 
 Produces final executable file 

Examples 
 LD (GNU Linker) 
 MS Linker 

 
H. Loaders 
Loaders load programs into memory for execution. 
Functions 

 Allocate memory 
 Load libraries 
 Prepare the program for execution 

 
I. Version Control Software 
Used to track code changes, collaborate, and maintain project history. 
Examples 

 Git 
 GitHub 
 GitLab 
 Bitbucket 

Features 
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 Branching and merging 
 Change history 
 Collaboration 
 Backup of code 

 
J. Build Automation Tools 
Used to compile, test, and deploy software automatically. 
Examples 

 Maven 
 Gradle 
 Jenkins 
 Make 

 
K. Testing Tools 
Used to verify correctness and performance. 
Examples 

 JUnit 
 Selenium 
 Postman (API Testing) 
 PyTest 

 
L. Scripting Tools 
Used for automating repetitive development tasks. 
Examples 

 Shell scripting (Bash) 
 PowerShell 
 Python scripts 

 
4. Examples of Programming Languages and Their Tools 
Language Common Tools 

C/C++ GCC, Clang, Visual Studio, Code::Blocks 

Java JDK, Eclipse, NetBeans, IntelliJ 

Python IDLE, PyCharm, VS Code, Jupyter 

JavaScript Node.js, npm, browser dev tools 

PHP XAMPP, WAMP, PHPStorm 

Android Android Studio, Gradle 

.NET Visual Studio, Roslyn 
 
5. Advantages of Programming Software 

 Increases development speed 
 Improves accuracy and reduces bugs 
 Helps manage complex projects 
 Supports multiple programming languages 
 Provides advanced debugging and testing tools 
 Encourages collaboration through version control 

 
6. Disadvantages of Programming Software 

 Advanced IDEs require high system resources 
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 Learning curve for beginners 
 Commercial tools may be expensive 
 Compatibility issues between tool versions 

 
7. Role of Programming Software in SDLC 
Programming software supports these SDLC phases: 

 Development – writing code 
 Testing – detecting and fixing errors 
 Deployment – building final software 
 Maintenance – updating and enhancing code 

 
Activity 2: Mini Application Task 
Task: 
Suggest suitable system software and application software for a diagnostic laboratory. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Develops practical software selection skills. 
 
1.4 Utility Software  
1. Introduction to Utility Software 
Utility software refers to system support programs that help manage, maintain, optimize, and 
secure the computer system. 
They are not directly involved in performing user tasks, but they ensure smooth, reliable, 
secure, and efficient functioning of the system. 
Utility software works alongside system software to: 

 Improve performance 
 Protect data 
 Manage files 
 Monitor system resources 
 Perform backups and recovery 

 
2. Characteristics of Utility Software 

 Performs specific maintenance tasks 
 Enhances the functionality of operating systems 
 Focused on system health, performance, and security 
 Lightweight and simple user interface 
 Often works in the background 

 
3. Types of Utility Software 
Utility software can be classified into several categories: 
A. File Management Utilities 
These utilities help users manage, organize, and manipulate files and folders. 
Examples 

 File Explorer (Windows) 
 Finder (MacOS) 
 WinRAR 
 7-Zip 
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Functions 
 Copy, paste, delete, rename 
 Compress or decompress files 
 Search and organize files 
 Manage storage and partitions 

 
B. Disk Management Utilities 
These help manage hard disks and storage devices. 
Examples 

 Disk Cleanup 
 Disk Management (Windows) 
 CHKDSK 
 Defragmentation tools 
 Partition Manager 

Functions 
 Create, delete, or format partitions 
 Defragment disk to boost speed 
 Check and repair disk errors 
 Remove temporary and junk files 

 
C. Backup and Recovery Utilities 
Used for creating copies of data and restoring them during system failures. 
Examples 

 Windows Backup & Restore 
 Time Machine (Mac) 
 Acronis True Image 
 Cloud backup services (Google Drive, OneDrive) 

Functions 
 Automatic backup scheduling 
 System restore 
 File recovery 
 Cloud and local backups 

 
D. Security Utilities 
Protect the system from threats such as viruses, malware, and unauthorized access. 
Types & Examples 

 Antivirus: Windows Defender, QuickHeal, McAfee 
 Anti-Malware: Malwarebytes, Spybot 
 Firewall: Windows Firewall, ZoneAlarm 
 Encryption Tools: BitLocker, VeraCrypt 

Functions 
 Detect and remove threats 
 Real-time protection 
 Safe browsing 
 Firewall monitoring 
 Encrypt sensitive data 

 
E. Performance Monitoring Utilities 
These tools track and report the performance of system resources. 
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Examples 
 Task Manager (Windows) 
 Activity Monitor (MacOS) 
 Resource Monitor 
 CPU-Z 
 GPU-Z 

Functions 
 Monitor CPU, RAM, disk, GPU usage 
 Manage startup programs 
 Kill unresponsive applications 
 Performance analytics 

 
F. Compression Utilities 
These utilities reduce file size for storage and sharing. 
Examples 

 WinZip 
 WinRAR 
 7-Zip 
 RAR 

Functions 
 Compress large files 
 Decompress ZIP, RAR, 7Z formats 
 Password protection for archives 
 Better storage management 

 
G. Networking Utilities 
Used to test, manage, and troubleshoot network connections. 
Examples 

 Ping 
 Traceroute 
 ipconfig / ifconfig 
 FTP clients (FileZilla) 
 Network analyzers (Wireshark) 

Functions 
 Test connectivity 
 Diagnose network problems 
 Manage file transfers 
 Analyze network traffic 

H. System Maintenance Utilities 
Tools designed to improve overall system health and stability. 
Examples 

 CCleaner 
 Glary Utilities 
 System Restore 
 Windows Update 

Functions 
 Remove junk files 
 Manage registry 
 Fix system issues 
 Update OS and drivers 
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I. Device Management Utilities 
Used to manage connected devices and drivers. 
Examples 

 Device Manager (Windows) 
 Driver Booster 
 Printer utilities 

Functions 
 Update drivers 
 Install/uninstall hardware 
 Troubleshoot device errors 

 
J. File Conversion Utilities 
Convert one file format into another. 
Examples 

 Format Factory 
 PDF converters 
 Audio/video converters 

Functions 
 Convert documents, images, videos, audio 
 Reduce file format compatibility issues 

 
K. Accessibility Utilities 
These utilities help users with physical disabilities use a computer effectively. 
Examples 

 Magnifier, Narrator (Windows) 
 Screen readers 
 On-screen keyboard 
 Speech-to-text tools 

Functions 
 Assist visually impaired users 
 Support for keyboard/mouse disabled users 
 Voice control tools 

 
4. Importance of Utility Software 
Utility software is essential because it: 

 Improves system performance 
 Prevents data loss 
 Enhances computer security 
 Simplifies file management 
 Helps diagnose system issues 
 Optimizes resource usage 

Without utility software, systems would become slow, unprotected, and inefficient. 
 
5. Differences Between System Software and Utility Software 
Feature System Software Utility Software 

Purpose 
Manages hardware and system 
operations 

Maintains and optimizes system 
performance 

Examples OS, Drivers Antivirus, Backup tools 
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Feature System Software Utility Software 

Works Always runs in background Runs when needed 

Dependency Required for system operation Enhances performance but not mandatory 
 
6. Examples of Most Common Utility Software 

 Windows Defender 
 Disk Cleanup 
 Recycle Bin 
 WinRAR / 7-Zip 
 CCleaner 
 Backup and Restore 
 BitLocker 
 System Restore 
 Device Manager 
 Network Troubleshooter 

 
Activity 3: Analytical Writing Task 
Task: 
Explain why user training is as important as software quality in hospitals. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Improves analytical and managerial reasoning. 
 
1.5 Middleware Software  
1. Introduction to Middleware Software 
Middleware is a software layer that sits between the operating system and application 
software to enable communication, data exchange, and integration between different 
applications or distributed systems. 
It acts as “glue software” that connects: 

 Applications with other applications 
 Applications with databases 
 Applications with networks 
 Applications with cloud services 

Middleware is essential in distributed computing, client–server architectures, enterprise 
software, and cloud environments. 
 
2. Need for Middleware 
Modern applications require: 

 Communication across networks 
 Sharing of data between different platforms 
 Integration of multiple systems 
 Reliable message handling 
 Transaction management 

Middleware solves these challenges by: 
 Enabling interoperability 
 Simplifying complex communication 
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 Providing uniform interfaces 
 Handling background connectivity 

3. Characteristics of Middleware 
 Supports heterogeneous environments (Windows, Linux, Mainframes, Cloud) 
 Provides communication abstraction 
 Enhances scalability 
 Ensures data consistency in transactions 
 Supports security and authentication 
 Works behind the scenes for enterprise applications 

 
4. Types of Middleware 
Middleware is classified into several important categories: 
 
A. Database Middleware (DB Middleware) 
Connects applications to databases. 
Examples 

 ODBC (Open Database Connectivity) 
 JDBC (Java Database Connectivity) 
 ADO.NET 
 Oracle Call Interface 

Functions 
 Standardized communication with different databases 
 Query execution 
 Data access & manipulation 
 Connection pooling 

 
B. Message-Oriented Middleware (MOM) 
Supports communication between distributed applications using messaging. 
Examples 

 RabbitMQ 
 Apache Kafka 
 IBM MQ 
 ActiveMQ 

Functions 
 Asynchronous communication 
 Message queuing 
 High reliability and load distribution 
 Event-driven architecture support 

 
C. Web Middleware / Web Application Servers 
Enables web-based applications to communicate with server resources. 
Examples 

 Apache Tomcat 
 IBM WebSphere 
 Oracle WebLogic 
 Nginx 
 Microsoft IIS 

Functions 
 Hosting web applications 
 Handling HTTP requests 
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 Managing sessions 
 Load balancing 

 
D. Transaction Processing Monitors 
Ensure reliable processing of transactions in distributed applications. 
Examples 

 IBM CICS 
 BEA Tuxedo 
 Microsoft Transaction Server (MTS) 

Functions 
 Manages multi-step transactions 
 Ensures ACID properties 
 Fault tolerance 
 Rollback in case of failure 

 
E. Remote Procedure Call (RPC) Middleware 
Allows applications to execute procedures on remote systems as if they were local. 
Examples 

 Java RMI 
 XML-RPC 
 gRPC 

Functions 
 Remote function calls 
 Simplifies distributed computing 
 Data serialization 

 
F. Object Middleware 
Supports communication between objects in distributed systems. 
Examples 

 CORBA (Common Object Request Broker Architecture) 
 DCOM (Distributed Component Object Model) 

Functions 
 Object-to-object communication 
 Interface definition through IDL 

 
G. Middleware for Mobile & Cloud Computing 
Enables applications to interact with cloud and mobile platforms. 
Examples 

 Firebase Cloud Messaging 
 AWS Lambda Middleware 
 Azure Service Bus 
 Mobile Backend as a Service (MBaaS) tools 

Functions 
 Authentication 
 Mobile push notifications 
 Storage access 
 API management 

H. API Middleware / Integration Middleware 
Handles API messaging, routing, and transformation. 
Examples 
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 MuleSoft 
 Dell Boomi 
 Apigee API Management 
 Postman (API Integration Testing) 

Functions 
 API calls routing 
 Data transformation 
 Security management 
 Service orchestration 

 
5. Features of Middleware 
Middleware provides powerful capabilities: 
1. Connectivity 
Connects applications running on different platforms. 
2. Interoperability 
Allows systems developed in different languages to work together. 
3. Security 
Provides authentication, authorization, encryption. 
4. Scalability 
Supports large, enterprise-level environments. 
5. Data Management 
Handles data access, conversion, and transfer. 
6. Reliability 
Provides error handling, failover, and recovery. 
 
6. Architecture of Middleware 
Middleware generally sits between: 
User Interface → Application Layer → Middleware → Database/Server Layer → 
Hardware/OS 
It acts as a translator and coordinator across layers. 
 
7. Real-World Examples of Middleware Use 
1. E-commerce Systems 

 Payment gateways 
 Inventory systems 
 Customer management 

2. Hospital Information Systems (HIS) 
 Lab, Pharmacy, Radiology, Billing modules connected via middleware 

3. Banking Systems 
 ATM networks communicating with banking servers 

4. Airline Reservation Systems 
 Real-time ticketing 
 Seat allocation 

5. Cloud & Mobile Apps 
 Synchronization across multiple devices 

 
8. Advantages of Middleware 

 Simplifies application development 
 Faster communication between systems 
 Supports distributed and cloud environments 
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 Enables system integration 
 Reduces code duplication 
 Enhances performance with caching and queues 

 
9. Disadvantages of Middleware 

 Can be costly (enterprise middleware) 
 Requires technical expertise 
 Complexity in implementation 
 Performance issues if not configured properly 

 
1.6 Open-Source Software (OSS)  
 
1. Introduction to Open-Source Software 
Open-Source Software (OSS) refers to software whose source code is publicly accessible, 
allowing anyone to view, modify, use, and distribute it. OSS is built on transparency, 
collaboration, and community-driven development. 
Key Principles 

 Free Redistribution: Can be shared without restrictions. 
 Source Code Availability: Must provide the human-readable source code. 
 Permission to Modify: Users can enhance or adapt the software. 
 No Discrimination: No restrictions on persons, groups, or fields of use. 
 License Integrity: Rights are preserved even when redistributed. 

 
2. Characteristics of Open-Source Software 

1. Transparency: Users see how software works internally. 
2. Security: Many developers inspect and improve code. 
3. Flexibility: Can be customized for specific needs. 
4. Community Support: Developers worldwide contribute. 
5. Cost-Effective: Usually available free of cost. 
6. Platform Independent: Many OSS tools support multiple operating systems. 
7. Frequent Updates: Community-driven patches and improvements. 

 
3. Advantages of Open-Source Software 
A. Technical Advantages 

 Enhanced reliability due to peer review. 
 Scalability for small to enterprise-level applications. 
 Easy integration with other systems. 
 Strong documentation and community forums. 

B. Business Advantages 
 Reduction in licensing fees. 
 No vendor lock-in. 
 Freedom to modify and deploy widely. 
 Long-term sustainability (supported by community). 

 
4. Disadvantages of Open-Source Software 

 Limited official support (compared to proprietary software). 
 Compatibility issues with some hardware or specialized systems. 
 Security risks if updates/patches are not managed promptly. 
 Steep learning curve for some OSS tools. 
 No guaranteed service level agreement (unless paid support is purchased). 
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5. Popular Open-Source Licenses 
Open-Source Software is governed by licenses that define how software can be used and 
distributed. Some major licenses include: 
1. GNU General Public License (GPL) 

 Strong “copyleft.” 
 Any modifications must also be open-source. 

 
2. MIT License 

 Very permissive. 
 Allows reuse, modification, and distribution even in commercial software. 

3. Apache License 2.0 
 Allows commercial use. 
 Offers explicit patent protection. 

4. BSD License 
 Very flexible. 
 Fewer restrictions on redistribution. 

 
6. Examples of Open-Source Software 
Operating Systems 

 Linux (Ubuntu, Fedora, Debian) 
 FreeBSD 

Office Suites 
 LibreOffice 
 Apache OpenOffice 

Browsers 
 Mozilla Firefox 
 Chromium 

Programming Languages 
 Python 
 PHP 
 Java (OpenJDK) 

Databases 
 MySQL 
 PostgreSQL 
 MongoDB (Community Edition) 

Graphic Tools 
 GIMP 
 Inkscape 
 Blender 

Server Tools 
 Apache HTTP Server 
 NGINX 
 Docker (Community Edition) 

 
7. Open-Source Software in Different Domains 
Education 

 Moodle (LMS) 
 Koha (Library management) 

Healthcare 
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 OpenMRS (Medical record system) 
 OpenEMR (Electronic medical records) 

Cloud & DevOps 
 Kubernetes 
 Terraform 
 Jenkins 

 
AI & Data Science 

 TensorFlow (Open-source framework) 
 Scikit-learn 
 PyTorch 

 
8. Open-Source Software Development Model 
OSS development follows a community-driven approach: 
1. Contributor Model 

 Anyone can contribute using GitHub/GitLab. 
 Maintainers review and accept contributions. 

2. Version Control 
 Mostly uses Git. 
 Public repositories allow collaboration. 

3. Release Cycle 
 Frequent updates. 
 “Stable” and “development” versions. 

4. Community Structure 
 Core maintainers 
 Contributors 
 Testers 
 Users (feedback providers) 

 
1.7 SUMMARY 
 
Computer software refers to the set of programs and instructions that tell a computer how to 
perform tasks. It acts as an interface between the user and the hardware. Software is broadly 
classified into system software, such as operating systems and device drivers, and application 
software, such as word processors and spreadsheets. Without software, hardware cannot 
perform any meaningful work. Software makes computers useful by enabling users to create 
documents, analyze data, communicate, and manage information efficiently. 
 
1.8 KEY WORDS 
 

System Software – Software that manages hardware resources and controls basic computer 
operations. 
Application Software – Programs designed to help users perform specific tasks like 
writing or calculations. 
Operating System – The main software that controls and coordinates all activities of a 
computer. 
Device Drivers – Specialized programs that allow the operating system to communicate 
with hardware devices. 
Utility Software – Programs used for system maintenance such as antivirus and disk 
cleanup. 
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Self-Assessment Questions 
A. Short-Answer Questions (5) – with Answers 

1. What is computer software? 
A set of programs and instructions that direct a computer to perform tasks. 

2. What is system software? 
Software that manages hardware and provides a platform for applications. 

3. Give two examples of application software used in hospitals. 
Hospital Information System, Laboratory Information System. 

4. What is utility software? 
Programs that maintain and optimise computer performance. 

5. Why is software important in healthcare management? 
It enables data processing, decision-making, and service integration. 

 
B. Essay-Type Questions (5) – with Guiding Hints 

1. Explain the different types of computer software. 
Hints: System, application, utility software 

2. Discuss the role of operating systems in computer functioning. 
Hints: Resource management, user interface 

3. Analyse the importance of application software in hospitals. 
Hints: EMR, diagnostics, billing 

4. Differentiate between system software and application software. 
Hints: Purpose, users, examples 

5. Evaluate the challenges involved in implementing hospital software systems. 
Hints: Cost, training, compatibility, security 

 
C. Multiple Choice Questions (5) – Analytical 

1. Which software acts as an interface between user and hardware? 
a) Application software 
b) Utility software 
c) Operating system 
d) Antivirus software 
Correct Answer: c 

2. Hospital Information System (HIS) is an example of: 
a) System software 
b) Application software 
c) Utility software 
d) Firmware 
Correct Answer: b 

3. Which utility software is most critical for hospital data protection? 
a) Word processor 
b) Disk defragmenter 
c) Antivirus program 
d) Media player 
Correct Answer: c 

4. Which factor is most important when selecting hospital software? 
a) Colour of interface 
b) Compatibility with workflows 
c) Popularity of vendor 
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d) Size of installation file 
Correct Answer: b 

5. Why does software require regular updates in hospitals? 
a) To increase file size 
b) To add unnecessary features 
c) To fix bugs and security vulnerabilities 
d) To reduce hardware life 
Correct Answer: c 
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1. Norton, P., Introduction to Computers and Communications, Tata McGraw-Hill, New 
Delhi, 2009. 

2. Rajaraman, V., Introduction to Information Technology, Prentice Hall of India, New 
Delhi, 2008. 

3. Goel, A., Computer Fundamentals, Pearson Education, New Delhi, 2010. 
4. Saxena, S., & Chopra, P., Computer Applications in Management, Vikas Publishing 

House, New Delhi, 2012. 
5. O’Brien, J. A., &Marakas, G. M., Management Information Systems, McGraw-Hill, 

New York, 2011. 
 

B. Other Reference Material 
 Ministry of Health & Family Welfare, Government of India – Digital Health 

&eHospital Reports 
 World Health Organization – Digital Health and HIS Publications 
 National Digital Health Mission (NDHM) Guidelines 
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LESSON- 4 

COMPUTER NETWORKS 
 
LEARNING OBJECTIVE 
 
At the end of this lesson, the learner should be able to: 

1. Explain the concept and components of computer networks. 
2. Distinguish between different types of networks such as LAN, MAN, and WAN. 
3. Analyse network topologies and their relevance to healthcare organisations. 
4. Apply networking concepts to hospital information and communication systems. 
5. Evaluate the role of computer networks in improving healthcare service delivery. 

 
STRUCTURE 
 
1.0 INTRODUCTION TO COMPUTER NETWORKS 

1.1 NETWORK MODELS 

1.2 TYPES OF COMPUTER NETWORKS 

1.3 SUMMARY 

1.4 KEYWORDS 

1.5 SELF-ASSESSMENT QUESTIONS 

1.6 SUGGESTED READINGS 

 
1.0 INTRODUCTION TO COMPUTER NETWORKS 
 
A computer network is a collection of two or more computers and devices connected together 
to share resources such as data, hardware, and software. 
Objectives of Networking 

 Resource sharing (printers, storage, software) 
 Data sharing and communication 
 Cost reduction 
 Reliability and availability 
 Scalability 

 
2. Components of a Computer Network 
2.1 Hardware Components 

 Nodes (Computers/Servers): Devices that send/receive data 
 Network Interface Card (NIC): Connects device to network 
 Hub: Basic device that broadcasts data 
 Switch: Smart device that forwards data to correct device 
 Router: Connects different networks (LAN to WAN) 
 Modem: Converts digital to analog signals and vice versa 
 Access Point: Provides wireless connectivity 

2.2 Transmission Media 
 Guided Media (Wired): 

o Twisted Pair Cable (UTP/STP) 
o Coaxial Cable 
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o Fiber Optic Cable 
 Unguided Media (Wireless): 

o Radio Waves 
o Microwaves 
o Infrared 
o Satellite Communication 

 
 
1.1 Network Models 
1. OSI Model (7 Layers) 

 

 
Layer Name Function 
7 Application User interface to network 
6 Presentation Data formatting and encryption 
5 Session Session management 
4 Transport End-to-end communication (TCP/UDP) 
3 Network Logical addressing (IP) 
2 Data Link MAC addressing and framing 
1 Physical Transmission of raw bits 
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2. TCP/IP Model 
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Layer Function 
Application User services (HTTP, FTP, SMTP) 
Transport TCP, UDP 
Internet IP addressing and routing 
Network Access Physical transmission 

 
3. Network Protocols 
Common protocols used in networks: 

 TCP (Transmission Control Protocol): Reliable, connection-oriented 
 UDP (User Datagram Protocol): Fast, connectionless 
 IP (Internet Protocol): Handles addressing and routing 
 HTTP/HTTPS: Web communication 
 FTP: File transfer 
 SMTP: Sending emails 
 DNS: Converts domain names to IP addresses 
 DHCP: Automatically assigns IP addresses 

4. IP Addressing 
4.1 IPv4 Addressing 

 32-bit address (e.g., 192.168.1.1) 
 Written in dotted decimal format 

4.2 Classes of IP Addressing 
Class Range Default Subnet Mask 
A 1.0.0.0 – 126.0.0.0 255.0.0.0 
B 128.0.0.0 – 191.255.0.0 255.255.0.0 
C 192.0.0.0 – 223.255.255.0 255.255.255.0 
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4.3 IPv6 Addressing 
 128-bit addresses 
 Example: 2001:0db8:85a3::8a2e:0370:7334 

 
5. Switching Techniques 

 Circuit Switching – Dedicated path (Example: Telephone networks) 
 Packet Switching – Data sent in packets (Example: Internet) 
 Message Switching – Entire message sent and stored 

 
6. Routing and Routing Protocols 
Types of Routing 

 Static Routing 
 Dynamic Routing 

Common Routing Protocols 
 RIP (Routing Information Protocol) 
 OSPF (Open Shortest Path First) 
 BGP (Border Gateway Protocol) 
 EIGRP (Enhanced Interior Gateway Routing Protocol) 

 
7. Network Security 
Common Network Threats 

 Viruses 
 Worms 
 Trojans 
 Phishing 
 Denial of Service (DoS) 

Security Mechanisms 
 Firewalls 
 Antivirus software 
 Encryption 
 VPNs (Virtual Private Networks) 
 Intrusion Detection Systems (IDS) 

 
8. Wireless Networking 
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Centre for Distance Education                         92                    Acharya Nagarjuna University 
 

9. Types of Wireless Networks 
 Wi-Fi (IEEE 802.11) 
 Bluetooth 
 Cellular Networks (3G, 4G, 5G) 
 Satellite Networks 

 
10. Client–Server and Peer-to-Peer Models 
Feature Client–Server Peer-to-Peer 
Structure Centralized Decentralized 
Control Server controlled No central control 
Example Web server File sharing 

 
11. Advantages and Disadvantages of Networks 
Advantages 

 Easy communication 
 Resource sharing 
 Data backup and recovery 
 Centralized management 

Disadvantages 
 Security risks 
 Setup cost 
 Requires skilled management 

 
Introductory Case Study: Network Failure in a Tertiary Care Hospital 
Background of the Organisation / Sector 
A large tertiary care teaching hospital with more than 1,000 beds operates round-the-clock 
emergency, diagnostic, ICU, and telemedicine services. The hospital uses a network-based 
Hospital Information System (HIS) connecting OPDs, wards, laboratories, radiology units, 
pharmacies, and billing counters. 
Contextual Trigger / Problem Situation 
One morning, the hospital experienced a network outage lasting several hours. As a result: 

 Doctors could not access electronic medical records 
 Laboratory reports were delayed 
 Pharmacy dispensing slowed down 
 Billing and insurance processing came to a halt 

Although computers were functional, the absence of network connectivity paralysed 
hospital operations. 
Stakeholders Involved 

 Hospital administrators 
 IT and network engineers 
 Doctors, nurses, and technicians 
 Patients and attendants 
 External service providers 

Behavioural / Managerial Issues 

 Over-reliance on a single network backbone 
 Inadequate redundancy and backup links 
 Limited understanding of network design among administrators 
 Delayed decision-making during crisis 
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Why This Case Is Important for the Lesson 
The case clearly demonstrates that computer networks are the backbone of modern 
healthcare systems. Without reliable networking, even well-designed hardware and software 
systems fail to deliver services. 
Explicit Linkage to Lesson Concepts 
This case links directly to: 

 Definition and importance of computer networks 
 Types of networks (LAN, MAN, WAN) 
 Network components and connectivity 
 Role of networks in healthcare coordination 

 
1.2 Types of Computer Networks  
1. Introduction 
A computer network is a collection of interconnected computers and devices that 
communicate with each other to share data, hardware, and software resources. Networks are 
classified based on geographical coverage, purpose, ownership, and architecture. 
 
2. Classification Based on Geographical Coverage 
2.1 PAN (Personal Area Network) 
Definition: 
A Personal Area Network (PAN) is a very small network centered around an individual person. 
Key Features: 

 Range: 1–10 meters 
 Uses Bluetooth, Infrared, or USB 

Examples: 
 Mobile phone connected to Bluetooth earphones 
 Laptop connected to wireless mouse 

Advantages: 
 Low cost 
 Easy to set up 

 
2.2 LAN (Local Area Network) 
Definition: 
A Local Area Network (LAN) connects computers within a limited area such as a room, 
building, school, or hospital. 
Key Features: 

 High-speed communication 
 Privately owned 

Examples: 
 Computer lab network in a college 
 Office internal network 

Advantages: 
 Fast data transfer 
 Easy resource sharing 

Disadvantages: 
 Limited geographical range 

 
2.3 WLAN (Wireless Local Area Network) 
Definition: 
A Wireless LAN (WLAN) connects devices wirelessly using Wi-Fi technology. 
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Examples: 
 Home Wi-Fi network 
 Hotspots in cafes and airports 

Advantages: 
 No physical cables 
 Mobility 

Disadvantages: 
 Security risks 
 Signal interference 

 
2.4 MAN (Metropolitan Area Network) 
Definition: 
A Metropolitan Area Network (MAN) covers an entire city or large campus. 
Examples: 

 City-wide cable TV network 
 Metro rail communication network 

Advantages: 
 Larger coverage than LAN 
 High-speed backbone 

 
2.5 WAN (Wide Area Network) 
Definition: 
A Wide Area Network (WAN) covers a very large geographical area such as countries or 
continents. 
Examples: 

 The Internet 
 Bank branch networking 

Advantages: 
 Global connectivity 
 Access to remote resources 

Disadvantages: 
 Expensive infrastructure 
 Slower than LAN 

 
3. Classification Based on Purpose 
3.1 SAN (Storage Area Network) 
Definition: 
A Storage Area Network (SAN) is a high-speed network that connects storage devices to 
servers. 
Uses: 

 Data centers 
 Large organizations 

 
3.2 CAN (Campus Area Network) 
Definition: 
A Campus Area Network (CAN) connects multiple LANs within a campus or organization. 
Examples: 

 University networks 
 Corporate office campuses 
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3.3 VLAN (Virtual Local Area Network) 
Definition: 
A VLAN is a logical network that groups devices regardless of their physical location. 
Advantages: 

 Improved security 
 Better traffic management 

 
4. Classification Based on Network Architecture 
4.1 Peer-to-Peer Network 
Definition: 
In this network, all computers have equal roles and can act as both client and server. 
Advantages: 

 Easy to set up 
 Low cost 

Disadvantages: 
 Poor security 
 Not suitable for large networks 

 
4.2 Client–Server Network 
Definition: 
A central server provides services, and clients request them. 
Advantages: 

 Centralized control 
 High security 

Disadvantages: 
 Server failure affects entire network 
 Higher cost 

5. Classification Based on Connection Method 
5.1 Wired Networks 

 Use cables (twisted pair, coaxial, fiber optic) 
 High speed and stable 

5.2 Wireless Networks 
 Use radio signals (Wi-Fi, Bluetooth, cellular networks) 
 More flexible but less secure 

 
Activity 1: Hospital Network Mapping 
Task: 
Sketch or describe the network layout of a hospital you are familiar with. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Enhances understanding of practical hospital networking structures. 
 
1.3 SUMMARY 
 
A computer network is a group of interconnected computers and devices that communicate 
with each other to share data and resources. Networks allow users to share files, printers, 
internet connections, and applications efficiently. Depending on geographical coverage, 
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networks can be classified as Local Area Network (LAN), Metropolitan Area Network (MAN), 
and Wide Area Network (WAN). Computer networks play a vital role in business, education, 
healthcare, and everyday communication through email, video calls, and cloud services. 
 
1.4 KEYWORDS 

 
LAN (Local Area Network) – A network that connects computers within a small 
geographical area like an office or school. 
WAN (Wide Area Network) – A network that connects devices over large distances such 
as cities or countries. 
Router – A device that forwards data packets between different networks. 
Protocol – A set of rules that govern data communication between devices in a network. 
Bandwidth – The maximum data transfer capacity of a network connection. 

 
Activity 2: Mini Application Task 
Task: 
Recommend a suitable network type for a rural primary health centre and justify your choice. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Develops application-oriented network planning skills. 
 
Case Study for Self-Assessment: Implementing a Hospital-Wide Network System 
Background 
A newly established 300-bed multi-specialty hospital planned to implement a fully digital 
workflow. The management decided to deploy a hospital-wide computer network 
connecting all departments, including OPD, IP wards, ICU, diagnostics, administration, and 
telemedicine units. 
Problem Development 
During implementation, several challenges emerged: 

 Choosing between wired and wireless networks 
 Deciding suitable network topology 
 Ensuring secure data transmission 
 Integrating remote clinics through WAN links 
 Managing network maintenance and downtime 

Managerial and Operational Challenges 
 Budget constraints for networking equipment 
 Balancing speed, reliability, and scalability 
 Training staff to use networked systems 
 Ensuring compliance with patient data confidentiality 

Relevance to the Lesson 
The hospital adopted: 

 LAN for internal department connectivity 
 WAN for linking satellite clinics 
 Secure network protocols for data protection 

This case highlights how network design and management decisions directly affect 
hospital efficiency and patient care. 
Analytical Questions 



MBA Hospital Administration                                   97          Information Technology for Healthcare…  

97 
 

1. Why are computer networks essential for hospital operations? 
2. Which type of network is most suitable within a hospital and why? 
3. How do network topologies influence performance and reliability? 
4. What risks arise from poorly designed hospital networks? 
5. How can hospital administrators ensure network security and continuity? 

 
 SELF-ASSESSMENT QUESTIONS 
A. Short-Answer Questions (5) – with Answers 

1. What is a computer network? 
A system of interconnected computers that share data and resources. 

2. Define LAN. 
A Local Area Network connects computers within a limited area such as a building. 

3. What is the function of a router? 
It directs data packets between different networks. 

4. Name any two advantages of computer networks in hospitals. 
Resource sharing and faster access to patient data. 

5. What is network topology? 
The physical or logical arrangement of network devices. 

 
B. Essay-Type Questions (5) – with Guiding Hints 

1. Explain the concept and importance of computer networks. 
Hints: Definition, resource sharing, communication 

2. Discuss different types of computer networks with examples. 
Hints: LAN, MAN, WAN, healthcare applications 

3. Describe various network topologies and their advantages. 
Hints: Bus, star, ring, mesh 

4. Analyse the role of computer networks in Hospital Information Systems. 
Hints: Integration, speed, coordination 

5. Evaluate challenges in implementing hospital networking systems. 
Hints: Cost, security, maintenance, scalability 

 
C. Multiple Choice Questions (5) – Analytical 

1. Which network is most suitable within a hospital building? 
a) WAN 
b) MAN 
c) LAN 
d) Internet 
Correct Answer: c 

2. Which device connects different networks together? 
a) Switch 
b) Hub 
c) Router 
d) Repeater 
Correct Answer: c 

3. Which topology offers high reliability but at higher cost? 
a) Bus 
b) Ring 
c) Star 
d) Mesh 
Correct Answer: d 
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4. Which network type is used to connect hospitals in different cities? 
a) LAN 
b) MAN 
c) WAN 
d) PAN 
Correct Answer: c 

5. Why is networking critical for telemedicine services? 
a) For entertainment 
b) For local printing 
c) For real-time data and video transmission 
d) For file storage only 
Correct Answer: c 

 
References and Suggested Readings 
A. Text Books (Printed & Published Only) 

1. Norton, P., Introduction to Computers and Communications, Tata McGraw-Hill, New 
Delhi, 2009. 

2. Rajaraman, V., Introduction to Information Technology, Prentice Hall of India, New 
Delhi, 2008. 

3. Tanenbaum, A. S., Computer Networks, Pearson Education, New Delhi, 2011. 
4. Forouzan, B. A., Data Communications and Networking, McGraw-Hill, New York, 

2010. 
5. Stallings, W., Data and Computer Communications, Pearson Education, London, 

2013. 
 

B. Other Reference Material 
 Ministry of Health & Family Welfare, Government of India – Telemedicine & 

eHealth Reports 
 WHO – Digital Health and Health Information Systems Publications 
 National Digital Health Mission (NDHM) Networking Guidelines 

 
Activity 3: Analytical Writing Task 
Task: 
Explain how network failures can impact patient safety and hospital reputation. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Strengthens analytical and managerial thinking. 
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LESSON-5 

NETWORK TOPOLOGIES 
 
LEARNING OBJECTIVES 
 
At the end of this lesson, the learner should be able to: 

1. Explain the concept and significance of network topologies. 
2. Distinguish between different types of network topologies. 
3. Analyse the advantages and limitations of various network topologies. 
4. Apply suitable network topologies to healthcare organisational settings. 
5. Evaluate topology selection decisions for hospital networking systems. 

 
STRUCTURE 
 
         1.0 INTRODUCTION TO NETWORK TOPOLOGY 

1.1 BUS TOPOLOGY 

1.2 STAR TOPOLOGY 

1.3 RING TOPOLOGY 

1.4 MESH TOPOLOGY 

1.5 TREE TOPOLOGY 

1.6 HYBRID TOPOLOGY 

1.7 POINT-TO-POINT TOPOLOGY 

1.8 SUMMARY 

1.9 KEYWORDS 

1.10 SELF-ASSESSMENT QUESTIONS 

1.11 SUGGESTED READINGS 

1.0 Introduction to Network Topology 
Network topology is the physical or logical arrangement of computers, cables, and other 
devices in a network. It defines how devices are connected and how data flows. 
 

1.1 Bus Topology  
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Diagram (Text Representation) 
PC1 ─── PC2 ─── PC3 ─── PC4 ─── PC5 
Explanation 
All devices are connected to a single main cable (backbone). Data is broadcast in both 
directions. 
Advantages 

 Simple to install 
 Low cost 

Disadvantages 
 Backbone failure stops the entire network 
 Difficult troubleshooting 

Uses 
 Small temporary networks 
 Laboratory testing 

 
1.2 Star Topology 
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Diagram (Text Representation) 
        PC1 
         | 
PC2 ── SWITCH ── PC3 
         | 
        PC4 
Explanation 
All devices connect to a central hub or switch. All communication passes through this central 
device. 
Advantages 

 Easy to manage and troubleshoot 
 Failure of one node does not affect others 

Disadvantages 
 If central device fails, entire network stops 
 More cables are required 

Uses 
 Office and school networks 
 Modern LANs 

 
1.3 Ring Topology 
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Diagram (Text Representation) 
PC1 ─── PC2 ─── PC3 ─── PC4 
  |                         | 
  └─────────────────────────┘ 
Explanation 
Each device is connected to exactly two other devices. Data travels in a circular path. 
Advantages 

 No data collision 
 Equal access to all devices 

Disadvantages 
 One break can disrupt entire network 
 Difficult to reconfigure 

Uses 
 Token Ring networks (older systems) 

 
1.4 Mesh Topology 
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Diagram (Text Representation) 
     PC1 ----- PC2 
      |  \     /  | 
      |   \   /   | 
      |    X     | 
      |   / \    | 
     PC3 ----- PC4 
Explanation 
Each device is connected to every other device. There are two types: 

 Full Mesh 
 Partial Mesh 

Advantages 
 Very high reliability 
 No single point of failure 

Disadvantages 
 Very costly 
 Complex cabling 

Uses 
 Military networks 
 Critical communication systems 

 
1.5 Tree Topology 
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Diagram (Text Representation) 
          MAIN HUB 
         /    |    \ 
      HUB1  HUB2  HUB3 
      /  \      \ 
    PC1  PC2    PC3 
Explanation 
Combination of star and bus topologies. Works in hierarchical structure. 
Advantages 

 Easy network expansion 
 Good for large organizations 

Disadvantages 
 Dependency on backbone cable 
 Complex setup 

Uses 
 Corporate networks 
 Large buildings and campuses 
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1.6 Hybrid Topology 

 

 
Diagram (Text Representation) 
 Star Network      Bus Network 
     |                 | 
  ─ SWITCH ─────── Backbone ───── SWITCH ─ 
     |                                   | 
    PCs                                 PCs 
Explanation 
Combination of two or more different topologies (Star + Bus, Star + Ring, etc.). 
Advantages 

 Flexible and scalable 
 High fault tolerance 

Disadvantages 
 Complex design 
 Expensive 
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Uses 
 Large enterprises 
 Data centers 

 
1.7 Point-to-Point Topology 

 

 
Diagram (Text Representation) 
Computer A ───────── Computer B 
Explanation 
Direct connection between two devices. 
Advantages 

 Simple configuration 
 High-speed communication 

Disadvantages 
 Not scalable for large networks 

Uses 
 Remote desktop connections 
 Direct cable connections 
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Activity 1: Hospital Network Analysis 
Task: 
Identify the probable network topology used in a hospital or institution you are familiar with 
and justify your answer. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
……………………………………………………………………………………………..….. 
Expected Learning Outcome: 
Enhances ability to relate topology concepts to real organisational settings. 

 
 
Introductory Case Study: Choosing the Right Network Topology for a New Hospital 
Background of the Organisation / Sector 
A newly commissioned 400-bed super-specialty hospital planned to implement a 
comprehensive Hospital Information System (HIS) connecting OPDs, wards, ICUs, 
diagnostic labs, pharmacy, administration, and billing units. The hospital management aimed 
for high availability, fast data access, and minimal downtime. 
Contextual Trigger / Problem Situation 
During the network design phase, the IT team proposed different network topologies for 
internal connectivity. However, hospital administrators faced difficulty in understanding: 

 How topology choice affects network reliability 
 Cost implications of different designs 
 Ease of maintenance and fault detection 
 Impact on critical care units if the network fails 

An inappropriate topology choice could lead to system-wide disruptions, especially in ICUs 
and emergency departments. 
Stakeholders Involved 

 Hospital administrators 
 IT and network engineers 
 Doctors, nurses, and clinical staff 
 Software vendors and system integrators 
 Patients dependent on real-time data access 

Behavioural / Managerial Issues 

 Preference for low-cost solutions without considering reliability 
 Limited technical understanding among decision-makers 
 Pressure to complete implementation quickly 
 Risk of underestimating future scalability needs 

Why This Case Is Important for the Lesson 
This case highlights that network topology is a strategic managerial decision, not merely a 
technical one. The structure of network connections directly influences performance, 
reliability, fault tolerance, and patient safety. 
Explicit Linkage to Lesson Concepts 
The case links directly to: 

 Meaning of network topology 
 Types of topologies (bus, star, ring, mesh, hybrid) 
 Advantages and disadvantages of each topology 
 Suitability of topologies for healthcare environments 
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1.8 SUMMARY 
 
Network topology refers to the physical or logical arrangement of computers and devices in a 
network. It defines how nodes are connected and how data flows between them. Common types 
of topologies include bus, star, ring, mesh, and tree. Each topology has its own advantages and 
limitations in terms of cost, reliability, performance, and scalability. Choosing the right 
network topology is important for efficient communication and network management. 
 
Activity 2: Mini Application Task 
Task: 
Suggest a suitable network topology for a 100-bed rural hospital and explain your choice. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Develops decision-making and application skills. 
 
1.9 KEYWORDS 
 

Bus Topology – A network structure where all devices are connected to a single central 
cable. 
Star Topology – A network layout where all devices are connected to a central hub or 
switch. 
Ring Topology – A configuration in which each device is connected to two other devices, 
forming a circular path. 
Mesh Topology – A network design where devices are interconnected with multiple paths 
for reliable communication. 
Tree Topology – A hierarchical network structure that combines characteristics of bus and 
star topologies 
 

Activity 3: Analytical Writing Task 
Task: 
Explain how an inappropriate network topology can increase operational risks in hospitals. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Strengthens critical thinking and managerial evaluation. 

 
Case Study for Self-Assessment: Network Topology Redesign in a Government Medical 
College Hospital 
Background 
A government medical college hospital serving as a referral centre used an outdated bus 
topology network installed many years ago. The network connected administrative offices, 
OPDs, and laboratories. 
Problem Development 
Over time, the hospital experienced: 

 Frequent network breakdowns 
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 Entire network failure due to single cable faults 
 Difficulty in adding new departments 
 Slow data transmission during peak hours 

These problems severely affected patient registration, laboratory reporting, and academic 
activities. 
Managerial and Operational Challenges 

 Continuing patient services during network upgrades 
 Budget approvals for restructuring 
 Training staff on new network systems 
 Ensuring uninterrupted access to patient records 

Corrective Action 
After technical evaluation, the hospital shifted to a star topology with: 

 Centralised switches 
 Separate connections for critical departments 
 Improved fault isolation and maintenance 

Relevance to the Lesson 
The case demonstrates: 

 Limitations of older topologies 
 Benefits of modern topology designs 
 Importance of scalability and reliability in healthcare networks 

Analytical Questions 
1. Why did the bus topology fail to meet hospital requirements? 
2. How did star topology improve network reliability? 
3. Which topology would be suitable for ICU and emergency units and why? 
4. What managerial factors should guide topology redesign decisions? 
5. How does network topology affect patient safety and service quality? 
 

1.10 SELF-ASSESSMENT QUESTIONS 
 
A. Short-Answer Questions (5) – with Answers 

1. What is network topology? 
The arrangement of network nodes and connections in a computer network. 

2. Name any two types of network topologies. 
Bus topology and star topology. 

3. Which topology uses a central connecting device? 
Star topology. 

4. What is a major limitation of bus topology? 
Failure of the main cable disrupts the entire network. 

5. Why is topology important in hospitals? 
It affects reliability, performance, and patient safety. 

 
B. Essay-Type Questions (5) – with Guiding Hints 

1. Explain the concept and importance of network topology. 
Hints: Definition, structure, performance impact 

2. Describe different types of network topologies. 
Hints: Bus, star, ring, mesh, hybrid 

3. Analyse the advantages and disadvantages of star topology. 
Hints: Reliability, cost, fault isolation 
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4. Discuss the suitability of different network topologies for healthcare 
organisations. 
Hints: OPD, ICU, diagnostics 

5. Evaluate managerial considerations in selecting network topology for hospitals. 
Hints: Cost, scalability, reliability, safety 

 
C. Multiple Choice Questions (5) – Analytical 

1. Which topology fails completely if the main cable breaks? 
a) Star 
b) Ring 
c) Bus 
d) Mesh 
Correct Answer: c 

2. Which topology provides high fault tolerance but is expensive? 
a) Bus 
b) Ring 
c) Star 
d) Mesh 
Correct Answer: d 

3. In hospitals, which topology is most commonly used within departments? 
a) Bus 
b) Star 
c) Ring 
d) Linear 
Correct Answer: b 

4. Which topology is best for future scalability? 
a) Bus 
b) Ring 
c) Star 
d) Point-to-point 
Correct Answer: c 

5. Why is mesh topology rarely used across entire hospitals? 
a) Low speed 
b) Security issues 
c) High cost and complexity 
d) Lack of reliability 
Correct Answer: c 
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B. Other Reference Material 
 Ministry of Health & Family Welfare, Government of India – eHealth & 

Telemedicine Reports 
 WHO – Digital Health Infrastructure Publications 
 National Digital Health Mission (NDHM) Technical Guidelines 
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LESSON-6 

INTERNET, INTRANET, EXTRANET & MIS 
 
LEARNING OBJECTIVES 
 
At the end of this lesson, the learner should be able to: 

1. Explain the concept of Internet as introduced in the lesson. 
2. Distinguish between Internet, Intranet, and Extranet. 
3. Describe the basic features and uses of Intranet and Extranet. 
4. Explain the meaning and purpose of Management Information System (MIS). 
5. Apply Internet, Intranet, Extranet, and MIS concepts to organisational contexts. 

 
Structure 
 
1.1 INTERNET 

1.2 INTRANET 

1.3 EXTRANET 

1.4 MIS (MANAGEMENT INFORMATION SYSTEM) 

1.5 DIFFERENCE TABLE – INTERNET VS INTRANET VS EXTRANET 

1.6 DIFFERENCE TABLE – MIS VS TRADITIONAL SYSTEM 

1.7 SIMPLE COMBINED DIAGRAM (TEXT FORMAT) 

1.8 SUMMARY 

1.9 KEYWORDS 

1.10 SELF-ASSESSMENT QUESTIONS 

1.11 SUGGESTED READINGS 

 
1.1 INTERNET 
 
Definition 
The Internet is a global network of interconnected computers and servers that allows 
worldwide communication and information sharing. 
 
Key Features 

 Worldwide connectivity 
 Uses TCP/IP protocols 
 Public access 
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  

Services on the Internet 
 Email 
 World Wide Web (WWW) 
 Social media 
 Cloud services 
 Video conferencing 

Advantages 
 Global communication 
 Easy access to information 

Disadvantages 
 Security risks 
 Privacy issues 
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1.2 INTRANET 

 

 
Definition 
An Intranet is a private network used inside an organization. It uses internet technologies 
(web browsers and TCP/IP), but access is restricted to authorized users. 
Key Features 

 Internal communication 
 Private and secured 

 
 



MBA Hospital Administration                                   115          Information Technology for Healthcare…  

115 
 

Uses 
 Employee portals 
 Internal documents 
 HR policies and manuals 

Advantages 
 Improved internal communication 
 Secure information sharing 

Disadvantages 
 Limited access (inside organization only) 
 Requires maintenance 

 
1.3 EXTRANET 
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Definition 
An Extranet is an extension of an intranet that allows controlled access to external users such 
as suppliers, vendors, or business partners. 
Key Features 

 Restricted external access 
 Uses secure login and VPN 

Uses 
 Supplier portals 
 Customer support portals 
 Business partner communication 

Advantages 
 Improves business collaboration 
 Secure data sharing with outsiders 

Disadvantages 
 Complex security management 
 Setup cost is high 

 
Introductory Case Study: Use of Internet and MIS in a Hospital Administration Office 
Background of the Organisation 
A medium-sized hospital uses computers and networking facilities for routine administrative 
and clinical support activities. The hospital has gradually adopted Internet connectivity, a 
basic internal network (Intranet), and a simple Management Information System (MIS) 
for reporting purposes. 
Contextual Situation 
Initially, the hospital relied on manual records and standalone computers. Over time, the 
administration introduced: 

 Internet access for information retrieval and communication 
 An internal network for sharing files among departments 
 Basic MIS reports for monitoring patient registrations and billing 

These changes were aligned with the hospital’s need to manage increasing volumes of 
information. 
Stakeholders Involved 
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 Hospital administrators 
 Clerical and data entry staff 
 Doctors and departmental heads 

Issues Highlighted 

 Difficulty in accessing information without Internet 
 Delays in internal communication without Intranet 
 Limited reporting capability without MIS 

Why This Case Is Important for the Lesson 
The case illustrates why Internet, Intranet, Extranet, and MIS are introduced in 
organisations, exactly as discussed in the lesson, without extending beyond the prescribed 
scope. 
Linkage to Lesson Concepts 

 Internet as a global information network 
 Intranet as an internal organisational network 
 Extranet as limited external access 
 MIS as an information system for management reporting 

1.4 MIS (Management Information System)  

Definition 
MIS (Management Information System) is a computer-based system that collects, processes, 
stores, and distributes information to help managers make decisions. 
MIS converts raw data → useful information → reports for management. 
Components of MIS 

 Hardware 
 Software 
 Data/Database 
 People (Users) 
 Procedures 

 
 
Functions 

 Data collection 
 Data processing 
 Report generation 
 Decision support 

Types of MIS Reports 
 Periodic reports 
 Summary reports 
 Exception reports 
 Real-time reports 

Advantages 
 Better decision making 
 Improves planning and control 
 Increases efficiency 

Disadvantages 
 Expensive setup 
 Needs trained staff 
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Activity 1: Concept Identification 
Task: 
Identify whether the following belong to Internet, Intranet, Extranet, or MIS: 
(a) Internal circular sharing 
(b) Public information access 
(c) Management report preparation 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Clear conceptual differentiation among lesson terms. 
 
1.5 Difference Table – Internet vs Intranet vs Extranet 
 
Point of 
difference 

Internet Intranet Extranet 

Accessibility 
of network 

Public Private Private 

Availability Global system. Specific to an 
organization. 

To share information 
with suppliers and 
vendors it makes the use 
of public network. 

Coverage All over the world. Restricted area up to an 
organization. 

Restricted area up to an 
organization and some of 
its stakeholders or so. 

Accessibility 
of content 

It is accessible to 
everyone 
connected. 

It is accessible only to 
the members of 
organization. 

Accessible only to the 
members of organization 
and external members 
with logins. 

No. of 
computers 
connected 

It is largest in 
number of 
connected devices. 

The minimal number of 
devices are connected. 

The connected devices 
are comparable with 
Intranet. 

Owner No one. Single organization. Single/ Multiple 
organization. 

Purpose of the 
network 

Its purpose is to 
share information 
throughout the 
world. 

Its purpose is to share 
information throughout 
the organization. 

Its purpose is to share 
information between 
members and external, 
members. 

Security It is dependent on 
the user of the 
device connected 
to network. 

It is enforced via 
firewall. 

It is enforced via firewall 
that separates internet and 
extranet. 

Users General public. Employees of the 
organization. 

Employees of the 
organization which are 
connected. 

Policies behind 
setup 

There is no hard 
and fast rule for 
policies. 

Policies of the 
organization are 
imposed. 

Policies of the 
organization are imposed. 
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Maintenance It is maintained by 
ISP. 

It is maintained by CIO. 
HR or communication 
department of an 
organization. 

It is maintained by CIO. 
HR or communication 
department of an 
organization. 

Economical It is more 
economical to use. 

It is less economical. It is also less economical. 

Relation It is the network of 
networks. 

It is derived from 
Internet. 

It is derived from 
Intranet. 

Example What we are 
normally using is 
internet. 

WIPRO using internal 
network for its business 
operations. 

DELL and Intel using 
network for its business 
operations. 

Feature Internet Intranet Extranet 
Access Public Private (Internal) Limited External 
Users Anyone Organization employees Employees + Partners 
Security Low High Very High 
Example Google, Email Company portal Supplier login portal 

 
1.6 Difference Table – MIS vs Traditional System 
Feature Traditional System MIS 
Data Handling Manual Computerized 
Speed Slow Fast 
Accuracy Low High 
Decision Making Difficult Easy 

 
1.7 Simple Combined Diagram (Text Format) 
                     INTERNET 
                         | 
              ---------------------- 
              |                    | 
          Company A            Company B 
           INTRANET              INTRANET 
              |                    | 
        Employees           Employees/Partners 
              | 
          EXTRANET 
        (Access for suppliers & partners) 
 
1.8 SUMMARY 
 
The Internet is a worldwide network that connects millions of computers and allows global 
communication and information sharing. An Intranet is a private network used within an 
organization to share internal information securely. An Extranet extends the intranet to trusted 
external users such as suppliers or partners. Management Information Systems (MIS) are 
computer-based systems that collect, process, and provide information to support planning, 
control, and decision-making in organizations. Together, these systems improve 
communication, efficiency, and managerial effectiveness. 
 
Activity 2: Short Application Task 
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Task: 
Write a short note on how MIS helps managers using information generated by computers. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Understanding of MIS purpose as given in the lesson. 
 
1.9 KEYWORDS 
 

Internet – A global network that connects computers and devices worldwide. 
Intranet – A private internal network used within an organization for secure 
communication. 
Extranet – A controlled network that provides limited access to external users. 
MIS (Management Information System) – A system that provides managers with 
information for effective decision-making. 
Data Processing – The collection and manipulation of data to produce meaningful 
information. 
 

Activity 3: Reflective Question 
Task: 
Explain why organisations move from standalone computers to Internet and Intranet systems. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Conceptual linkage between networking and information systems. 

 
Case Study for Self-Assessment: Introduction of Intranet and MIS in an Organisation 
Background 
An organisation using multiple computers decided to improve internal information sharing 
and reporting. Initially, employees worked independently with little coordination. 
Problem Situation 
The organisation faced: 

 Duplication of data 
 Slow communication between departments 
 Delays in preparing management reports 

Steps Taken 
To address these issues, the organisation introduced: 

 Intranet for internal communication 
 Extranet for limited interaction with external agencies 
 MIS to generate periodic reports for management 

Outcome 
The organisation experienced improved information flow and better availability of data for 
decision-making. 
Relevance to the Lesson 
This case reinforces the basic definitions, purposes, and uses of Internet, Intranet, Extranet, 
and MIS exactly as covered in the lesson. 
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Analytical Questions 
1. Why was Intranet introduced in the organisation? 
2. How does Extranet differ from Internet in this case? 
3. What type of information does MIS provide to management? 
4. How did Internet improve information access? 
5. What limitations might arise if MIS is not properly maintained? 
 
 

1.10 SELF-ASSESSMENT QUESTIONS 
 
A. Short-Answer Questions (5) – with Answers 

1. What is the Internet? 
A global network connecting computers worldwide. 

2. Define Intranet. 
A private network used within an organisation. 

3. What is Extranet? 
A network that allows limited access to authorised external users. 

4. What does MIS stand for? 
Management Information System. 

5. What is the main purpose of MIS? 
To provide information for management decision-making. 

 
B. Essay-Type Questions (5) – with Guiding Hints 

1. Explain the concept of Internet. 
Hints: Definition, purpose, information access 

2. Differentiate between Internet and Intranet. 
Hints: Access scope, users 

3. Describe Extranet and its uses. 
Hints: Controlled access, external users 

4. Explain the meaning and functions of MIS. 
Hints: Data processing, information output 

5. Discuss the importance of MIS in organisations. 
Hints: Reporting, decision support* 

 
C. Multiple Choice Questions (5) 

1. Intranet is mainly used for: 
a) Public access 
b) Internal communication 
c) Entertainment 
d) Gaming 
Correct Answer: b 

2. Extranet provides access to: 
a) Anyone on the Internet 
b) Only internal staff 
c) Authorised external users 
d) No users 
Correct Answer: c 

3. MIS mainly helps: 
a) Data entry operators 
b) Managers 
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c) Hardware technicians 
d) Programmers 
Correct Answer: b 

4. Internet is best described as: 
a) A private network 
b) A local network 
c) A global network 
d) A single computer 
Correct Answer: c 

5. MIS converts data into: 
a) Hardware 
b) Software 
c) Information 
d) Signals 
Correct Answer: c 
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LESSON-7 

MICROSOFT WORD 
 
LEARNING OBJECTIVES 
 
At the end of this lesson, the learner should be able to: 

1. Explain the purpose and features of MS Word. 
2. Describe the steps involved in creating and saving documents. 
3. Apply basic text editing and formatting functions. 
4. Organise information using tables and outlines. 
5. Explain the use of mail merge and printing options. 

 
STRUCTURE 
 

1.0 INTRODUCTION TO MS WORD 

1.1 CREATION OF DOCUMENT IN MS WORD 

1.2 SUMMARY 

1.3 KEYWORDS 

1.4 SELF-ASSESSMENT QUESTIONS 

1.5 SUGGESTED READINGS 

 
1.0 INTRODUCTION TO MS WORD  
 
Microsoft Word, commonly known as MS Word, is a popular word processing software used 
to create, edit, format, store, and print text documents. It is developed by Microsoft and is 
included as part of the Microsoft Office software package. MS Word allows users to prepare 
professional documents such as letters, reports, resumes, project works, books, and question 
papers with ease. It provides a user-friendly interface that helps both beginners and advanced 
users to work efficiently with text-based documents. 
MS Word provides a wide range of basic and advanced features that make document creation 
simple and effective. Users can type text, change font styles, sizes, and colors, align paragraphs, 
and apply spacing to improve the visual appearance of documents. It also offers automatic 
spelling and grammar checking, which helps in reducing typing mistakes and improving the 
quality of written content. The software supports inserting pictures, tables, charts, symbols, and 
shapes, making documents more attractive and informative. 
The MS Word window consists of several important components that help users work 
smoothly. The Title Bar displays the document name, while the Ribbon contains tabs such as 
Home, Insert, Page Layout, References, and Review, which organize tools into logical groups. 
The Quick Access Toolbar provides shortcuts for commonly used commands like Save, Undo, 
and Redo. The main working area is the document area, where users type and edit content. The 
Status Bar at the bottom shows information such as page number and word count, helping users 
track their progress. 
MS Word also makes file management easy by allowing users to save documents in different 
formats. The default file format is .docx, while older versions use .doc. Users can save files in 
different locations such as computer drives, external devices, or cloud storage. MS Word also 
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supports printing functionality, allowing users to preview documents before printing and select 
printing options such as page size, orientation, and number of copies. 
Another important feature of MS Word is its ability to enhance productivity through tools such 
as templates, mail merge, and styles. Templates provide ready-made document formats for 
resumes, letters, and reports, saving time and effort. Mail Merge helps in creating multiple 
documents like invitation letters or certificates by combining a single template with a list of 
names and addresses. Styles allow uniform formatting throughout long documents, which is 
especially useful in academic and professional writing. 
MS Word is widely used in education, business, and government organizations because it 
improves work efficiency and ensures professional document presentation. Its ease of use and 
powerful editing tools make it an essential application for students, teachers, office staff, and 
researchers. By learning MS Word, users can develop strong document preparation skills that 
are helpful in both academic and professional life. 
 
Introductory Case Study: Document Preparation in an Office Environment 
Background of the Organisation 
An organisation regularly prepares letters, notices, reports, and internal documents. Initially, 
documents were prepared manually or using basic typing tools, making editing and 
formatting difficult. 
Contextual Situation 
With increasing documentation requirements, the organisation adopted MS Word to: 

 Create documents efficiently 
 Edit and revise content easily 
 Format text uniformly 
 Store and retrieve documents when required 

Stakeholders Involved 

 Office staff 
 Supervisors and managers 
 Clerical personnel 

Issues Highlighted 

 Difficulty in editing handwritten or typed documents 
 Time-consuming document preparation 
 Lack of uniform formatting 

Why This Case Is Important for the Lesson 
The case demonstrates the need for word processing software, directly aligning with the 
lesson’s focus on creation, editing, formatting, and saving documents using MS Word. 
Linkage to Lesson Concepts 

 Creation of documents 
 Text editing 
 Formatting and saving 
 Printing documents 

 
 
1.1 CREATION OF DOCUMENT IN MS WORD  
 
1. What is Document Creation in MS Word? 
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Document creation in MS Word is the process of opening the software, starting a new file, 
typing content, formatting it, saving it, and preparing it for printing or sharing. It is the most 
basic and important skill in word processing. 
 
2. Steps to Create a New Document 

 

 
Method 1: Using Menu 

1. Open Microsoft Word 
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2. Click File 
3. Click New 
4. Select Blank Document 

Method 2: Using Shortcut 
Press: 
Ctrl + N → New Document opens instantly 
 
3. Typing Text in a Document 
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After opening a blank document: 

 Place the cursor in the document area 
 Start typing using the keyboard 
 Use Enter for new paragraph 
 Use Backspace/Delete to remove text 

 
 
4. Saving a Document 

 

 
First Time Saving 

1. Click File → Save As 
2. Choose location (This PC / Documents) 
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3. Type file name 
4. Click Save 

Shortcut: 
Ctrl + S 
File Types 

 .docx → Default Word format 
 .doc → Older format 

 
5. Basic Formatting of the Document 
5.1 Text Formatting 
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 Bold (Ctrl + B) 
 Italic (Ctrl + I) 
 Underline (Ctrl + U) 
 Change font size and font type 

5.2 Paragraph Formatting 
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 Alignment: Left, Center, Right, Justify 
 Line spacing 
 Indentation 

 
6. Inserting Elements into a Document 
6.1 Inserting Pictures 
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Steps: 

1. Click Insert 
2. Click Pictures 
3. Select image → Insert 

 
Activity 1: Basic Practice Task 
Task: 
List the steps involved in creating and saving a document in MS Word. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
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Expected Learning Outcome: 
Understanding of document creation and storage. 
 
6.2 Inserting Tables 

 

 
Steps: 

1. Click Insert 
2. Click Table 
3. Select rows and columns 

 
7. Page Setup of Document 
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Options available: 
 Margins 
 Orientation (Portrait / Landscape) 
 Paper size (A4, Letter) 

 
8. Adding Header and Footer 

 

 
Steps: 
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1. Click Insert 
2. Click Header or Footer 
3. Type required content 

 
9. Spell Check and Grammar Check 

 

 
Steps: 

1. Click Review 
2. Click Spelling & Grammar 

 
10. Printing the Document 
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Steps: 

1. Click File 
2. Click Print 
3. Choose printer 
4. Click Print 

 
Activity 2: Formatting Exercise 
Task: 
Write a short paragraph and identify the formatting options used (bold, alignment, spacing). 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
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…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Familiarity with text formatting features. 
 
11. Simple Flow Diagram of Document Creation Process 
Open MS Word 
      ↓ 
Create New Document 
      ↓ 
Type Content 
      ↓ 
Format Text & Page 
      ↓ 
Save Document 
      ↓ 
Print / Share 
 
 
1.2 SUMMARY 
 
MS Word is a powerful word processing application used to create professional documents 
such as letters, reports, and resumes. It provides tools for text formatting, page layout, spelling 
and grammar checking, and document design. Users can insert pictures, shapes, headers, 
footers, and page numbers to enhance the appearance of documents. MS Word improves 
productivity by making document creation, editing, and sharing easy and efficient. 
 
Activity 3: Concept Reflection 
Task: 
Explain why editing tools are important in word processing software. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Clear understanding of text editing functions. 
 
1.3 KEYWORDS 
 

Word Processor – A software application used to create, edit, and print text documents. 
Formatting – The process of changing the appearance of text using fonts, styles, and 
alignment. 
Spell Check – A tool that automatically detects and corrects spelling errors. 
Page Layout – The arrangement of text and images on a document page. 
Templates – pre-designed document layouts used to create documents quickly. 

Case Study for Self-Assessment: Using MS Word for Official Documentation 
Background 
An office prepares multiple official documents such as circulars, notices, and reports. Each 
document requires consistent formatting and periodic updates. 
Problem Situation 
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Before using MS Word, the office faced: 
 Repetition of work while revising documents 
 Errors during retyping 
 Poor alignment and spacing 

Action Taken 
The office began using MS Word features such as: 

 Editing and formatting tools 
 Tables for organising information 
 Printing options for final output 

Outcome 
Document preparation became faster, more accurate, and easier to manage. 
Relevance to the Lesson 
This case reinforces the core uses of MS Word exactly as described in the lesson, without 
introducing any external applications. 
Analytical Questions 

1. Why is MS Word suitable for document creation? 
2. How does text editing improve document quality? 
3. What role do formatting features play in document presentation? 
4. Why are tables useful in MS Word documents? 
5. How does MS Word simplify printing tasks? 
 
 

1.4 SELF-ASSESSMENT QUESTIONS 
 
A. Short-Answer Questions (5) – with Answers 

1. What is MS Word? 
A word processing software used to create and edit documents. 

2. What is text editing? 
The process of modifying text by inserting, deleting, or correcting content. 

3. Why is formatting important in a document? 
It improves readability and presentation. 

4. What is a table in MS Word? 
An arrangement of data in rows and columns. 

5. What is mail merge? 
A feature used to create multiple documents from one template. 

 
B. Essay-Type Questions (5) – with Guiding Hints 

1. Explain the features of MS Word. 
Hints: Creation, editing, formatting, saving 

2. Describe the steps involved in creating and saving a document. 
Hints: New document, typing, saving 

3. Explain different text formatting options available in MS Word. 
Hints: Font, alignment, spacing 

4. Discuss how tables help in organising information. 
Hints: Structured presentation 

5. Explain the concept of mail merge. 
Hints: Main document, data source* 

 
C. Multiple Choice Questions (5) 
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1. MS Word is an example of: 
a) System software 
b) Application software 
c) Utility software 
d) Programming software 
Correct Answer: b 

2. Which option is used to save a document? 
a) Print 
b) Open 
c) Save 
d) Close 
Correct Answer: c 

3. Which feature is used to organise data in rows and columns? 
a) Header 
b) Table 
c) Paragraph 
d) Margin 
Correct Answer: b 

4. Editing a document mainly involves: 
a) Printing 
b) Formatting 
c) Modifying text 
d) Saving files 
Correct Answer: c 

5. Mail merge is useful when: 
a) Creating a single document 
b) Editing images 
c) Printing multiple similar documents 
d) Drawing diagrams 
Correct Answer: c 

 
References and Suggested Readings 
A. Text Books (Printed & Published Only) 

1. Cox, J., et al., 2007 Microsoft Office System Step-by-Step, PHI Learning, New Delhi, 
2007. 
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3. Rajaraman, V., Introduction to Information Technology, Prentice Hall of India, New 

Delhi, 2008. 
4. Saxena, S. & Chopra, P., Computer Applications in Management, Vikas Publishing 

House, New Delhi, 2012. 
5. Norton, P., Introduction to Computers and Communications, Tata McGraw-Hill, New 

Delhi, 2009. 
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LESSON-8 
ORGANIZING INFORMATION WITH TABLES AND OUTLINES IN MS WORD 

 
LEARNING OBJECTIVES 
 
At the end of this lesson, the learner should be able to: 

1. Explain the concept of organising information in MS Word. 
2. Describe the structure and uses of tables in documents. 
3. Apply tables to present information in rows and columns. 
4. Explain the concept and purpose of outlines in MS Word. 
5. Organise document content logically using tables and outlines. 

 
STRUCTURE 
 
1.0 INTRODUCTION 

1.1 ORGANIZING INFORMATION USING TABLES 

1.2 ORGANIZING INFORMATION USING OUTLINES 

1.3 DIFFERENCE BETWEEN TABLES AND OUTLINES 

1.4 PRACTICAL USES 

1.5 COMBINED DIAGRAM – TABLES AND OUTLINES IN A DOCUMENT 

1.6 MAIL MERGE IN MS WORD 

1.7 INDEX IN MS WORD 

1.8 PRINTING IN MS WORD 

1.9 SUMMARY 

1.10 KEYWORDS 

1.11 SELF-ASSESSMENT QUESTIONS 

1.12 SUGGESTED READINGS 

 
1.0 INTRODUCTION 
Organizing information in MS Word (Microsoft Word) helps present content in a clear, 
structured, and professional way. Two powerful tools used for organizing data are Tables and 
Outlines. Tables arrange information in rows and columns, while outlines organize content 
using headings and hierarchical levels. 
Introductory Case Study: Organising Information in an Office Report 
Background of the Organisation 
An office regularly prepares reports and documents containing lists, details, and structured 
information. Initially, information was written in continuous paragraphs, making documents 
lengthy and difficult to read. 
Contextual Situation 
To improve clarity and presentation, the office staff began using: 

 Tables to arrange data systematically 
 Outlines to structure headings and sub-headings 

This made documents easier to understand and revise. 
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Stakeholders Involved 

 Office staff 
 Supervisors 
 Managers reviewing documents 

Issues Highlighted 

 Difficulty in locating specific information 
 Poor document readability 
 Lack of logical structure 

Why This Case Is Important for the Lesson 
The case highlights the need to organise information, which directly corresponds to the 
lesson focus on tables and outlines in MS Word. 
Linkage to Lesson Concepts 

 Creating and using tables 
 Organising content with outlines 
 Improving document clarity and structure 

 
1.1 Organizing Information Using Tables 
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What is a Table? 
A table is a grid that contains rows and columns used to organize data systematically. 
How to Create a Table 
Steps: 

1. Click the Insert tab 
2. Click Table 
3. Select number of rows and columns 
4. Click to insert the table 

 
Sample Diagram (Text Representation) 
+---------+---------+---------+ 
| Name    | Class   | Marks   | 
+---------+---------+---------+ 
| Rahul   | 10th    | 85      | 
| Anjali  | 10th    | 90      | 
| Suresh  | 10th    | 88      | 
+---------+---------+---------+ 
 
Formatting Tables 
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You can: 

 Change border styles 
 Shade cells with colors 
 Merge and split cells 
 Adjust row height and column width 

 
1.2 Organizing Information Using Outlines 



MBA Hospital Administration                                   145          Information Technology for Healthcare…  

145 
 

 

 
What is an Outline? 
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An outline arranges content in a hierarchical structure using headings and subheadings. 
Example structure: 
I. Chapter One 
   A. Introduction 
   B. Objectives 
II. Chapter Two 
   A. Methods 
   B. Results 
 
Using Outline View in MS Word 
Steps to use Outline: 

1. Click View tab 
2. Select Outline View 
3. Use Heading Styles (Heading 1, Heading 2, Heading 3) 

 
Sample Outline Diagram (Text Representation) 
 
 
 
Title: Computer Networks 
  | 
  ├── 1. Introduction 
  |      ├── 1.1 Definition 
  |      └── 1.2 Advantages 
  | 
  ├── 2. Types of Networks 
  |      ├── 2.1 LAN 
  |      └── 2.2 WAN 
  | 
  └── 3. Conclusion 
 
1.3 Difference Between Tables and Outlines 
Feature Tables Outlines 
Structure Rows and columns Hierarchical headings 
Best for Numerical or tabular data Large documents & chapters 
View Grid format Tree-like format 

 
1.4 Practical Uses 
Tables are commonly used to prepare: 

 Mark sheets 
 Timetables 
 Financial reports 

Outlines are used for: 
 Project reports 
 Books and manuals 
 Research documents 

 
1.5 Combined Diagram – Tables and Outlines in a Document 
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1.6 Mail Merge in Ms Word  
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1. Definition 
Mail Merge is a powerful feature in Microsoft Word that allows users to create multiple 
documents such as letters, certificates, envelopes, or labels by combining: 

 A main document (template) 
 A data source (list of names and addresses) 

It is mainly used when the same document has to be sent to many people with personalized 
details. 
 
2. Components of Mail Merge 
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Main Components 

 Main Document – The body of the letter 
 Data Source – Excel/Word table containing recipient information 
 Merge Fields – Placeholders like «Name», «Address» 
 Merged Document – Final personalized output 
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3. Types of Mail Merge 
Type Use 

Letters Personalized letters 

Emails Customized emails 

Envelopes Printing addresses on envelopes 

Labels Bulk labels printing 

Directory Creating catalogs/lists 
 
4. Step-by-Step Process of Mail Merge 
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Step 1: Create Main Document 
1. Open MS Word 
2. Click Mailings tab 
3. Click Start Mail Merge 
4. Choose Letters 

 
Step 2: Create Data Source 
You can create a new list or use an existing file (Excel/Access). 
Example data table: 
+----+--------+---------------------+ 
| ID | Name   | Address             | 
+----+--------+---------------------+ 
| 1  | Rahul  | Chennai, Tamil Nadu | 
| 2  | Anjali | Hyderabad, Telangana| 
| 3  | Suresh | Bengaluru, Karnataka| 
+----+--------+---------------------+ 
 
Step 3: Insert Merge Fields 
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1. Click Insert Merge Field 
2. Select fields like: 

o «Name» 
o «Address» 

Example inside document: 
Dear «Name», 
You are invited to attend the annual function. 
Your address is: «Address» 
Thank you. 
 
Step 4: Preview the Results 
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1. Click Preview Results 
2. Use next/previous buttons to view different recipients 

 
Step 5: Complete the Merge 
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1. Click Finish & Merge 
2. Choose: 

o Edit individual documents 
o Print documents 
o Send email messages 

 
6. Flow Diagram of Mail Merge Process 
Create Main Document 
          ↓ 
Create/Select Data Source 
          ↓ 
Insert Merge Fields 
          ↓ 
Preview Results 
          ↓ 
Finish & Merge 
 
7. Advantages of Mail Merge 

 Saves time and effort 
 Avoids repetitive typing 
 Increases accuracy 
 Professional communication 

 
8. Limitations of Mail Merge 

 Requires basic computer knowledge 
 Data must be accurate 
 Formatting can be complex for beginners 

9. Practical Uses of Mail Merge 
 Certificates for students 
 Salary slips 
 Invitation letters 
 Mark sheets 
 Fee reminders 
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1.7 Index in Ms Word  
 
1. Definition 
An Index in Microsoft Word is an alphabetical list of important words, topics, or names along 
with the page numbers where they appear in a document. It is usually placed at the end of a 
document and helps readers quickly locate information. 
An index is mostly used in: 

 Books 
 Research reports 
 Project reports 
 Manuals 

 
2. Why is Index Important? 
An index improves: 

 Ease of navigation 
 Professional appearance of documents 
 Reader experience 

 
3. Steps to Create an Index in MS Word 
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Step 1: Select Text for Index Entry 
Highlight the word or phrase you want to include in the index. 
Step 2: Mark the Entry 

1. Go to References tab 
2. Click Mark Entry 
3. Click Mark or Mark All 

This adds hidden field codes like: 
{ XE "Computer" } 
 
4. Inserting the Index 
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Steps: 

1. Place the cursor where you want the index 
2. Click References → Insert Index 
3. Choose format and columns 
4. Click OK 

 
5. Sample Index Diagram (Text Representation) 
Index 
 
Computer ............... 1, 3, 7 
Internet ............... 2, 5 
Mail Merge .............. 4 
MS Word ................. 1, 6 
Network ................. 3, 9 
 
6. Updating the Index 
Steps: 

1. Right-click on the index 
2. Click Update Field 
3. Select Update entire index 

 
7. Marking Subentries in an Index 
You can create main entries and subentries. 
Example in Mark Entry box: 

 Main entry: Computer 
 Subentry: Networks 

Displayed index result: 
Computer 
   Networks .......... 3 
   Hardware .......... 5 
 
8. Difference Between Index and Table of Contents 
Feature Index Table of Contents 

Basis Keywords Headings 

Order Alphabetical Sequential 

Location End of document Beginning of document 
9. Advantages of Using Index 

 Saves reader’s time 
 Works automatically with page numbers 
 Easy to update 
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10. Flow Diagram of Creating an Index 
Select Word/Phrase 
        ↓ 
Mark Index Entry 
        ↓ 
Insert Index 
        ↓ 
Update Index 
 
 
1.8 Printing in Ms Word  
 
1. Introduction 
Printing in Microsoft Word is the process of transferring a document from the computer to 
paper using a printer. It helps create physical copies of letters, reports, question papers, and 
other documents. 
 
Activity 1: Concept Identification 
Task: 
Identify which information is better presented using a table and which using outlines. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Ability to differentiate appropriate use of tables and outlines. 
 
2. Print Preview in MS Word 
Purpose of Print Preview 
Print Preview shows how the document will appear on paper before printing. It helps to avoid 
mistakes like page breaks or wrong margins. 
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3. Steps to Print a Document 

 

 
Step-by-Step Procedure 

1. Open the document in MS Word 
2. Click File menu 
3. Click Print 
4. Select the Printer 
5. Set Number of copies 
6. Click Print button 
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Shortcut key: 
Ctrl + P 
 
4. Print Settings in MS Word 
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Common Print Options 
Option Description 

Copies Number of pages to print 

Printer Select available printer 

Orientation Portrait / Landscape 

Paper Size A4, Letter, Legal 

Margins Top, Bottom, Left, Right 

Page Range Print all or selected pages 
 
 
 
 
 
 
 



Centre for Distance Education                         162                    Acharya Nagarjuna University 
 

5. Types of Printing 

 

 
a) Single-Sided Printing 
Prints on one side of the paper. 
b) Double-Sided Printing 
Prints on both sides of the paper (also called duplex printing). 
c) Collated Printing 
Prints complete sets in proper order. 
d) Uncollated Printing 
Prints multiple copies of the same page together. 
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6. Page Range Printing 

 

 
You can print: 

 All pages 
 Current page 
 Specific pages like 1–3, 5, 7 
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7. Simple Flow Diagram of Printing Process 
Open Document 
      ↓ 
Click File → Print 
      ↓ 
Select Printer 
      ↓ 
Set Print Options 
      ↓ 
Click Print 
 
8. Common Printing Problems and Solutions 
Problem Solution 

Printer not responding Check power and cable/Wi-Fi 

Paper jam Remove stuck paper 

Blank pages Check ink/toner 

Wrong layout Check print preview 
 
9. Advantages of Printing 

 Creates hard copies 
 Useful for official records 
 Easy sharing of information 

 
Activity 2: Short Application Task 
Task: 
Write a short list of points and explain how it can be organised using an outline. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Understanding of outline structure. 
 
1.9 SUMMARY 
 
Organizing information with tables and outlines in MS Word helps present data in a clear and 
structured way. Tables are used to arrange information into rows and columns, making 
comparisons and data interpretation easier. Outlines help organize headings and subheadings 
in a logical order, which is useful for creating reports, research papers, and lengthy documents. 
These features improve document clarity, consistency, and professional presentation. 
 
1.10 KEYWORDS 

 
Table – A grid of rows and columns used to organize information neatly. 
Outline View – A special view in MS Word used to arrange headings and subheadings 
hierarchically. 
Styles – Predefined formatting settings used to create consistent headings and text. 
Row and Column – Horizontal (row) and vertical (column) divisions in a table for data 
entry. 
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Heading Levels – Different levels of headings used to structure document sections. 
 
Activity 3: Reflective Question 
Task: 
Explain how tables improve readability compared to continuous text. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Clear conceptual understanding of structured presentation. 
 
Case Study for Self-Assessment: Use of Tables and Outlines in Official Documents 
Background 
An organisation prepares circulars, lists, and summary reports that contain structured data 
such as names, dates, and descriptions. 
Problem Situation 
When information was presented as plain text: 

 Documents appeared cluttered 
 Errors occurred while editing 
 Information was difficult to compare 

Action Taken 
The organisation adopted: 

 Tables to present structured data 
 Outlines to arrange content under headings and sub-headings 

Outcome 
Documents became clearer, better organised, and easier to update. 
Relevance to the Lesson 
This case reinforces the practical usefulness of tables and outlines, exactly as explained in 
the lesson. 
Analytical Questions 

1. Why are tables useful for organising information? 
2. How do outlines improve document structure? 
3. What problems arise when information is not organised properly? 
4. How do tables help in editing documents? 
5. Why is logical arrangement important in documents? 

 
1.11 SELF-ASSESSMENT QUESTIONS 
 
A. Short-Answer Questions (5) – with Answers 

1. What is a table in MS Word? 
An arrangement of information in rows and columns. 

2. What is the main purpose of using tables? 
To organise and present data clearly. 

3. What is an outline in MS Word? 
A structured arrangement of headings and sub-headings. 

4. Why are outlines useful in documents? 
They improve logical flow and readability. 

5. Name one advantage of using tables. 
Easy comparison of information. 
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B. Essay-Type Questions (5) – with Guiding Hints 

1. Explain the use of tables in organising information. 
Hints: Rows, columns, clarity 

2. Describe how outlines help in structuring documents. 
Hints: Headings, sub-headings 

3. Differentiate between presenting information as text and as a table. 
Hints: Readability, comparison 

4. Explain the steps involved in creating a table in MS Word. 
Hints: Insert table, rows, columns 

5. Discuss the importance of organising information in documents. 
Hints: Clarity, understanding* 

 
C. Multiple Choice Questions (5) 

1. A table consists of: 
a) Pages and margins 
b) Rows and columns 
c) Fonts and styles 
d) Headers and footers 
Correct Answer: b 

2. Outlines are mainly used to: 
a) Insert images 
b) Organise headings 
c) Print documents 
d) Save files 
Correct Answer: b 

3. Tables are most useful when information needs: 
a) Decoration 
b) Comparison 
c) Animation 
d) Sound 
Correct Answer: b 

4. Which improves document readability the most? 
a) Long paragraphs 
b) Unstructured text 
c) Tables and outlines 
d) Repetition 
Correct Answer: c 

5. Outlines help the reader to: 
a) Ignore content 
b) Understand document structure 
c) Increase file size 
d) Reduce clarity 
Correct Answer: b 
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LESSON-9 

MICROSOFT EXCEL 
 
LEARNING OBJECTIVES 
 

At the end of this lesson, the learner should be able to: 
1. Explain the purpose and features of Microsoft Excel. 
2. Create and edit worksheets using MS Excel. 
3. Apply cell formatting, formulas, and functions. 
4. Organise and analyse data using sorting and querying tools. 
5. Present data using graphs and charts. 

 
STRUCTURE 
 
1.0 INTRODUCTION TO MS EXCEL 

1.1 CREATING AND EDITING WORKSHEETS 

1.2 CELL FORMATTING 

1.3 CREATING AND USING FORMULAS 

1.4 USING FUNCTIONS IN EXCEL 

1.5 DIFFERENCE BETWEEN FORMULA AND FUNCTION 

1.6 COMBINED FLOW DIAGRAM 

1.7 PRACTICAL USES 

1.8 USE OF MACROS IN MS EXCEL 

1.9 SORTING AND QUERYING DATA 

1.10 WORKING WITH GRAPHS AND CHARTS 

1.11 SUMMARY 

1.12 KEYWORDS 

1.13 SELF-ASSESSMENT QUESTIONS 

1.14 SUGGESTED READINGS 

 
1.0 INTRODUCTION TO MS EXCEL  

 
MS Excel (Microsoft Excel) is a powerful spreadsheet software used for storing, organizing, 
calculating, and analyzing data in the form of rows and columns. It is developed by Microsoft 
and is part of the Microsoft Office package. MS Excel is widely used in education, business, 
finance, healthcare, and research because it helps users perform complex calculations 
accurately and quickly. It works on the concept of a worksheet, where data is entered into 
individual cells arranged in a grid structure. 
In MS Excel, a document is called a workbook, which contains one or more worksheets. Each 
worksheet consists of horizontal rows and vertical columns, and the intersection of a row and 
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a column is called a cell. Each cell has a unique address, such as A1, B2, or C5, which makes 
it easy to locate and use data in formulas and functions. This organized structure allows users 
to handle large volumes of information efficiently and systematically. 
One of the most important features of MS Excel is its ability to perform calculations using 
formulas and built-in functions. Users can add, subtract, multiply, and divide numbers and use 
advanced functions such as SUM, AVERAGE, COUNT, MAX, and MIN. Excel automatically 
recalculates results whenever the data changes, which reduces manual effort and minimizes 
errors. This makes it highly useful for tasks like preparing budgets, financial statements, marks 
sheets, and performance reports. 
MS Excel also provides rich formatting options that help in improving the visual appearance 
of data. Users can change font styles, apply colors, adjust column widths and row heights, and 
use borders to make data more readable. It also supports charts and graphs, which transform 
numerical data into visual presentations like bar charts, pie charts, and line graphs. These visual 
tools make it easier to understand trends, comparisons, and patterns in data. 
Another key feature of MS Excel is data management and analysis. Users can sort data in 
ascending or descending order, filter records to view specific information, and use tools like 
PivotTables to summarize large datasets. Excel also supports data validation, conditional 
formatting, and protection options to maintain data accuracy and security. These advanced 
features make Excel a highly effective tool for decision-making and reporting. 
 
MS Excel is easy to learn and widely used across different fields because it improves 
productivity and accuracy in handling data. Students use it for academic projects, teachers use 
it to maintain student records, businesses use it for accounting and inventory management, and 
researchers use it for data analysis. By learning MS Excel, users acquire essential digital skills 
that are valuable in both academic and professional environments. 
 

Introductory Case Study: Use of Spreadsheets for Office Data Management 
Background of the Organisation 
An organisation regularly handles numerical data related to attendance, expenses, 
inventories, and basic reports. Initially, data was maintained in handwritten registers 
or simple text documents. 
Contextual Situation 
As data volumes increased, the organisation adopted Microsoft Excel to: 

 Enter and store numerical data in worksheets 
 Perform calculations accurately 
 Sort and analyse information 
 Present data in chart form 

Stakeholders Involved 

 Office staff 
 Supervisors 
 Managers responsible for reviewing reports 

Issues Highlighted 

 Calculation errors in manual records 
 Difficulty in analysing large data sets 
 Poor presentation of numerical information 

Why This Case Is Important for the Lesson 
The case demonstrates the need for spreadsheet software, directly aligning with the 
lesson focus on worksheets, formulas, functions, sorting, and charts in MS Excel. 
Linkage to Lesson Concepts 
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 Creating and editing worksheets 
 Using formulas and functions 
 Sorting and querying data 
 Creating graphs and charts 

 
1.1 Creating and Editing Worksheets 

 

 
Creating a New Worksheet 
A worksheet is a single page in an Excel workbook where data is entered. 
Steps: 

1. Open MS Excel 
2. Click File → New → Blank Workbook 



MBA Hospital Administration                                   171          Information Technology for Healthcare…  

171 
 

3. To add a worksheet, click the + button near sheet tabs 
 
Editing a Worksheet 

 

 
You can edit a worksheet by: 

 Changing cell contents 
 Inserting and deleting rows/columns 
 Renaming sheets (Right-click → Rename) 
 Moving or copying sheets 

 
1.2 Cell Formatting 



Centre for Distance Education                         172                    Acharya Nagarjuna University 
 

 

 
What is Cell Formatting? 
Cell formatting means changing the appearance of cells to improve readability. 
Types of Formatting 
Formatting Type Use 
Font Formatting Change font, size, color 
Alignment Left, Center, Right 
Borders Add lines around cells 
Number Format Currency, Date, Percentage 
Fill Color Background shading 
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Sample Cell Formatting Diagram (Text) 
+---------------------------+ 
|   STUDENT MARKS REPORT    | 
+---------------------------+ 
| Name   | Marks | Result   | 
+--------+-------+----------+ 
| Ravi   | 85    | Pass     | 
| Anu    | 92    | Pass     | 
+--------+-------+----------+ 
 
1.3 Creating and Using Formulas 
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What is a Formula? 
A formula is an expression used to perform calculations. 
All formulas in Excel start with an equal sign (=). 
Example Formulas 
Formula Meaning 

=A1+B1 Addition 

=A1-B1 Subtraction 

=A1*B1 Multiplication 

=A1/B1 Division 
Diagram (Text Representation) 
A       B        C 
---------------------- 
10     20     =A1+B1 
Result in cell C1 → 30 
 
1.4 Using Functions in Excel 
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What is a Function? 
A function is a predefined formula that makes complex calculations easy. 
 
Common Functions 
Function Purpose Example 
SUM Adds values =SUM(A1:A5) 
AVERAGE Finds average =AVERAGE(A1:A5) 
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COUNT Counts numbers =COUNT(A1:A5) 
MAX Highest value =MAX(A1:A5) 
MIN Lowest value =MIN(A1:A5) 

 
Example Function Diagram 
A 
------- 
10 
20 
30 
40 
50 
 
Formula: =SUM(A1:A5) 
Result: 150 
 
1.5 Difference Between Formula and Function 
Feature Formula Function 

Definition User-created expression Predefined calculation 

Example =A1+B1 =SUM(A1:A5) 

Complexity Simple Can be complex 
 
1.6 Combined Flow Diagram 
Create Worksheet 
       ↓ 
Enter Data 
       ↓ 
Format Cells 
       ↓ 
Apply Formulas 
       ↓ 
Use Functions 
 
1.7 Practical Uses 

 Mark sheets 
 Salary calculations 
 Budget preparation 
 Inventory management 

 
Activity 1: Concept Identification 
Task: 
Identify which Excel feature is used for data entry, calculation, sorting, and presentation. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Clear understanding of Excel feature usage. 
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1.8 Use of Macros in MS Excel 
What is a Macro? 
A macro is a set of recorded actions that can be played back to automate repetitive tasks in 
Microsoft Excel. Macros are written in VBA (Visual Basic for Applications). 
 
How to Create a Macro 
Steps: 

1. Go to Developer tab 
2. Click Record Macro 
3. Give macro name 
4. Perform actions (formatting, calculations) 
5. Click Stop Recording 

 
How to Run a Macro 

 

 
Steps: 

1. Click Macros 
2. Select macro name 
3. Click Run 

 
1.9 Sorting and Querying Data 
 
Sorting Data 
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What is Sorting? 
Sorting arranges data in a specific order such as ascending or descending. 
Types of Sorting 

 A → Z / Z → A (Text) 
 Smallest → Largest (Numbers) 
 Oldest → Newest (Dates) 

 
Querying (Filtering) Data 
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Activity 2: Short Application Task 
Task: 
Explain how formulas and functions differ in Excel. 
………………………………………………………………………………………………
………………………………………………………………………………………………
………………………………………………………………………………………………
……………………………………………………………………………………………… 
Expected Learning Outcome: 
Understanding of calculation tools in Excel. 
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What is Querying? 
Querying means searching and extracting specific data using filters and conditions. 
Steps: 

1. Select data 
2. Click Data → Filter 
3. Use dropdown arrows to select conditions 

 
Sample Diagram of Sorting and Filtering 
Before Sorting: 
Name    Marks 
Ravi     65 
Anu      90 
Kumar    75 
 
After Sorting (Ascending): 
Name    Marks 
Ravi     65 
Kumar    75 
Anu      90 
 
1.10 Working with Graphs and Charts 
What are Charts? 
Charts are graphical representations of data that help in visual analysis. 
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Types of Charts 
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Chart Type Use 
Column Chart Compare values 
Bar Chart Horizontal comparison 
Line Chart Show trends over time 
Pie Chart Show percentage distribution 

 
Creating a Chart in Excel 
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Steps: 

1. Select data 
2. Click Insert 
3. Choose chart type 
4. Chart appears in worksheet 

 
Sample Text Diagram of a Bar Chart 
Marks 
 
Ravi  | ███████ 
Anu   | ██████████ 
Kumar | ████████ 
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Difference Table 
Feature Sorting Querying Charts 
Purpose Arrange data Extract specific data Visual representation 
Tools Used Sort command Filter/Search Chart tools 

 
Flow Diagram 
Raw Data 
    ↓ 
Sort Data 
    ↓ 
Query/Filter Data 
    ↓ 
Create Charts 
    ↓ 
Visual Analysis 
 
Practical Uses 

 Sales reports 
 Student performance analysis 
 Financial data analysis 
 Trend prediction 

 
1.11 SUMMARY 
 
MS Excel is a powerful spreadsheet application used to store, organize, and analyze data. It 
allows users to perform calculations using formulas and built-in functions. Excel supports 
sorting, filtering, and chart creation to help users understand data patterns and trends. It is 
widely used in business, education, finance, and research for budgeting, reporting, and data 
analysis. 
 

Activity 3: Reflective Question 
Task: 
Explain why charts are preferred over tables for presenting summary data. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Conceptual clarity on data presentation. 
 

1.12 KEYWORDS 
 
Worksheet – A single spreadsheet page where data is entered in rows and columns. 
Formula – An expression used to perform calculations in Excel using cell references. 
Function – A predefined formula that performs specific calculations automatically. 
Cell – The intersection of a row and a column where data is entered. 
Chart – A graphical representation of worksheet data. 

 
Case Study for Self-Assessment: Preparing Data Reports Using MS Excel 
Background 
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An office prepares monthly data sheets containing figures such as totals, averages, 
and summaries. These reports are reviewed by management for routine monitoring. 
Problem Situation 
Before using Excel: 

 Calculations were done manually 
 Revisions required complete reworking 
 Trends were difficult to identify 

Action Taken 
The office started using MS Excel features such as: 

 Built-in formulas and functions 
 Sorting and querying tools 
 Graphs and charts for visual representation 

Outcome 
Data handling became faster, more accurate, and easier to interpret. 
Relevance to the Lesson 
This case reinforces the exact applications of Excel covered in the lesson, without 
introducing any external data analysis tools. 
Analytical Questions 

1. Why are worksheets suitable for handling numerical data? 
2. How do formulas improve accuracy in calculations? 
3. Why is sorting data useful in Excel? 
4. How do charts help in understanding data? 
5. What problems arise when data is analysed manually? 

 
1.13 SELF-ASSESSMENT QUESTIONS 
 
A. Short-Answer Questions (5) – with Answers 

1. What is Microsoft Excel? 
A spreadsheet application used to organise and analyse data. 

2. What is a worksheet? 
A grid of rows and columns used to enter data. 

3. What is a formula in Excel? 
An expression used to perform calculations. 

4. Why is sorting data important? 
It helps organise information for easy analysis. 

5. What is the use of charts in Excel? 
To present data visually. 

 
B. Essay-Type Questions (5) – with Guiding Hints 

1. Explain the features of Microsoft Excel. 
Hints: Worksheets, formulas, charts 

2. Describe the process of creating and editing worksheets. 
Hints: Data entry, modification 

3. Explain the role of formulas and functions in Excel. 
Hints: Calculations, accuracy 

4. Discuss the importance of sorting and querying data. 
Hints: Organisation, analysis 

5. Explain how graphs and charts help in data presentation. 
Hints: Visual interpretation* 
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C. Multiple Choice Questions (5) 
1. Excel is mainly used for: 

a) Word processing 
b) Data analysis 
c) Image editing 
d) Programming 
Correct Answer: b 

2. A worksheet consists of: 
a) Slides 
b) Rows and columns 
c) Pages 
d) Paragraphs 
Correct Answer: b 

3. Which symbol is used to begin a formula in Excel? 
a) + 
b) – 
c) = 
d) * 
Correct Answer: c 

4. Sorting data helps to: 
a) Delete data 
b) Arrange data logically 
c) Format text 
d) Draw pictures 
Correct Answer: b 

5. Charts are used to: 
a) Store data 
b) Edit text 
c) Present data visually 
d) Print documents 
Correct Answer: c 
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LESSON-10 

MICROSOFT POWER POINT 
 
LEARNING OBJECTIVES 
 

At the end of this lesson, the learner should be able to: 
1. Explain the purpose and features of Microsoft PowerPoint. 
2. Create presentation slides using PowerPoint. 
3. Apply templates and slide designs to presentations. 
4. Explain the role of Slide Master in presentations. 
5. Use animations, timings, and action buttons appropriately. 

 
STRUCTURE 
 

1.0 INTRODUCTION TO MS POWERPOINT 

1.1 FEATURES OF MS POWERPOINT 

1.3 CREATION OF SLIDES WITH GRAPHS AND CHARTS 

1.4 DIAGRAMS – CREATION OF SLIDES WITH GRAPHS AND CHARTS 

1.11 SUMMARY 

1.12 KEYWORDS 

1.13 SELF-ASSESSMENT QUESTIONS 

1.14 SUGGESTED READINGS 

 
1.0 INTRODUCTION TO MS POWERPOINT  
 
MS PowerPoint (Microsoft PowerPoint) is a presentation software used to create visually 
attractive slide-based presentations. It is developed by Microsoft and is a part of the Microsoft 
Office suite. MS PowerPoint allows users to combine text, images, charts, audio, video, and 
animations to communicate ideas clearly and effectively. It is widely used in education, 
business, healthcare, marketing, and training programs for delivering structured and 
professional presentations. 
A presentation in MS PowerPoint is made up of a series of individual pages called slides. Each 
slide can contain different types of content such as titles, bullet points, pictures, tables, 
diagrams, and multimedia elements. PowerPoint provides various pre-designed templates and 
themes, which help users create professional-looking presentations quickly without the need 
for advanced design skills. The slide layout options allow users to arrange content in a well-
organized manner. 
The PowerPoint interface consists of several important components that make it easy to work 
with presentations. The Title Bar displays the presentation name, the Ribbon contains tabs such 
as Home, Insert, Design, Transitions, and Animations, and the Slides Pane shows thumbnail 
views of all slides. The Slide Area is the main workspace where content is created and edited, 
while the Status Bar displays information such as slide number and zoom level. These 
components help users navigate and manage presentations efficiently. 
MS PowerPoint supports adding visual effects that make presentations more engaging. Users 
can apply slide transitions to control how slides change during the slideshow and animations 
to add movement to text and objects. It also allows inserting charts and graphs to represent data 
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visually, helping the audience understand trends and comparisons more easily. Multimedia 
elements such as audio narration and video clips can also be added to enhance the quality of a 
presentation. 
PowerPoint is an essential tool for effective communication because it helps presenters 
organize information logically and present it in an attractive format. It is widely used by 
students for seminars and projects, teachers for classroom teaching, and professionals for 
meetings and conferences. Learning MS PowerPoint improves presentation skills and boosts 
confidence in public speaking, making it a valuable skill in both academic and professional 
environments. 
 

Introductory Case Study: Preparing a Presentation for an Office Meeting 
Background of the Organisation 
An organisation conducts regular meetings where information must be presented 
clearly to staff and supervisors. Earlier, information was shared verbally or through 
written notes. 
Contextual Situation 
To improve clarity and visual appeal, the organisation started using Microsoft 
PowerPoint to: 

 Prepare structured slides 
 Present information visually 
 Maintain uniform presentation style 

Stakeholders Involved 

 Presenters 
 Supervisors and managers 
 Staff attending meetings 

Issues Highlighted 

 Difficulty in explaining information without visual support 
 Inconsistent presentation formats 
 Time-consuming preparation of repeated presentations 

Why This Case Is Important for the Lesson 
The case demonstrates the need for presentation software, directly aligning with the 
lesson focus on creating slides, using designs, and presenting information 
effectively through PowerPoint. 
Linkage to Lesson Concepts 

 Features of PowerPoint 
 Creation of slides 
 Use of templates and slide designs 

 
1.1 Features of MS PowerPoint 
 
MS PowerPoint (Microsoft PowerPoint) is a powerful presentation tool developed by 
Microsoft and included in the Microsoft Office package. It provides a wide range of features 
that help users create professional, attractive, and interactive presentations. One of the key 
features is the availability of themes and templates, which allow users to apply consistent 
designs, colors, and fonts across all slides. This helps maintain a uniform and professional 
appearance throughout the presentation. 
Another important feature of PowerPoint is its support for multimedia integration. Users can 
easily insert images, audio files, video clips, tables, charts, and SmartArt graphics into slides. 
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The software also supports animations and transitions, which add movement effects to text and 
objects and control how one slide changes to the next. These features help make presentations 
more engaging and easier to understand for the audience. 
PowerPoint also offers editing and formatting tools that allow users to change font styles, sizes, 
colors, alignment, and spacing. It provides slide layout options such as title slide, content slide, 
comparison slide, and blank slide. With the slide master feature, users can control the overall 
formatting and design of all slides from a single place, saving time and ensuring design 
consistency. 
Another valuable feature is collaboration and sharing. Multiple users can work on the same 
presentation using cloud services, and features like comments and real-time editing make 
teamwork easier. PowerPoint also supports presenter tools, such as Presenter View, which 
shows notes and upcoming slides only to the presenter during a slideshow. These features make 
MS PowerPoint suitable for both individual and group presentations. 
 
Activity 1: Concept Identification 
Task: 
List the steps involved in creating a PowerPoint presentation. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Understanding of slide creation process. 
 
1.3 Creation of Slides with Graphs and Charts 
Creating slides with graphs and charts in Microsoft PowerPoint helps convert numerical data 
into visual form, making information easy to understand. Charts are especially useful for 
comparing values, showing trends over time, and presenting percentage shares. PowerPoint 
provides several chart types such as column charts, bar charts, line charts, pie charts, and area 
charts that can be inserted directly into slides. 
To create a slide with a chart, the user first selects a new slide layout such as “Title and 
Content.” After clicking the Insert tab and choosing Chart, a dialog box appears allowing the 
user to select the type of chart. Once a chart type is selected, a small spreadsheet window opens 
where users can enter or edit the data. As soon as data is entered, the chart automatically 
updates in the slide. The chart can then be resized, repositioned, and formatted using chart 
tools. 
Graphs and charts can be customized using different colors, styles, titles, legends, and data 
labels. Users can add a chart title to explain what the data represents and use axis labels to 
make the chart easier to read. Gridlines can be added or removed to improve clarity. These 
formatting options help make the chart more attractive and meaningful to the audience. 
Using graphs and charts in PowerPoint improves the quality of presentations by making them 
more interactive and data-driven. Instead of reading long tables of numbers, the audience can 
quickly understand patterns and comparisons through visual representation. This makes 
PowerPoint an effective tool for business reports, academic presentations, project reviews, and 
training sessions. 
 
1.4 Diagrams – Creation of Slides with Graphs and Charts 
Diagram 1: Steps to Create a Chart in PowerPoint 
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Open PowerPoint 
       ↓ 
Insert New Slide 
       ↓ 
Click Insert Tab 
       ↓ 
Select Chart 
       ↓ 
Enter Data 
       ↓ 
Chart Appears on Slide 
 
Diagram 2: Types of Charts 
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Diagram 3: Sample Text Graph 
Sales Graph 
 
Q1  █████ 
Q2  ███████ 
Q3  █████████ 
Q4  ██████ 
 
Activity 2: Short Application Task 
Task: 
Explain how templates and slide designs help in presentations. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Conceptual clarity on presentation design. 
 
1.5 SUMMARY 
 
MS PowerPoint is a presentation software used to create slide-based presentations for teaching, 
training, meetings, and seminars. It allows users to add text, pictures, shapes, charts, and tables 
to slides. Users can organize slides using different views like Normal View and Slide Sorter 
View. PowerPoint helps present information in a clear and structured way and is widely used 
in education and business. 
 
1.6 KEYWORDS 

 
Slide – A single page or screen in a PowerPoint presentation. 
Slide Sorter View – A view that displays all slides as thumbnails for easy arrangement. 
Text Box – A container used to insert and format text on a slide. 
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Insert Tab – The toolbar option used to add pictures, charts, tables, and shapes. 
Presentation – A collection of slides created to communicate information visually. 

 
Activity 3: Reflective Question 
Task: 
Explain why consistency is important in presentations. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Understanding of Slide Master usage. 
 

Case Study for Self-Assessment: Using PowerPoint for Information Presentation 
Background 
An office prepares presentations to communicate plans, instructions, and summaries. 
These presentations are reused and modified periodically. 
Problem Situation 
Before using PowerPoint effectively: 

 Slides lacked uniform formatting 
 Changes had to be made on each slide separately 
 Presentations appeared inconsistent 

Action Taken 
The office used PowerPoint features such as: 

 Templates and slide designs 
 Slide Master for uniform formatting 
 Basic animations and timings 

Outcome 
Presentations became consistent, visually clear, and easy to update. 
Relevance to the Lesson 
This case reinforces the exact PowerPoint features covered in the lesson, without 
introducing any external presentation tools. 
Analytical Questions 

1. Why is PowerPoint suitable for presentations? 
2. How do templates improve presentation quality? 
3. What is the role of Slide Master? 
4. Why should animations be used carefully? 
5. How do timings help in presentations? 

 
1.7 SELF-ASSESSMENT QUESTIONS 
 
A. Short-Answer Questions (5) – with Answers 

1. What is Microsoft PowerPoint? 
A presentation software used to create slide-based presentations. 

2. What is a slide? 
An individual page of a PowerPoint presentation. 

3. What is a template in PowerPoint? 
A pre-designed layout used for slides. 

4. What is Slide Master? 
A feature used to control overall slide formatting. 
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5. Why are animations used in presentations? 
To enhance visual presentation of content. 

 
B. Essay-Type Questions (5) – with Guiding Hints 

1. Explain the features of Microsoft PowerPoint. 
Hints: Slides, designs, animations 

2. Describe the steps involved in creating a PowerPoint presentation. 
Hints: New presentation, slide creation 

3. Explain the use of templates and slide designs. 
Hints: Uniformity, appearance 

4. Discuss the importance of Slide Master. 
Hints: Consistency, formatting 

5. Explain the role of animations and timings in presentations. 
Hints: Visual effect, control* 

 
C. Multiple Choice Questions (5) 

1. PowerPoint is mainly used for: 
a) Data analysis 
b) Word processing 
c) Presentations 
d) Programming 
Correct Answer: c 

2. A PowerPoint file is called: 
a) Worksheet 
b) Document 
c) Presentation 
d) Database 
Correct Answer: c 

3. Slide Master is used to: 
a) Add pictures 
b) Control slide formatting 
c) Insert tables 
d) Print slides 
Correct Answer: b 

4. Templates help to: 
a) Delete slides 
b) Apply uniform design 
c) Reduce file size 
d) Add sound 
Correct Answer: b 

5. Animations should be used: 
a) Excessively 
b) Randomly 
c) Appropriately 
d) Not at all 
Correct Answer: c 

 
References and Suggested Readings 
A. Text Books (Printed & Published Only) 
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LESSON-11 
MICROSOFT POWER POINT TEMPLATES AND SLIDE DESIGN 

 
LEARNING OBJECTIVES 
 
Objectives of the Lesson 
At the end of this lesson, the learner should be able to: 

1. Explain the concept of templates in Microsoft PowerPoint. 
2. Describe slide design and layout options. 
3. Apply templates to create presentations. 
4. Organise slides using appropriate layouts. 
5. Explain the importance of design consistency in presentations. 

 
STRUCTURE 
 
1.0 INTRODUCTION 

1.1 USE OF DIFFERENT TEMPLATES IN MS POWERPOINT 

1.2 USE OF DIFFERENT SLIDE DESIGNS IN MS POWERPOINT 

1.3 SUMMARY 

1.4 KEYWORDS 

1.5 SELF-ASSESSMENT QUESTIONS 

1.6 SUGGESTED READINGS 

 
1.0 INTRODUCTION 
 
MS PowerPoint (Microsoft PowerPoint) is a widely used presentation application developed 
by Microsoft and included in the Microsoft Office package. Templates play an important role 
in creating professional and visually consistent presentations. A template is a pre-designed set 
of slide layouts, background designs, fonts, and color schemes that helps the user create 
attractive presentations quickly and easily without starting from scratch. 
 

Introductory Case Study: Improving Presentation Appearance Using Templates 
Background of the Organisation 
An organisation regularly prepares presentations for meetings and training sessions. 
Earlier, each presentation was created from scratch without any standard design. 
Contextual Situation 
As a result of inconsistent slide designs: 

 Presentations looked unprofessional 
 Fonts and colours varied from slide to slide 
 Information appeared cluttered 

To overcome these issues, the organisation began using PowerPoint templates and 
slide designs. 
Stakeholders Involved 

 Staff preparing presentations 
 Supervisors and managers reviewing slides 
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Issues Highlighted 

 Lack of uniform appearance 
 Poor visual organisation of content 
 Time spent repeatedly designing slides 

Why This Case Is Important for the Lesson 
The case demonstrates the need for templates and slide design, which is the core 
focus of this lesson. 
Linkage to Lesson Concepts 

 Templates in PowerPoint 
 Slide design and layouts 
 Consistency across slides 

 
1.1 Use of Different Templates in MS PowerPoint 
What is a Template in PowerPoint? 
A template is a ready-made presentation format that contains a set of predefined slide designs. 
It includes background styles, font types, color combinations, and layout structures. By 
selecting a suitable template, users can focus more on the content rather than on designing the 
visual appearance. Templates are especially useful for business meetings, classroom teaching, 
marketing pitches, research presentations, and seminars. 
 
Types of Templates in MS PowerPoint 
1. Business Templates 
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Business templates are used for corporate meetings, annual reports, project reviews, and sales 
presentations. They usually contain professional color schemes like blue, grey, and white with 
clean layouts. These templates include slides such as agenda, project overview, financial charts, 
and conclusion slides. 
 
2. Education Templates 
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Education templates are designed for teaching and learning purposes. They use simple layouts, 
readable fonts, and sometimes include icons and diagrams suitable for explaining topics. 
Teachers and students use these templates for lectures, seminars, and academic projects. 
 
3. Marketing Templates 
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Marketing templates are used for product launches, advertisements, and promotional 
presentations. They often use bright colors, large images, and creative layouts to attract 
audience attention and highlight product features. 
 
4. Portfolio Templates 

 

 
Portfolio templates are used to showcase personal skills, work samples, achievements, and 
resumes. These templates help individuals present their profiles in a professional and visually 
appealing way. 
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Steps to Use a Template in PowerPoint 
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Steps: 

1. Open Microsoft PowerPoint 
2. Click File → New 
3. Browse the available templates 
4. Select the required template 
5. Click Create 
6. Add your content to the slides 

 
Examples of Using Templates 
Example 1: Business Presentation Structure 
Slide 1 – Title Slide (Company Name) 
Slide 2 – Agenda 
Slide 3 – Company Overview 
Slide 4 – Sales Chart 
Slide 5 – Conclusion 
Example 2: Education Presentation Structure 
Slide 1 – Topic Title 
Slide 2 – Definition 
Slide 3 – Diagram 
Slide 4 – Key Points 
Slide 5 – Summary 
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Diagram – Workflow of Template Usage 

 

 
Open PowerPoint 
       ↓ 
Choose Template 
       ↓ 
Apply Slide Layouts 
       ↓ 
Insert Text & Images 
       ↓ 
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Finalize Presentation 
 
Advantages of Using Different Templates 

 Saves time and effort 
 Ensures professional look 
 Maintains design consistency 
 Easy to edit and customize 
 Suitable for different purposes 

 
Activity 1: Concept Identification 
Task: 
Identify the difference between a PowerPoint template and a slide layout. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Clear understanding of templates and layouts. 
 
1.2 Use of Different Slide Designs in MS PowerPoint 
Introduction 
MS PowerPoint (Microsoft PowerPoint) is a powerful presentation software developed by 
Microsoft and part of the Microsoft Office package. Slide design refers to the overall layout 
and visual appearance of slides, including background, color schemes, fonts, placeholders, and 
arrangement of text and objects. Proper use of slide designs helps make presentations more 
attractive, professional, and easy to understand. 
 
What is Slide Design? 
Slide design is the predefined structure and visual format used to organize content on a slide. 
It includes title position, content boxes, image placeholders, and visual styles. Slide designs 
ensure consistency across all slides and help in maintaining a uniform look throughout the 
presentation. 
 
Types of Slide Designs with Examples 
1. Title Slide Design 
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Use: First slide of the presentation 
Contains: Presentation title, subtitle, name, date 
Example: 
INTRODUCTION TO COMPUTER NETWORKS 
By: John Smith 
 
2. Title and Content Slide Design 
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Use: To display text, bullet points, and small images 
Example: 
Types of Networks 
• LAN 
• MAN 
• WAN 
 
3. Section Header Slide Design 
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Use: To divide presentation into sections 
Example: 
CHAPTER 1: BASICS OF NETWORKING 
 
4. Two Content Slide Design 
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Use: To display text and image/diagram side by side 
Example: 
Left Side: Definition 
Right Side: Diagram/Image 
 
5. Comparison Slide Design 
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Use: To compare two topics 
Example: 
LAN                     WAN 
High speed              Low speed 
Small area              Large area 
Low cost                High cost 
 
6. Blank Slide Design 
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Use: When full custom design is required 
Example: Custom diagram or large image 
 
 
 
 
Steps to Apply Slide Designs 

 

 
Steps: 

1. Select the slide 
2. Click Home → Layout 
3. Choose the required slide design 

 
Diagram – Workflow of Slide Design Application 
Create New Slide 
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        ↓ 
Select Slide 
        ↓ 
Choose Layout 
        ↓ 
Apply Design 
        ↓ 
Insert Content 
 
Advantages of Using Slide Designs 

 Improves visual appearance 
 Organizes content clearly 
 Saves time in designing 
 Enhances audience understanding 

 
Activity 2: Short Application Task 
Task: 
Explain how slide design affects the readability of a presentation. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Understanding of visual organisation in slides. 
 
1.3 SUMMARY 
 
Templates and slide designs in MS PowerPoint help users create visually consistent and 
attractive presentations. Templates provide pre-designed themes with coordinated colors, fonts, 
and backgrounds, which save time and improve presentation quality. Different slide designs or 
layouts help organize content such as titles, text, images, and charts in a structured way. Using 
appropriate templates and slide designs makes presentations more engaging and easier to 
understand. 
 
 
1.4 KEYWORDS 
 

Template – A pre-designed PowerPoint file that includes fixed formats, colors, and styles. 
Theme – A combination of colors, fonts, and effects applied to slides for a uniform look. 
Slide Layout – The arrangement of text and content placeholders on a slide. 
Design Tab – The PowerPoint menu used to apply themes and slide designs. 
Placeholder – A predefined area in a slide used to insert text, images, or content. 

 
Activity 3: Reflective Question 
Task: 
Explain why consistency is important when designing slides. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
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Expected Learning Outcome: 
Conceptual clarity on uniform slide design. 
 
Case Study for Self-Assessment: Using Slide Design for Consistent Presentations 
Background 
An office prepares multiple presentations for different departments. Each presentation 
follows a similar structure but varies in content. 
Problem Situation 
Without templates: 

 Slides had inconsistent headings and layouts 
 Formatting errors occurred frequently 
 Updating designs was time-consuming 

Action Taken 
The office adopted: 

 PowerPoint templates for standard structure 
 Predefined slide layouts for content organisation 

Outcome 
Presentations became: 

 Uniform in appearance 
 Easier to prepare and modify 
 More visually clear 

Relevance to the Lesson 
This case reinforces the exact lesson content on templates and slide design, without 
introducing additional features. 
Analytical Questions 

1. Why are templates useful in PowerPoint? 
2. How do slide layouts improve content organisation? 
3. What problems arise from inconsistent slide design? 
4. How does using templates save time? 
5. Why is uniform design important in presentations? 

 
Self-Assessment Questions 
A. Short-Answer Questions (5) – with Answers 

1. What is a template in PowerPoint? 
A pre-designed set of slides with consistent layout and formatting. 

2. What is slide design? 
The arrangement of text, colours, and layout on slides. 

3. What is a slide layout? 
A predefined arrangement of content on a slide. 

4. Why are templates used? 
To maintain uniformity and save time. 

5. What is the benefit of consistent slide design? 
Improved clarity and professional appearance. 

 
B. Essay-Type Questions (5) – with Guiding Hints 

1. Explain the concept of templates in PowerPoint. 
Hints: Purpose, uniformity 

2. Describe different slide layouts available in PowerPoint. 
Hints: Title, content layouts 
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3. Discuss the importance of slide design in presentations. 
Hints: Readability, organisation 

4. Explain how templates help in creating effective presentations. 
Hints: Time saving, consistency 

5. Explain why design consistency is necessary across slides. 
Hints: Visual flow, clarity* 

 
C. Multiple Choice Questions (5) 

1. A PowerPoint template mainly helps to: 
a) Insert animations 
b) Maintain uniform design 
c) Add sound 
d) Print slides 
Correct Answer: b 

2. Slide layout refers to: 
a) Colour scheme 
b) Arrangement of content 
c) File name 
d) Printing option 
Correct Answer: b 

3. Templates reduce: 
a) Slide size 
b) Preparation time 
c) Font size 
d) Number of slides 
Correct Answer: b 

4. Consistent slide design improves: 
a) File storage 
b) Readability 
c) Sound quality 
d) Printing speed 
Correct Answer: b 

5. Which is NOT a slide layout? 
a) Title slide 
b) Content slide 
c) Two-content slide 
d) Spreadsheet 
Correct Answer: d 

 
References and Suggested Readings 
A. Text Books (Printed & Published Only) 

1. Cox, J., et al., 2007 Microsoft Office System Step-by-Step, PHI Learning, New Delhi, 
2007. 

2. Goel, A., Computer Fundamentals, Pearson Education, New Delhi, 2010. 
3. Rajaraman, V., Introduction to Information Technology, Prentice Hall of India, New 

Delhi, 2008. 
4. Saxena, S. & Chopra, P., Computer Applications in Management, Vikas Publishing 

House, New Delhi, 2012. 
5. Norton, P., Introduction to Computers and Communications, Tata McGraw-Hill, New 

Delhi, 2009. 
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LESSON-12 

MICROSOFT POWER POINT SLIDE MASTER, ANIMATIONS,  
TIMINGS, AUDIO & VIDEO 

 
LEARNING OBJECTIVES 
 
At the end of this lesson, the learner should be able to: 

1. Explain the purpose and uses of Slide Master in MS PowerPoint. 
2. Apply animations to text and objects in slides. 
3. Use slide timings to control presentation flow. 
4. Insert and manage audio and video elements in presentations. 
5. Create interactive and multimedia PowerPoint presentations. 

 
STRUCTURE 
 
1.1 USES OF SLIDE MASTER IN MS POWERPOINT 

1.2 USES OF ANIMATIONS, TIMINGS, AUDIO & VIDEO IN MS POWERPOINT 

1.3 SUMMARY 

1.4 KEYWORDS 

1.5 SELF-ASSESSMENT QUESTIONS 

1.6 SUGGESTED READINGS 

 
1.1 Uses of Slide Master in MS PowerPoint  
 
1. Why Slide Master matters (uses & benefits) 
 
Slide Master is essential for any presentation that must look consistent, professional, and 
maintainable. Its main uses: 

 Global formatting control: set a single font family, size, color scheme, and it applies 
to every slide. 

 Consistent logo/header/footer placement: place a logo, footer text or page number 
once so it appears uniformly on all slides. 

 Create and manage layouts: define custom layouts (title slide, two-content, 
comparison, blank, etc.) so every new slide follows the template. 

 Uniform placeholders: control positions and sizes of title/content/placeholders so 
content aligns perfectly across slides. 

 Efficient updates: change the master once (for example, update the company logo or 
color) and every slide updates automatically. 

 Brand compliance: enforce corporate colors, fonts and slide elements for all 
presenters. 

 Faster slide creation: predesigned masters speed up building new presentations — 
ideal for recurring reports, lectures, marketing decks. 

 Presenter consistency: keep notes, slide number and date format consistent for 
printing and presenter view. 

Practical scenarios: corporate templates, lecture series, training material, research theses, 
standardized reports. 
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2. Slide Master components (what you’ll see) 
 Slide Master (topmost thumbnail): controls theme and default styles for all layouts 

beneath it. 
 Layout masters (below the Slide Master): Title Slide, Title & Content, Two Content, 

Comparison, Blank, etc. Each layout inherits from the Slide Master but can have 
exceptions. 

 Placeholders: areas for title, subtitle, text, picture, chart, date, footer, slide number. 
 Theme elements: background, color palette, fonts, effects and slide size. 

 
3. Step-by-step procedure — Create & use Slide Master (with diagrams) 
Below is a clear, repeatable procedure. Each step is followed by a compact ASCII diagram to 
reinforce the visual idea. 
Step A — Open Slide Master view 

1. Open your presentation in PowerPoint. 
2. Click View → Slide Master. 
3. The left pane now shows the master slide at the top and layout slides under it. 

Diagram (before / after): 
Normal View: 
[Slide thumbnails] 
 -> Slide 1 
 -> Slide 2 
 -> ... 
 
After: View → Slide Master 
[Master Pane] 
 -> Slide Master (top) 
 -> Title Slide Layout 
 -> Content Layout 
 -> Two Content Layout 
 -> ... 
Step B — Edit the Slide Master (global changes) 

1. Select the Slide Master (top thumbnail). 
2. Make global edits: change background (Format Background), set theme fonts (Home 

→ Font or Design → Fonts), choose theme colors (Design → Colors), and insert 
logo/image or watermark (Insert → Picture). 

3. Add or edit placeholders for footer, date, slide number: Insert Placeholder → choose 
type and place it. 

Diagram (logo + footer applied to master): 
[Slide Master] ---------------------- 
| LOGO (top-right)                   | 
|                                    | 
| Title placeholder                   | 
| Content placeholder                 | 
|                                    | 
| Footer: "Company Confidential"     | 
| Slide #   Date                      | 
-------------------------------------- 
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Step C — Customize specific layout masters 
1. Click any layout under the master (e.g., Title Slide, Two Content). 
2. Rearrange placeholders, change alignment, or hide a placeholder (select → Delete). 
3. If a specific layout needs a different background or font, change it here — it overrides 

the Slide Master for that layout only. 
Diagram (two-content layout change): 
[Two Content Layout] 
| Title                             | 
| Left placeholder | Right placeholder | 
| Footer + Slide #                   | 
Step D — Create new custom layouts (optional, advanced) 

1. In Slide Master view, click Insert Layout. 
2. Add placeholders (text, picture, chart) and name the layout (right-click → Rename 

Layout). 
3. This layout appears as an option when you add a new slide in Normal view. 

Diagram (custom layout with image and caption): 
[Custom Layout: Image + Caption] 
| Title                         | 
| [Large Picture Placeholder]   | 
| [Caption / Text Placeholder]  | 
| Footer / Slide #              | 
Step E — Set Slide Master defaults (fonts & colors) 

1. Use Slide Master → Fonts to pick heading/body fonts. 
2. Use Colors to pick or create a color palette that matches branding. 
3. Use Effects if you want consistent shadow/3D effects. 

Tip: use accessible font sizes and high-contrast colors for readability. 
Step F — Close Master View and use layouts 

1. Click Slide Master → Close Master View (or View → Normal). 
2. Insert new slides using Home → New Slide and choose the layout you customized. All 

new slides follow the master. 
Flow diagram (compact): 
Open PPT → View → Slide Master 
     ↓ 
Edit Slide Master (logo, fonts, background) 
     ↓ 
Customize Layouts (Title, Content, Custom) 
     ↓ 
Close Master View → Insert slides using chosen layouts 
Step G — Update master later (propagates automatically) 

1. Reopen Slide Master to edit. 
2. Any change to the master (e.g., update logo) automatically updates all slides that use 

that master/layout. 
3. If a slide has manual overrides (direct edits), you may need to reset (Home → Reset) to 

reapply master formatting. 
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4. Practical examples & scenarios (with mini-diagrams) 
Example 1 — Add company logo & footer to all slides 

 In Slide Master: Insert logo image in top-right, Insert Placeholder → Footer at bottom 
→ type “Company Confidential”. 
Result: every slide displays logo + footer without editing each slide. 

Mini view: 
Slide Master:  [Logo]                 [Title] 
               [content....] 
               Footer: Company Confidential 
Example 2 — Two different slide masters (for sections) 

 Create two masters: Master A (blue theme) for business section; Master B (green 
theme) for training section. 

 Apply Master B to slides 10–20 (Design → Variants → Browse for Themes or use Slide 
Layouts). 
Benefit: different sections have distinct visual identity while keeping consistency 
within sections. 

Mini view: 
Master A (Blue)  -> Slides 1-9 
Master B (Green) -> Slides 10-20 
Example 3 — Force consistent title position (lecture slides) 

 Edit Title placeholder position in Slide Master so every lecture slide has title at the same 
X/Ycoordinates. 
Result: diagrams and tables align vertically on sequential slides — better for handouts. 

 
5. Tips, best practices & troubleshooting 

 Use Slide Master early: design master before creating content to avoid rework. 
 Keep masters simple: avoid overcrowding; minimal and clear is more professional. 
 Use placeholders, not fixed text boxes: placeholders remain editable per slide; fixed 

text in master is global. 
 Name custom layouts: right-click → Rename Layout to make them easy to find. 
 Avoid local manual formatting: excessive manual changes on slides may prevent 

master updates from appearing; use Reset on slides to reapply master. 
 Save master as template (.potx): File → Save As → PowerPoint Template to reuse 

across presentations. 
 Check slide size and aspect ratio: Design → Slide Size before finalizing master (16:9 

vs 4:3). 
 Accessibility: choose high contrast colors, readable fonts (≥24 pt for body in 

presentation). 
 Logos and images: use high-resolution images but optimized size to avoid large file 

sizes. 
 Protect corporate template: consider saving a locked read-only copy for users to 

avoid unauthorized changes. 
Troubleshooting: 

 If a slide doesn’t reflect master changes, it might use a different layout or have direct 
formatting — use Layout (Home → Layout) to reapply the correct layout, or Reset to 
revert manual changes. 

 If fonts look wrong when opened on another computer, embed fonts (File → Options 
→ Save → Embed fonts in the file) or use common system fonts. 
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Activity 1: Concept Identification 
Task: 
List three functions of Slide Master in PowerPoint. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Understanding of centralized formatting control. 
 
6. Quick classroom exercise (5–10 minutes) 

1. Open a blank presentation. 
2. View → Slide Master. Insert a sample logo top-right and type “Faculty: [Your Name]” 

in footer placeholder. 
3. Create one custom layout named “Two-picture + Caption”. Add two picture 

placeholders and one small text placeholder beneath each. Close master view. 
4. Insert a new slide → choose your “Two-picture + Caption” layout. Insert sample 

pictures. Observe footer and logo appear automatically. 
Expected learning: students see how master changes propagate and how custom layouts make 
slide creation faster. 
 
Introductory Case Study: Maintaining Consistency and Multimedia Use in Presentations 
Background of the Context 
An organization regularly prepares PowerPoint presentations for meetings, training sessions, 
and academic purposes. These presentations often include text, images, animations, and 
multimedia elements. 
Contextual Situation 
Initially, presenters formatted each slide individually and added animations and audio 
randomly. This resulted in: 

 Inconsistent slide appearance 
 Repetitive formatting work 
 Poor synchronization of animations and audio 

To overcome these issues, the presenters began using Slide Master, controlled 
animations, slide timings, and audio/video features available in PowerPoint. 
Stakeholders Involved 

 Presentation creators 
 Audience members 
 Supervisors evaluating presentations 

Issues Highlighted 

 Lack of uniform formatting 
 Overuse or misuse of animations 
 Poor timing and audio control 

Why This Case Is Important for the Lesson 
The case clearly reflects the need for Slide Master and multimedia controls, which are 
the core focus areas of Lesson–12. 
Linkage to Lesson Concepts 

 Uses of Slide Master 
 Animations and timings 
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 Audio and video insertion 
 
1.2 Uses of Animations, Timings, Audio & Video in MS PowerPoint  
 
1. Why use animations, timings, audio and video? 
Animations let you reveal content progressively (avoid overwhelming the audience), 
emphasize key points, and illustrate processes. Timings automate slide flow for rehearsed or 
kiosk presentations. Audio (narration, background music, sound effects) improves clarity and 
accessibility; video embeds demonstrations, interviews, and dynamic visuals that explain 
complex ideas more effectively than text or images alone. 
 
Practical classroom/corporate uses: 

 Step-by-step process build (animations) 
 Auto-advance slides for unattended kiosks (timings) 
 Voiceover lecture or spoken instructions (audio) 
 Product demo, experiment footage, or guest talk (video) 

 
2. PowerPoint components you’ll use 

 Animations Pane (View → Animations → Animation Pane) — control order & timing. 
 Animation Gallery (Animations tab) — Entrance, Emphasis, Exit, and Motion Paths. 
 Transitions tab — slide-to-slide visual effects and basic timings. 
 Insert → Audio / Video — embed or link multimedia. 
 Playback tab (appears when media selected) — play options, trimming, volume. 
 Rehearse Timings (Slide Show tab) — record slide durations and narration. 
 Record Slide Show — record narration, ink, and timings. 

 
3. Step-by-step: Adding and controlling animations (with diagrams) 
Step A — Apply an animation 

1. Select object (text box, shape, picture). 
2. Go to Animations → pick an animation (Entrance/Emphasis/Exit/Motion Path). 
3. The slide shows a small numbered tag (order index). 

Diagram (before/after applying animation): 
[Slide] 
 Title 
 [1] Bullet 1 
 [2] Bullet 2 
 
After Animations tab selection: 
 Bullet 1 ← Entrance Fade (1) 
 Bullet 2 ← Entrance Fly In (2) 
 
Step B — Open Animation Pane & adjust order 

1. Click Animations → Animation Pane. 
2. In the pane: drag items to reorder, click the drop-down for options. 

Diagram (Animation Pane simplified): 
Animation Pane 
1. Bullet 1  | Start: On Click | Duration: 0.50s 
2. Bullet 2  | Start: With Previous | Delay: 0.30s 
Step C — Set Start / Duration / Delay 

 Start: On Click / With Previous / After Previous 
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 Duration: How long the animation takes (seconds) 
 Delay: Wait before starting (seconds) 

Example: Make bullet 2 start After Previous with 0.3s delay to create a smooth stagger. 
 
4. Step-by-step: Using Timings and Rehearse Timings 
Slide-level transition timing 

1. Select slide → Transitions tab. 
2. Under Timing, uncheck “On Mouse Click” and set After X:XX to auto-advance. 

Rehearse Timings (recorded slide durations) 
1. Slide Show → Rehearse Timings. 
2. Advance through slides while speaking or practicing; PowerPoint records time on each 

slide. 
3. Save timings at the end. 

Diagram (Auto-advance): 
Transition: Fade 
Advance slide → After: 00:08  (slide auto moves after 8 seconds) 
 
5. Step-by-step: Inserting and controlling audio 
Insert audio (narration / music) 

1. Insert → Audio → Audio on My PC (or Record Audio). 
2. Select audio icon placed on slide (speaker icon). 

Playback settings (Playback tab) 
 Start: On Click / Automatically / Play Across Slides 
 Play Across Slides: good for background music across presentation 
 Loop until Stopped: for kiosk mode 
 Hide During Show: hides icon while presenting 
 Trim Audio: remove unwanted start/end portions 
 Volume: adjust playback loudness 

Diagram (audio options): 
[Audio icon] 
Playback: Start = Automatically | Play across slides = checked | Loop = unchecked 
Record narration for entire show 

1. Slide Show → Record Slide Show. 
2. Choose to record slide and animation timings and narration. 
3. Speak per slide; stop to move to next. Timings and audio attached to slides. 

Tip: Use a good microphone and quiet room; use Script or bullet notes for smooth narration. 
 
6. Step-by-step: Inserting and editing video 
Insert video 

1. Insert → Video → This Device (or Online Video). 
2. Video placeholder appears on slide. 

Playback & Format controls 
 Playback tab: Start (On Click / Automatically), Play Full Screen, Trim Video, Fade 

In/Out, Volume, Loop until Stopped. 
 Format tab: Picture Frame, Corrections, Poster Frame (choose thumbnail), Crop, Size. 

Diagram (video workflow): 
Insert → Video placed on slide 
→ Playback: Start = On Click   (or Auto) 
→ Format: Poster Frame = choose thumbnail 
→ Trim: Cut lead/trailing silence 
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Tips for embedded vs linked video 
 Embedded stores video in .pptx — file grows. 
 Linked keeps file external — reduces .pptx size but must keep video file with 

presentation. 
Recommendation: embed short clips; use linked for very large videos if you’ll always 
present from the same folder. 

 
7. Synchronizing animations with audio/video 
Use the Animation Pane to add animation to objects and to the audio/video object itself. You 
can set audio/video to start With Previous and then chain subsequent animations After 
Previous with delays to sync actions. 
Example: Start video (animation entry) → after 5s, animate overlay text to appear. 
Animation Pane: 
1. Video Play       Start: On Click (or Automatically) 
2. Overlay Text     Start: After Previous | Delay: 5.00s 
 
8. Best practices & accessibility 

 Less is more: use subtle animations—avoid distracting audiences. 
 Purposeful animations: use to teach sequence or emphasize, not for decoration. 
 Consistent timing: maintain uniform durations across similar animations. 
 Readable text durations: don’t auto-advance slides too fast; typical reading time = 6–

10 seconds per slide for dense content. 
 Use high-quality audio: check levels and avoid clipping; normalize voice levels. 
 Provide captions/transcripts: for accessibility and non-native speakers. PowerPoint 

supports closed captions when recording narration. 
 Test on target machine: fonts, video codecs, and hardware vary—always test on 

presenting device. 
 Embed fonts or use standard fonts to avoid substitution on other machines. 
 Compress media (File → Info → Compress Media) to reduce file size while preserving 

quality. 
 
Activity 2: Application Task 
Task: 
Explain how slide timings help in running an automatic presentation. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Conceptual clarity on presentation flow control. 
 
9. Common troubleshooting 

 Video won’t play: ensure codecs installed or use MP4 (H.264 + AAC) which is widely 
compatible. 

 Audio cuts off when moving slides: set audio playback to Play across slides. 
 Animations out of order after editing: open Animation Pane and reorder manually. 
 Large file size: compress media or link large files. 
 Timing not matching rehearsal: re-record timings or fine-tune delays in Animation 

Pane. 
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10. Classroom exercise (15–20 minutes) 
1. Create a 5-slide deck: Title, 3 content slides, Thank you. 
2. On each content slide: add three bullet points. Animate bullets to appear one-by-one 

using Fade with With Previous for a cascading effect (Delay 0.3s). 
3. Insert a short (10–20s) video on slide 3; set Poster Frame and Start = Automatically. 

Trim to 15s. 
4. Insert background music on slide 2 → Playback: Play across slides and Loop until 

Stopped. Set volume low. Hide icon. 
5. Rehearse Timings and save. Run Slide Show to test audio/video sync and automatic 

advance. 
 
1.3 SUMMARY 
 
Slide Master in PowerPoint allows users to control the overall design and layout of slides from 
one central place, ensuring consistency throughout a presentation. Animations help add 
movement to text and objects to make content more engaging. Timings control the duration of 
slides and automate the slide show. Audio and video features allow users to embed sound and 
visual clips, making presentations more interactive and effective for learning and 
communication. 
 
Activity 3: Reflective Question 
Task: 
Explain one advantage and one limitation of using audio and video in presentations. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Balanced understanding of multimedia usage. 
 
1.4 KEYWORDS 
 

Slide Master – A tool that controls the overall design and formatting of all slides in a 
presentation. 
Animations – Visual effects applied to text or objects to add movement. 
Slide Timings – The control of how long a slide is displayed during a slideshow. 
Audio – Sound files added to slides to enhance presentation delivery. 
Video – Moving visual files embedded in slides for better explanation of concepts. 

 
Case Study for Self-Assessment: Using Slide Master and Multimedia Features Effectively 
Background 
An institution prepares a standard presentation template for repeated use in seminars and 
lectures. The content changes, but the overall design must remain the same. 
Problem Situation 
Without Slide Master and proper multimedia control: 

 Fonts and layouts differed across slides 
 Animations appeared out of sequence 
 Audio and video playback was inconsistent 

Action Taken 
The presenters: 
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 Used Slide Master to control layout and formatting 
 Applied animations carefully to text and objects 
 Set slide timings for automatic transitions 
 Inserted audio and video with proper playback settings 

Outcome 
Presentations became consistent, professional, and easy to manage. 
Relevance to the Lesson 
This case reinforces all major concepts of Lesson–12 exactly as covered in the SLM. 
Analytical Questions 

1. Why is Slide Master important for presentation consistency? 
2. How do animations enhance slide content when used properly? 
3. What is the role of slide timings in automated presentations? 
4. Why should audio and video be managed carefully in slides? 
5. How do multimedia features improve presentation effectiveness? 

 
1.5 SELF-ASSESSMENT QUESTIONS 
 
A. Short-Answer Questions (5) – with Answers 

1. What is Slide Master? 
A feature used to control the overall design and formatting of slides. 

2. What are animations in PowerPoint? 
Visual effects applied to text or objects. 

3. What are slide timings? 
Controls that determine how long a slide is displayed. 

4. Why is audio used in presentations? 
To enhance explanation and engagement. 

5. What is the purpose of inserting video in slides? 
To visually explain concepts. 

 
B. Essay-Type Questions (5) – with Guiding Hints 

1. Explain the uses and advantages of Slide Master. 
Hints: Consistency, centralized control 

2. Describe different types and uses of animations in PowerPoint. 
Hints: Text, objects, sequencing 

3. Discuss the importance of slide timings in presentations. 
Hints: Automation, flow 

4. Explain the steps and importance of inserting audio and video. 
Hints: Engagement, clarity 

5. Write an essay on how multimedia features enhance PowerPoint presentations. 
Hints: Visual appeal, understanding* 

 
C. Multiple Choice Questions (5) 

1. Slide Master is mainly used to: 
a) Insert audio 
b) Control slide formatting 
c) Add charts 
d) Print slides 
Correct Answer: b 

2. Animations are applied to: 
a) Only slides 
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b) Only audio 
c) Text and objects 
d) Only backgrounds 
Correct Answer: c 

3. Slide timings control: 
a) Font size 
b) Slide duration 
c) Audio volume 
d) File size 
Correct Answer: b 

4. Audio and video in PowerPoint are used to: 
a) Reduce slide count 
b) Improve visual and auditory explanation 
c) Replace text completely 
d) Increase printing speed 
Correct Answer: b 

5. Which feature ensures consistent layout across slides? 
a) Animation Pane 
b) Slide Sorter 
c) Slide Master 
d) Notes View 
Correct Answer: c 

 
References and Suggested Readings 

A. Text Books (Printed & Published Only) 
1. Foulkes, L., Learn Microsoft Office 2021, Microsoft Press, Redmond, 2022. 
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3. Foulkes, L., Learn Microsoft Office 2019, Microsoft Press, Redmond, 2020. 
4. Humphrey, M. L., Microsoft Office 2019 Beginner, Independently Published, 2021. 
5. Cox, J. et al., 2007 Microsoft Office System Step-by-Step, PHI Learning, New Delhi, 

2007. 
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LESSON-13 

MICROSOFT ACCESS  
 
LEARNING OBJECTIVES 
 
At the end of this lesson, the learner should be able to: 

1. Explain the concept of a database as presented in the lesson. 
2. Describe the basic features of Microsoft Access. 
3. Create simple tables using MS Access. 
4. Explain the concepts of records and fields. 
5. Use MS Access for storing and retrieving data. 

 
STRUCTURE 
 

1.1  PLANNING: ENTITY IDENTIFICATION & ER SKETCH (BEFORE YOU      

         OPEN  ACCESS) 

1.2  CREATE A NEW ACCESS DATABASE (STEP BY STEP) 

1.3  CREATE TABLES — METHOD A: DESIGN VIEW 

1.4 DEFINE RELATIONSHIPS AND ENFORCE REFERENTIAL INTEGRITY 

 (STEP BY STEP) 

1.5  MS ACCESS — CREATING FORMS TO ENTER DATA & FILTERING DATA 

1.6  SUMMARY 

1.7  KEYWORDS 

1.8  SELF-ASSESSMENT QUESTIONS 

1.9  SUGGESTED READINGS 

 
1.1  PLANNING: ENTITY IDENTIFICATION & ER SKETCH (BEFORE YOU OPEN   
       ACCESS) 
 
Scenario (example): Student–Course system. Entities: Student, Course, Enrollment (junction). 
Key attributes: 

 Student(StudentID PK, FirstName, LastName, DOB, Email) 
 Course(CourseID PK, CourseName, Credits) 
 Enrollment(EnrollmentID PK, StudentID FK, CourseID FK, Grade, EnrollDate) 

Simple ER sketch (text diagram): 
[Student] 1 ----< [Enrollment] >---- 1 [Course] 
Student(StudentID PK, ...)        Course(CourseID PK, ...) 
Enrollment (Enrollment ID PK, Student ID FK, Course ID FK, Grade) 
Design note: Enrollment models the many-to-many relationship between Student and Course. 
 

Introductory Case Study: Need for Database Software in an Office 
Background of the Context 
An office maintains information related to employees, materials, and routine 
administrative records. Initially, all data was maintained in registers and separate files. 
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Contextual Situation 
As the volume of information increased: 

 Repetition of data occurred 
 Errors became frequent 
 Searching and updating records was time-consuming 

To overcome these issues, the office adopted Microsoft Access to organise data in a 
structured manner. 
Stakeholders Involved 

 Office staff 
 Data entry operators 
 Supervisory staff 

Issues Highlighted 

 Difficulty in managing large amounts of data 
 Lack of systematic data storage 
 Delays in retrieving information 

Why This Case Is Important for the Lesson 
The case clearly shows why a database and MS Access are introduced, exactly 
matching the lesson’s emphasis on basic database concepts and MS Access 
features. 
Linkage to Lesson Concepts 

 Meaning of database 
 Introduction to MS Access 
 Tables, records, and fields 

 
 
1.2 Create a new Access database (step by step) 

1. Open Microsoft Access. 
2. On start screen choose Blank desktop database. 
3. In the right pane type CollegeDB.accdb (or your preferred name). 
4. Click Create. Access opens with a default table named Table1. 

Diagram (startup): 
Access Start → Blank desktop database → Name file → Create 
 
1.3 Create tables — Method A: Design View 
Create Student table 

1. In the left Navigation Pane right-click → New → choose Table Design (or Home → 
View → Design View). 

2. In design grid add fields: 
Field Name Data Type Description / Properties 

StudentID AutoNumber Set Primary Key (right-click row → Primary Key) 

FirstName Short Text Field Size 50, Required = Yes 

LastName Short Text Field Size 50, Required = Yes 

DOB Date/Time Format = Short Date 

Email Short Text Field Size 100, Indexed = Yes (No Duplicates) 
3. Save → name Student. 

Diagram (Student table design): 
Student (Table) 



MBA Hospital Administration                                   229          Information Technology for Healthcare…  

229 
 

+-----------+-----------+---------------------+ 
| Field     | Type      | Key/Props           | 
+-----------+-----------+---------------------+ 
| StudentID | AutoNum   | PK                  | 
| FirstName | ShortText | Required            | 
| LastName  | ShortText | Required            | 
| DOB       | Date/Time |                     | 
| Email     | ShortText | Indexed (No Dups)   | 
+-----------+-----------+---------------------+ 
Create Course table 
Fields: 

 CourseID — AutoNumber — PK 
 CourseName — Short Text (100) — Required 
 Credits — Number (Integer) — Default Value 3 

Save as Course. 
Create Enrollment table (junction) 
Fields: 

 EnrollmentID — AutoNumber — PK 
 StudentID — Number (Long Integer) — will be FK to Student.StudentID 
 CourseID — Number (Long Integer) — will be FK to Course.CourseID 
 EnrollDate — Date/Time — Default Value = Date() 
 Grade — Short Text (5) or Number depending on grading scheme 

Save as Enrollment. 
Important: Use the same numeric type for FK fields as PK fields (AutoNumber PKs are 
referenced as Number Long Integer in Access when building FKs manually). 
 
Set Primary Keys & Indexing 

 In Table Design view select the StudentID row → click Primary Key on the toolbar. 
Do this for CourseID and EnrollmentID. 

 To speed lookups, set Indexed = Yes (No Duplicates) on fields like Email or unique 
codes. 

 
1.4 Define Relationships and enforce Referential Integrity (step by step) 
Open Relationships window 

1. Click Database Tools → Relationships. 
2. If prompted to add tables, add Student, Course, Enrollment. 

Create Student → Enrollment relationship 
1. Drag Student.StudentID onto Enrollment.StudentID. 
2. The Edit Relationships dialog appears. 
3. Check Enforce Referential Integrity. Optionally check Cascade Update Related 

Fields and Cascade Delete Related Records (use with caution). 
4. Click Create. 

Create Course → Enrollment relationship 
1. Drag Course.CourseID onto Enrollment.CourseID. 
2. Enforce Referential Integrity and Create. 

Relationship diagram (Access Relationships window simplified): 
[Student] 1 ----< [Enrollment] >---- 1 [Course] 
Student.StudentID PK  Enrollment.StudentID FK 
Course.CourseID  PK  Enrollment.CourseID FK 
(Referential Integrity enforced) 
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Cardinality: Student 1 → * Enrollment; Course 1 → * Enrollment. 
 
Additional Access conveniences 
Lookup fields (not always recommended for normalization) 
You can create a Lookup in the Enrollment table design so StudentID displays student names: 

 In Enrollment Design View, set StudentID Data Type to Lookup Wizard → choose 
"I want the lookup field to get values from another table" → Student table → display 
FirstName + LastName. 
Note: While convenient, lookup fields hide the FK numeric value and can complicate 
SQL; prefer joins in queries for learning. 

Input Masks and Validation Rules 
 For Email you can set a Validation Rule or use event code in forms. 
 For Phone numbers use Input Mask (e.g., (999) 000-0000). 

Default Values and Required fields 
 Set Default Value for EnrollDate to Date(). 
 Set Required = Yes for fields that must have values. 

 
Enter sample data (Datasheet View) 

 Double-click table to open in Datasheet View and enter sample rows for Student and 
Course first, then insert Enrollment rows referencing existing StudentID and CourseID. 

 If referential integrity is enabled, Access will prevent inserting an Enrollment that 
references a non-existent StudentID or CourseID. 

Sample data (text table): 
Student 
ID | FirstName | LastName 
1  | Rahul     | Sharma 
2  | Anjali    | Rao 
 
Course 
ID | CourseName   | Credits 
1  | Database 101 | 3 
2  | Networks     | 4 
 
Enrollment 
ID | StudentID | CourseID | Grade 
1  | 1         | 1        | A 
2  | 2         | 2        | B 
 
Test referential integrity & cascade behavior 

 Try deleting Student with ID 1. If Cascade Delete was checked, related Enrollment 
rows will be deleted automatically. If not, Access blocks deletion until child records 
removed — protecting data integrity. 

 
Run queries to join tables (using Query Design or SQL) 
Query Design (GUI) 

1. Create → Query Design → add Student, Enrollment, Course. 
2. Drag fields: Student.FirstName, Student.LastName, Course.CourseName, 

Enrollment.Grade. 
3. Run → shows joined results. 

SQL example (Access SQL dialect) 
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SELECT s.FirstName, s.LastName, c.CourseName, e.EnrollDate, e.Grade 
FROM (Student AS s 
      INNER JOIN Enrollment AS e ON s.StudentID = e.StudentID) 
      INNER JOIN Course AS c ON e.CourseID = c.CourseID; 
 
Normalization & design checks (short) 

 Ensure atomic fields (no multiple values in one field). 
 Avoid storing derived or repeating groups (use separate tables). 
 Student–Course–Enrollment is normalized: student info stored only once, relationships 

stored in Enrollment. 
 
Creating Forms & Reports (brief) 

 Forms: Create → Form Wizard or Blank Form. Use forms for data entry, hide the raw 
table structure, and enforce validation. 

 Reports: Create → Report Wizard for printable output (e.g., class lists, grade reports). 
 
Best practices & tips 

 Use AutoNumber surrogate keys for simplicity and stable PKs. 
 Enforce Referential Integrity to prevent orphan records. 
 Avoid overusing Lookup fields in table design; use them on forms for friendly display. 
 Keep consistent data types between PK and FK fields. 
 Back up the .accdb before big changes (compact & repair via File → Info). 
 Name objects clearly: tblStudent, tblCourse, tblEnrollment, qryStudentEnrollments, 

frmStudent. 
Troubleshooting common issues 

 FK insert fails → you’re referencing a non-existent PK or referential integrity blocks 
it. Insert parent first. 

 Lookup shows blank → check the Row Source of lookup and that related table 
contains data. 

 Cascade delete removed too much → undo and reconsider cascade settings. 
 Performance sluggish with many records → Access is best for small/medium 

datasets; consider SQL Server for large scale. 
 
Classroom exercise (lab) 
Task: Build LibraryDB with Book, Member, Borrow tables. 
Steps students should follow: 

1. Create new Access DB LibraryDB.accdb. 
2. Create Book (BookID AutoNumber PK, Title, Author, ISBN). 
3. Create Member (MemberID AutoNumber PK, Name, Phone). 
4. Create Borrow (BorrowID PK, BookID FK, MemberID FK, BorrowDate, ReturnDate). 
5. Define relationships with Referential Integrity (no cascade delete). 
6. Enter sample data and write a query that shows Member Name, Book Title, 

BorrowDate. 
7. Produce a simple report of current borrowed books. 

Expected deliverable: ER diagram, three tables with data, working query, and a short reflection 
on why Enrollment/Borrow table is necessary. 
 
Activity 1: Concept Identification 
Task: 
Identify whether the following refer to a table, record, or field. 
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…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Clear understanding of database components. 
 
1.5 MS ACCESS — Creating Forms to Enter Data & Filtering Data 
 
Prerequisite 
You should already have tables created (e.g., Student, Course, Enrollment) with primary keys 
and foreign keys. If not, create those first (see earlier MS Access materials). 
 
1. Types of Forms in Access (quick summary) 

 Simple Form / AutoForm (Form View): Quick form generated automatically. 
 Form Wizard: Guided creation with layout choices. 
 Design View (Blank Form): Full control — place controls exactly where you want. 
 Split Form: Shows Form view + Datasheet view simultaneously. Good for editing one 

record while scanning others. 
 Continuous Form: Shows multiple records in a stacked layout (like repeating detail 

rows). 
 Popup / Modal Forms: Small windows for data entry or messages. 

 
2. Example scenario & goal 
We will build a Student data-entry form and a Student Enrollments form that includes a 
subform showing courses the student has enrolled in. We'll also build filters and a search box 
on the Student form. 
Tables used: 

 Student(StudentID PK, FirstName, LastName, DOB, Email) 
 Course(CourseID PK, CourseName, Credits) 
 Enrollment(EnrollmentID PK, StudentID FK, CourseID FK, EnrollDate, Grade) 

 
3. Step-by-step: Create a basic form using Form Wizard 
A — Using Form Wizard (fast start) 

1. In Access ribbon → Create → Form Wizard. 
2. Choose table/query: select Student. 
3. Move fields you want on the form (e.g., StudentID, FirstName, LastName, DOB, 

Email) to the Selected list. 
4. Click Next → Choose layout (Columnar is good for single-record forms). 
5. Click Next → Give the form a name, e.g., frmStudent. 
6. Click Finish. Access opens the form in Form View ready for data entry. 

Diagram (wizard flow): 
Create → Form Wizard 
    Student table -> select fields 
    Next -> Choose layout (Columnar) 
    Next -> Name form (frmStudent) 
    Finish -> Form View 
 
4. Step-by-step: Create a custom Blank Form (Design View) — more control 
B — Blank Form → Design View 
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1. Create → Blank Form. Access shows a blank canvas and the Field List. 
2. From Field List pane drag fields (FirstName, LastName, DOB, Email) onto the form 

canvas. 
3. Use Design and Arrange tabs to position controls (text boxes, labels). 
4. Set StudentID control as a bound control (Control Source = StudentID). Usually 

StudentID is AutoNumber; you may hide it or set it ReadOnly. 
5. Format fonts, add a title label and set tab order (Design → Tab Order). 
6. Save form as frmStudent_Design. Switch to Form View to test. 

Diagram (simple form layout ASCII): 
+---------------------------------------------+ 
| [Label: Student Details]                    | 
|                                             | 
| First Name: [___________]                   | 
| Last Name : [___________]                   | 
| DOB       : [  dd/mm/yyyy  ]                | 
| Email     : [______________________]        | 
| [Save Button]  [New Record]  [Delete]       | 
+---------------------------------------------+ 
 
5. Add controls & set properties (important fields) 
Controls you will use 

 Text Box — for text and dates (bound to a field via Control Source). 
 Combo Box — for selecting from a list (good for Course selection in Enrollment). 
 List Box — multi-select options. 
 Command Button — run macros/VBA (Save, New, Delete, Close). 
 Subform/Subreport — embed a subform showing related records (Enrollments). 
 Label — static text. 
 Image — logo. 

Setting properties (Property Sheet) 
 Control Source: bind control to a field (e.g., FirstName). 
 Name: give a meaningful name like txtFirstName, cboCourse. 
 Format: date formatting, input masks. 
 Enabled / Locked: control editing. 
 Visible: hide controls like PK. 
 Default Value: e.g., Date() for EnrollDate. 
 Validation Rule / Validation Text: enforce data rules. 

Tip: Right-click control → Properties to open Property Sheet. 
 
6. Create combo box for lookups (recommended for FK fields) 
Use case: select Course when creating an Enrollment record 

1. On Enrollment form in Design View, Create → Combo Box. 
2. Wizard options: choose “I want the combo box to get the values from another table or 

query.” 
3. Select Course table, choose CourseID and CourseName. 
4. Choose to hide key column (so user sees CourseName), but Control Source remains 

CourseID. 
5. Name the control cboCourse. 

Diagram (combo box mapping): 
cboCourse shows: [Database 101] 
but stores: CourseID = 1  (Control Source=CourseID) 
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7. Add a subform for Enrollments in the Student form (one-to-many) 
Why a subform? 
A subform displays the many side (Enrollment) for the current Student. It’s ideal for 
viewing/editing all enrollments belonging to the displayed student. 
Steps 

1. Open frmStudent in Design View. 
2. Create → Subform/Subreport. Use the wizard. 
3. Choose “Use an existing form” (create a form for Enrollment first, e.g., 

frmEnrollment_Continuous). Alternatively the wizard can create a datasheet subform. 
4. When asked, choose the relationship: StudentID in Student → StudentID in Enrollment 

(Link Master Fields / Link Child Fields). 
5. Finish. Resize the subform area. 

Diagram (form with subform): 
[frmStudent] 
  Student Details... 
  ------------------------- 
  Subform: [Enrollment list for current Student] 
   EnrollmentID | CourseName | EnrollDate | Grade 
   ------------------------------------------------ 
   1            | DB 101     | 2025-06-01 | A 
   2            | Networks   | 2025-07-10 | B 
Tip: Use Continuous Form or Datasheet layout for subform so multiple rows show. 
 
8. Navigation & command buttons (Create common actions) 
Add Navigation Buttons 

 In Design View → Design tab → Controls → Button (Command Button). 
 The Command Button Wizard helps create: 

o Move record buttons (First, Previous, Next, Last) — you can also add 
Navigation control from Design → Navigation Controls. 

o Add New Record: Action = Record Operations → Add New Record. 
o Save Record: Action = Record Operations → Save Record (or use VBA 

DoCmd.RunCommand acCmdSaveRecord). 
o Delete Record: Action = Record Operations → Delete Record. 

Example: Create a Search Button (macro) 
 Command Button Wizard → Miscellaneous → Run Macro. 
 Or create a simple embedded macro: On Click → RunCommand → FindDialog or use 

filtering macro (OpenForm with WhereCondition). 
 
Activity 2: Short Application Task 
Task: 
Explain why MS Access is more suitable than manual registers for storing data. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Understanding the need for databases. 
 
9. Tab order & keyboard shortcuts (usability) 
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 Design → Tab Order: set logical order users will tab through controls. 
 Useful shortcuts in form view: Ctrl + + (New Record), Ctrl + S (Save), Ctrl + F (Find), 

Ctrl + PageUp/PageDown (move record). 
 
10. Saving and testing forms 

 Save form (Ctrl + S). 
 Switch to Form View and try entering sample data. 
 Test validation rules and the behavior of combo boxes and subforms. 

 
11. Step-by-step: Filtering data in forms 
Access offers several quick and advanced filters. We'll demonstrate three common techniques. 
A — Filter By Selection (quick) 

1. In Form View, click a value in a control (e.g., LastName = “Rao”). 
2. Right-click → Filter by Selection. Access filters records that match that value. 
3. To remove filter: Home → Advanced → Toggle Filter or click Remove Filter/Sort 

in the ribbon. 
Diagram: 
[All records] -> choose 'Rao' -> Filter by Selection -> [Only records with LastName=Rao] 
B — Filter By Form (complex, multi-field) 

1. In Form View → Home → Advanced → Filter by Form. Form becomes blank for 
entering criteria. 

2. In the blank form, type criteria you want (e.g., LastName = "Rao", DOB >= 
#01/01/2000#). 

3. Click Toggle Filter (Apply). Access shows records matching all criteria (AND). 
4. For OR criteria: use the second row (click the Or row in the design) and enter alternative 

values. 
Diagram (Filter by Form): 
Filter By Form: 
 [FirstName] [LastName] [DOB] 
 Row1: Rahul     Rao      >=01/01/2000   -> Apply => matches AND 
 Row2 (OR): Anjali                      -> alternative OR option 
C — Advanced Filter/Sort (saveable filter) 

1. Form View → Home → Advanced → Advanced Filter/Sort. 
2. Access switches to a query-like grid where you can drag fields, set Sort, and criteria. 
3. After setting criteria, click Toggle Filter to apply. 
4. You can Save As Query to reuse the filter later. 

D — Using a Search Box (unbound control) 
1. Add a TextBox (name txtSearch) and a Command Button btnSearch. 
2. In the button’s On Click event, use a small macro or VBA to apply a filter: 

Macro approach (embedded macro): 
 Action: ApplyFilter 
 Where Condition: "[LastName] Like '*" & [Forms]![frmStudent]![txtSearch] & "*' OR 

[FirstName] Like '*" & [Forms]![frmStudent]![txtSearch] & "*'" 
VBA approach: 
Private Sub btnSearch_Click() 
    Dim s As String 
    s = Me.txtSearch 
    If s <> "" Then 
        Me.Filter = "[FirstName] LIKE '*" & s & "*' OR [LastName] LIKE '*" & s & "*'" 
        Me.FilterOn = True 
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    Else 
        Me.FilterOn = False 
    End If 
End Sub 
Diagram (search flow): 
User types "Rah" into txtSearch -> clicks btnSearch 
Form applies Filter => shows FirstName or LastName containing "Rah" 
 
12. Requery vs Refresh vs Repaint 

 Me.Requery reloads the form’s recordsource (useful after adding records via subform). 
 Me.Refresh refreshes current record(s) without re-running the query. 
 Repaint redraws UI. Use Me.Requery in AfterUpdate of a form that affects subform 

data. 
 
13. Using Macros for common filtering tasks (no VBA) 

 Create → Macro → Add action ApplyFilter with WhereCondition. 
 Save macro and attach to a button’s On Click property. 
 Advantage: no code required; easier for beginners and safer for locked-down 

environments. 
 
14. Example: Build a Student form with subform and search (summary of steps) 

1. Create frmStudent with fields (FirstName, LastName, DOB, Email). 
2. Add a subform control that uses frmEnrollment_Datasheet (showing CourseName 

through a lookup) and link via StudentID. 
3. Add txtSearch textbox and btnSearch button. Implement simple VBA (or macro) to 

filter FirstName/LastName on click. 
4. Add navigation buttons (New, Save, Delete) using Command Button wizard. 
5. Test: add student, go to subform and add enrollment rows, click Save, verify data in 

table. 
 
15. Best practices & usability tips 

 Use meaningful control names (txtEmail, cboCourse, subEnrollments) to make 
VBA/macros readable. 

 Keep forms clean and uncluttered; group related fields visually. 
 Use combo boxes for foreign keys but store the ID (hide the key column). 
 Validate critical fields via Validation Rule or AfterUpdate events. 
 Add help tooltips to complex fields (Control → Tooltip Text). 
 Use Split Forms for quick browsing + detailed editing. 
 Set Allow Additions, Allow Deletions properties appropriately for user roles. 
 When building search, avoid full-table filters on very large datasets — use parameter 

queries for performance. 
 
16. Common problems & troubleshooting 

 Filter returns no records: check criteria syntax, date formats (#MM/DD/YYYY# vs 
local). 

 Subform not showing records: verify Link Master/Child Fields are set to StudentID 
and that types match. 

 Combo box shows blank: check Row Source and Bound Column settings. 
 Changes not visible: use Me.Requery after inserts/updates. 
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 Form slow: avoid complex recordsource queries that return large numbers of records; 
use search to restrict result set. 

 
Activity 3: Reflective Question 
Task: 
Explain how organising data in tables improves accuracy. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Conceptual clarity on structured data storage. 
 
17. Classroom exercise (lab) 
Task A — Build Student Entry Form 

1. Create frmStudent using Form Wizard (Student table). 
2. Convert to Design View and add a search box txtSearch and button btnSearch. 

Implement the VBA search code above. 
3. Add navigation buttons and set Tab Order. 

Task B — Add Subform 
1. Create form frmEnrollment_Datasheet bound to Enrollment (include CourseName via 

lookup or join query). Save it as datasheet layout. 
2. Add frmEnrollment_Datasheet as a subform to frmStudent and set Link Master/Child 

Fields to StudentID. 
3. Test adding an enrollment via subform and verify record appears in Enrollment table. 

Deliverables: Working frmStudent with subform, search functionality, at least 5 sample 
students and 8 enrollments. 
 
1.6 SUMMARY 
 
MS Access is a relational database management system that helps users store, organize, and 
manage large amounts of data efficiently. It allows the creation of databases with tables, fields, 
and relationships to structure data logically. Forms in Access make data entry easier and more 
user-friendly. Proper use of primary keys, data types, and relationships ensures data integrity 
and supports effective data management for business, education, and research purposes. 
 
1.7 KEYWORDS 

 
Database – A collection of related data organized for easy access and management. 
Table – A structure in Access used to store data in rows (records) and columns (fields). 
Field – A column in a table that stores a specific type of data. 
Primary Key – A unique identifier for each record in a table. 
Form – A user-friendly interface for entering, editing, and viewing data in tables. 

 
Case Study for Self-Assessment: Creating and Using Tables in MS Access 
Background 
An organisation decided to store information such as names, codes, and dates in a 
computerised format for easy reference. 
Problem Situation 
Before using MS Access: 
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 Data was stored in multiple files 
 Updating information was difficult 
 Information retrieval took more time 

Action Taken 
The organisation: 

 Created tables in MS Access 
 Defined fields for each category of information 
 Stored data as records 

Outcome 
Data became organised, easy to update, and simple to retrieve. 
Relevance to the Lesson 
This case reinforces the core lesson concepts of tables, fields, and records, without 
extending beyond the SLM. 
Analytical Questions 

1. Why are tables important in a database? 
2. How do fields help in organising data? 
3. What is the role of records in MS Access? 
4. How does MS Access improve data handling? 
5. What problems may arise without a database system? 

 
1.8 SELF-ASSESSMENT QUESTIONS 
 
A. Short-Answer Questions (5) – with Answers 

1. What is a database? 
An organised collection of related data. 

2. What is Microsoft Access? 
A database application used to store and manage data. 

3. What is a table in MS Access? 
A structure used to store data in rows and columns. 

4. What is a field? 
An individual item or category of data. 

5. What is a record? 
A complete set of related fields. 

 
B. Essay-Type Questions (5) – with Guiding Hints 

1. Explain the concept of a database. 
Hints: Data organisation, storage 

2. Describe the features of Microsoft Access. 
Hints: Tables, data storage 

3. Explain the structure of a table in MS Access. 
Hints: Fields, records 

4. Discuss the importance of records and fields. 
Hints: Data accuracy, organisation 

5. Explain how MS Access helps in data management. 
Hints: Storage, retrieval* 

 
C. Multiple Choice Questions (5) 

1. Microsoft Access is an example of: 
a) Word processor 
b) Spreadsheet software 
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c) Database software 
d) Presentation software 
Correct Answer: c 

2. Data in MS Access is stored in: 
a) Slides 
b) Tables 
c) Charts 
d) Pages 
Correct Answer: b 

3. A field represents: 
a) A complete record 
b) A category of data 
c) A report 
d) A file 
Correct Answer: b 

4. A record consists of: 
a) One field 
b) Many tables 
c) Related fields 
d) One database 
Correct Answer: c 

5. MS Access helps to: 
a) Draw pictures 
b) Write letters 
c) Store and retrieve data 
d) Create slides 
Correct Answer: c 
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LESSON-14 

MICROSOFT ACCESS - QUERIES & REPORTS 
 
 
LEARNING OBJECTIVES 
 
At the end of this lesson, the learner should be able to: 

1. Explain the meaning and purpose of queries in MS Access. 
2. Describe the basic types and uses of queries. 
3. Use queries to retrieve specific information from tables. 
4. Explain the concept and purpose of reports in MS Access. 
5. Generate simple reports for presenting data. 

 
STRUCTURE 
 

1.1 INTRODUCTION TO QUERIES (DATA RETRIEVAL & MANIPULATION) 

1.2 REPORTS (PRESENTATION & PRINTING) 

1.3 SUMMARY 

1.4 KEYWORDS 

1.5 SELF-ASSESSMENT QUESTIONS 

1.6 SUGGESTED READINGS 

 
1.1 Introduction to QUERIES (Data retrieval & manipulation) 
1. What is a Query? 
A query is a saved database object that retrieves records from one or more tables (or other 
queries). In Access you build queries in Design View using a visual grid, or in SQL View 
using SQL statements. 
 
2. Query Types (quick list) 

 Select Query — retrieve rows/columns. 
 Action Queries — Make-Table, Append, Update, Delete (change data). 
 Parameter Query — prompts user for criteria at runtime. 
 Crosstab Query — pivot-style summary. 
 Aggregate (Totals) Query — SUM, AVG, COUNT, GROUP BY. 
 Union / SQL-specific queries — combine results (SQL view). 
 Pass-Through / Stored Procedure — advanced (server-side). 

 
3. Building a basic Select Query (Design view) — step-by-step 
Goal: list students with FirstName, LastName, Email sorted by LastName. 
Steps: 

1. In Access ribbon → Create → Query Design. 
2. Add table Student to the design window → Close the Add Tables dialog. 
3. Double-click fields FirstName, LastName, Email to add to the grid (or drag). 
4. In the grid, under LastName set Sort: Ascending. 
5. Click Run (red exclamation) to view results. 
6. Save query as qry_StudentList. 

Diagram (Design view simplified): 
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[Student table]         Query Grid 
  StudentID  PK  ─┐     Field: FirstName  | Table: Student | Sort: ( ) 
  FirstName       |--   Field: LastName   | Table: Student | Sort: Asc 
  LastName        | 
  Email           |--   Field: Email      | Table: Student | Sort: ( ) 
Equivalent SQL: 
SELECT FirstName, LastName, Email 
FROM Student 
ORDER BY LastName ASC; 
 
4. Using Criteria to filter records 
Example: students with LastName = 'Rao' and DOB after 01-Jan-2000 
Design grid: in LastName row put Rao; in DOB row put >#01/01/2000#. 
SQL: 
SELECT * FROM Student 
WHERE LastName = 'Rao' AND DOB > #2000-01-01#; 
Notes: 

 Dates in Access SQL use # markers. 
 Use Like with wildcards for partial matches: Like "Ra*". 

 
5. Calculated fields in queries 
Add an expression in the Field cell, e.g. full name: 
In Field row: 
FullName: [FirstName] & " " & [LastName] 
This creates a runtime field FullName. 
SQL: 
SELECT [FirstName] & ' ' & [LastName] AS FullName, Email 
FROM Student; 
 
6. Joining tables — Inner Join example 
Goal: show Student full name with CourseName and Grade (join Enrollment & Course) 
Design Steps: 

1. Create Query Design, add Student, Enrollment, Course. 
2. Ensure relationships lines show Student.StudentID → Enrollment.StudentID and 

Course.CourseID → Enrollment.CourseID (access draws them automatically if 
relationships defined). 

3. Add fields: [FirstName],[LastName],[CourseName],[Grade]. 
4. Run and save as qry_StudentEnrollments. 

SQL: 
SELECT s.FirstName, s.LastName, c.CourseName, e.Grade 
FROM (Student AS s 
      INNER JOIN Enrollment AS e ON s.StudentID = e.StudentID) 
      INNER JOIN Course AS c ON e.CourseID = c.CourseID; 
 
7. Aggregate (Totals) query — SUM / AVG / COUNT 
Example: find average marks or count enrollments per course 
Design Steps: 

1. Query Design → add Enrollment and Course. 
2. Click the Totals (Σ) button to show the Totals row. 
3. Add CourseName (Group By) and EnrollmentID (Count) or Grade with Avg if numeric. 
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4. Run. 
SQL: 
SELECT c.CourseName, COUNT(e.EnrollmentID) AS NumStudents 
FROM Course AS c 
LEFT JOIN Enrollment AS e ON c.CourseID = e.CourseID 
GROUP BY c.CourseName; 
 
8. Crosstab query (pivot-style) 
Example: Count students per course by grade 
Design Steps: 

1. Create Query Design → click Crosstab button. 
2. Add CourseName as Row Heading, Grade as Column Heading, EnrollmentID as Value 

with Count. 
3. Run and save. 

Result example (visual): 
CourseName  |  A  |  B  |  C 
----------------------------- 
DB101       | 10  | 4   | 1 
Networks    | 5   | 7   | 2 
 
9. Parameter queries (prompt user) 
Example: ask for a minimum grade 
Design: 
In Criteria row for Grade: >= [Enter minimum grade:] 
When user runs the query, a dialog prompts: Enter minimum grade: and uses the input. 
SQL: 
SELECT StudentID, CourseID, Grade 
FROM Enrollment 
WHERE Grade >= [Enter minimum grade:]; 
 
10. Action queries — Make-Table, Append, Update, Delete 
Important: Back up data before running action queries. They change data. 
A — Make-Table Query (create a new table from query results) 
Use case: make a snapshot table for reporting. 
Steps: 

1. Build Select query that returns required rows. 
2. In Design View, Query Type → Make Table. 
3. Provide new table name e.g., Snapshot_2025. 
4. Run → confirms creation. 

SQL example: 
SELECT s.StudentID, s.FirstName, s.LastName INTO Snapshot_2025 
FROM Student AS s 
WHERE s.DOB < #2005-01-01#; 
 
B — Append Query (add rows to existing table) 
Use case: import cleaned rows into master table. 
Steps: 

1. Build Select query. 
2. Query Type → Append. Choose target table. Map fields. 
3. Run. 
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SQL example: 
INSERT INTO MasterStudents (StudentID, FirstName, LastName) 
SELECT StudentID, FirstName, LastName FROM TempStudents; 
C — Update Query (modify existing records) 
Use case: increase credits for certain courses. 
Steps: 

1. Create Select query to identify target rows. 
2. Query Type → Update. In Update To row provide new expression (e.g., Credits + 1). 
3. Run. 

SQL example: 
UPDATE Course 
SET Credits = Credits + 1 
WHERE CourseName LIKE "Intro%"; 
D — Delete Query (remove records) 
Use case: remove test accounts. 
Steps: 

1. Query Type → Delete. Set criteria to target rows. 
2. Run (Access warns you before deletion). 

SQL example: 
DELETE FROM Student WHERE Email LIKE '*@test.local'; 
 
11. Saving & scheduling queries 

 Save queries with descriptive names: qry_, aq_ prefix for action queries. 
 Access doesn’t have built-in scheduling — use Windows Task Scheduler calling a 

macro/VBA or export results on a schedule via code. (Advanced topic.) 
 
12. Using Query Results as Record Source for Forms/Reports 

 When you build a form/report, set its Record Source to a saved query 
(qry_StudentEnrollments) so the UI always shows latest computed results. 

 
Introductory Case Study: Retrieving and Presenting Data Using Queries and 
Reports 
Background of the Context 
An organisation maintains its records in MS Access tables. As the volume of stored 
data increased, managers required specific information rather than complete data 
tables. 
Contextual Situation 
The organisation faced difficulties such as: 

 Searching manually through tables 
 Extracting only required records 
 Presenting information in a readable format 

To solve these problems, the organisation began using queries to retrieve selected 
data and reports to present the information clearly. 
Stakeholders Involved 

 Data entry staff 
 Supervisors 
 Managers reviewing information 

Issues Highlighted 

 Time-consuming manual data retrieval 
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 Difficulty in preparing summaries 
 Poor presentation of raw data 

Why This Case Is Important for the Lesson 
The case demonstrates the need for queries and reports, which are the core focus of 
Lesson–14, and directly aligns with the uploaded SLM. 
Linkage to Lesson Concepts 

 Queries for data retrieval 
 Reports for formatted data presentation 

 
1.2 REPORTS (Presentation & printing) 
1. What is a Report? 
A report formats query/table data for printing or PDF export. Reports support headers, footers, 
grouping, sorting, totals and charts. 
 
2. Report Types & Tools 

 Report Wizard — fast report creation using query/table. 
 Layout View — quick visual edit (drag/resize). 
 Design View — full control over controls and sections. 
 Report Header/Footer, Page Header/Footer, Group Header/Footer, Detail — 

structural sections for layout. 
 
3. Create a basic report (Report Wizard) — step-by-step 
Goal: create a report showing students with their courses and grades 
Steps: 

1. Create → Report Wizard. 
2. Choose table/query: pick qry_StudentEnrollments (or add Student & Enrollment and 

use grouping). 
3. Select fields to include (FirstName, LastName, CourseName, Grade). 
4. Choose how to view data: choose grouping — group by StudentID or LastName (so 

enrollments appear under each student). 
5. Choose sort order (LastName Asc). 
6. Choose layout (Tabular/Stepped) and orientation (Portrait/Landscape). 
7. Finish — Access creates the report. 

Diagram (report sections simplified): 
Report Header: [School Logo] [Title] 
Page Header:   [Column headings: Course | Grade] 
Group Header (Student): [Student: Rahul Sharma] 
Detail rows:    DB101 | A 
                Networks | B 
Group Footer:   [Student total/notes] 
Report Footer:  [Prepared on: date] 
Page Footer:    [Page 1 of N] 
 
4. Modify report layout (Design / Layout view) 
Common tasks: 

 Move or resize controls (labels, text boxes). 
 Add logo: Design → Image → place in Report Header. 
 Add grouping: Group & Sort pane → Add a group level (e.g., StudentID). Set group 

header/footer options. 
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 Add totals: In group/footer row add a text box with Control Source 
=Count([EnrollmentID]) or =Sum([Credits]). Use the Totals button in Design. 

 Add page numbers: Insert → Page Number (choose location and format). 
 Add a calculated control: =Format([EnrollDate],"dd-mmm-yyyy"). 

 
5. Chart in report 

 Insert chart: Design → Insert Chart (or use Chart control). 
 Set Row/Column source to query fields and configure series/labels via the Chart Data 

window. 
 Use to show totals per course or grade distribution. 

 
Activity 1: Concept Identification 
Task: 
Classify the following as query-related or report-related activities. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Clear understanding of the purpose of queries and reports. 
 
6. Grouping, sorting & totals (example) 
Example: Grouping by Course, showing average Grade 
Steps: 

1. Open report in Design View → Group & Sort → add group on CourseName. 
2. In Group Footer add a text box: =Avg([GradeNumeric]) (use numeric grade field). 
3. Label as Average Grade: and format. 

Notes: Grades often stored as text; to AVG them convert or store as numeric. 
7. Formatting for print (best practices) 

 Use Report Header for title & logo; Page Header for column headings. 
 Keep margins consistent (Page Layout → Margins). 
 Use Keep Together settings to avoid splitting grouped records awkwardly. 
 Preview before printing (File → Print Preview). 
 Use Can Grow / Can Shrink for text boxes with variable content. 

 
8. Exporting & Distribution 

 Export report to PDF: External Data → PDF or XPS. 
 Email report: File → Share → Email (or use VBA to automate). 
 Export data: save query results to CSV/Excel if recipients need raw data. 

 
9. Example: Report building flow (diagram) 
Design query -> Save as qry_ReportSource 
     ↓ 
Create Report using Wizard (select qry_ReportSource) 
     ↓ 
Open in Layout / Design View -> Add grouping, totals, logo 
     ↓ 
Add charts if needed -> Preview 
     ↓ 
Export PDF / Print 
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10. Advanced: Sub-reports (reports within a report) 

 Useful to show detail lists inside a parent report (e.g., Student details with a subreport 
listing enrollments). 

 Create subreport bound to Enrollment query; insert into parent report and set Link 
Master/Child fields (StudentID). 

Diagram (parent with subreport): 
[Parent report: Student info] 
   [Subreport control: Enrollment list for that student] 
 
11. Common report controls & their uses 

 Text Box: displays field values or expressions. 
 Label: static text (column heading). 
 Line / Rectangle: visual separation. 
 Image: logos/photos. 
 Subreport: embedded report. 
 Chart: graphical data display. 

 
12. Practical classroom exercises 
Exercise 1 — Query Practice (30–40 minutes) 

1. Create qry_StudentsAboveGrade that shows students with Grade >= B (use numeric 
mapping or text criteria). 

2. Create qry_CourseCounts that lists course name and number of enrolled students (use 
COUNT and GROUP BY). 

3. Create a parameter query qry_FilterByCourse prompting: Enter course name: and 
shows enrolled students for the chosen course. 

Exercise 2 — Action Query (15 minutes) 
1. Create a Make-Table query Snapshot_Enrolled that creates a backup table of current 

enrollments. 
2. Create an Update query to give all students in "Database 101" a grade bump of +1 point 

(use numeric grade field), then test on a copy or undo by restoring snapshot. 
 
Exercise 3 — Report (45–60 minutes) 

1. Build a report rpt_StudentsWithEnrollments grouped by Student (Student Header 
shows name & email). 

2. Add subreport listing each student’s courses. 
3. Add group footer showing number of courses per student. 
4. Add page header with logo and footer with page numbers. Export to PDF. 

 
13. Troubleshooting & tips 

 No results in query: check criteria, joins (Left Join vs Inner Join), date formats using 
#. 

 Action query fails: check permissions and always back up before running. 
 Report layout broken: use Can Grow and test with long values; check grouping 

settings. 
 Slow report: limit recordset with pre-filtered query; avoid pulling huge datasets into 

reports. 
 Charts wrong: ensure underlying query fields are numeric where needed; use 

aggregated queries as chart source. 
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Activity 2: Short Application Task 
Task: 
Explain why managers prefer reports instead of tables for reviewing data. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
Expected Learning Outcome: 
Understanding of data presentation needs. 
 
1.3 SUMMARY 
 
Queries in MS Access are used to search, filter, sort, and manipulate data from one or more 
tables. They help users extract specific information, update records, and perform calculations. 
Reports are used to present data in a structured and printable format. By using queries and 
reports, users can convert raw data into meaningful information that supports analysis and 
organizational decision-making. 
 
1.4 KEYWORDS 
 

Query – A request to retrieve or modify data from a database. 
Select Query – A query used to display specific data from one or more tables. 
Action Query – A query that makes changes to data such as update, delete, or append. 
Report – A formatted output used to present data clearly for viewing or printing. 
Filter – A tool used to display only records that meet specific conditions. 

 
Activity 3: Reflective Question 
Task: 
Explain how queries save time in data retrieval. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Conceptual clarity on selective data access. 
 
Case Study for Self-Assessment: Using Queries and Reports in MS Access 
Background 
An office stores details such as codes, dates, and quantities in MS Access tables. Managers 
frequently require filtered and summarised information. 
Problem Situation 

Before using queries and reports: 
 Staff searched entire tables manually 
 Summaries were prepared separately 
 Information was difficult to interpret 
Action Taken 

The office: 
 Created queries to extract required records 
 Used reports to present the data in a structured format 
Outcome 
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Information became easy to retrieve, understand, and use for routine review. 
Relevance to the Lesson 
This case reinforces the exact lesson content on queries and reports, without 
introducing any additional database concepts. 
Analytical Questions 

1. Why are queries necessary in a database system? 
2. How do queries help in retrieving specific data? 
3. What is the purpose of reports in MS Access? 
4. How do reports differ from tables? 
5. What problems may occur if queries and reports are not used? 

 
1.5 SELF-ASSESSMENT QUESTIONS 
 
A. Short-Answer Questions (5) – with Answers 

1. What is a query in MS Access? 
A tool used to retrieve specific data from tables. 

2. Why are queries used? 
To select required records from large data sets. 

3. What is a report in MS Access? 
A formatted presentation of data. 

4. How does a report differ from a table? 
A table stores data; a report presents data. 

5. Who mainly uses reports? 
Managers and supervisors. 

 
B. Essay-Type Questions (5) – with Guiding Hints 

1. Explain the concept and uses of queries in MS Access. 
Hints: Data retrieval, filtering 

2. Describe the importance of queries in databases. 
Hints: Efficiency, accuracy 

3. Explain the purpose of reports in MS Access. 
Hints: Presentation, readability 

4. Differentiate between tables, queries, and reports. 
Hints: Storage, retrieval, presentation 

5. Discuss how queries and reports support decision-making. 
Hints: Relevant information, clarity* 

 
C. Multiple Choice Questions (5) 

1. Queries are mainly used to: 
a) Store data 
b) Retrieve data 
c) Print reports 
d) Design tables 
Correct Answer: b 

2. Reports are used for: 
a) Data entry 
b) Data storage 
c) Data presentation 
d) Data editing 
Correct Answer: c 
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3. Queries work on: 
a) Slides 
b) Tables 
c) Charts 
d) Forms 
Correct Answer: b 

4. Reports are mainly prepared for: 
a) Data entry operators 
b) Programmers 
c) Managers 
d) Hardware engineers 
Correct Answer: c 

5. Which comes after data retrieval? 
a) Data storage 
b) Data entry 
c) Data presentation 
d) Data deletion 
Correct Answer: c 
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LESSON-15 

STATISTICAL PROGRAM FOR SOCIAL SCIENCES 
 
LEARNING OBJECTIVES 
 
At the end of this lesson, the learner should be able to: 

1. Explain the meaning and purpose of SPSS. 
2. Describe the basic features of SPSS software. 
3. Identify different data views used in SPSS. 
4. Enter and edit data using SPSS. 
5. Generate simple output using SPSS. 

 
STRUCTURE 
 
1.1 SPSS – INTRODUCTION 

1.2 SCOPE OF SPSS 

1.3 USES OF SPSS 

1.4 ADVANTAGES OF SPSS 

1.5 DISADVANTAGES OF SPSS 

1.6 IMPORTANT FEATURES OF SPSS 

1.7 SUMMARY 

1.8 KEYWORDS 

1.9 SELF-ASSESSMENT QUESTIONS 

1.10 SUGGESTED READINGS 

 
1.1 SPSS – INTRODUCTION 
 
SPSS stands for Statistical Package for the Social Sciences. It is a powerful software 
application used for statistical data analysis. SPSS is widely used by researchers, students, 
healthcare professionals, business analysts, and social scientists to analyze quantitative data 
and generate accurate statistical results. The software provides an easy-to-use, menu-driven 
interface where users can enter, edit, and analyze data without needing advanced programming 
skills. SPSS was originally developed in 1968 and is now maintained and distributed as IBM 
SPSS Statistics by IBM. It supports data management, statistical analysis, and graphical 
representation of data, making it one of the most trusted tools in research and analytics. 
 

Introductory Case Study: Using SPSS for Data Analysis in an Organisation 
Background of the Context 
An organisation collects numerical data related to activities such as attendance, survey 
responses, and routine records. Initially, the data was maintained manually or using 
simple spreadsheet files. 
Contextual Situation 
As the amount of data increased: 

 Manual analysis became time-consuming 
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 Errors occurred during calculations 
 Output was difficult to interpret 

To improve accuracy and efficiency, the organisation adopted SPSS for basic data 
handling and analysis. 
Stakeholders Involved 

 Data entry staff 
 Supervisors 
 Managers reviewing results 

Issues Highlighted 

 Difficulty in managing large datasets 
 Inconsistent results from manual calculations 
 Lack of structured output 

Why This Case Is Important for the Lesson 
The case illustrates why SPSS is introduced as a statistical software, directly 
aligning with the lesson’s focus on basic SPSS features and usage. 
Linkage to Lesson Concepts 

 Introduction to SPSS 
 Data entry and editing 
 Generating output 

 
1.2 Scope of SPSS 
 
The scope of SPSS is very broad and extends across multiple academic and professional fields. 
In education and academic research, SPSS is used to analyze survey results, experimental data, 
and thesis or dissertation datasets. In healthcare and medical research, it is used for clinical 
studies, epidemiological research, and hospital quality improvement projects. In business and 
management, SPSS helps in market research, customer satisfaction analysis, sales forecasting, 
and financial analysis. In social sciences such as psychology, sociology, and political science, 
SPSS is used for behavioral studies and policy research. Government organizations also use 
SPSS for census data analysis and public welfare studies. Because of this wide applicability, 
SPSS is considered a versatile and industry-relevant statistical tool. 
 
1.3 Uses of SPSS 
SPSS is primarily used for managing and analyzing data. It allows users to enter raw data 
manually or import data from Excel, CSV files, and databases. Users can clean and transform 
data by handling missing values, recoding variables, and creating new variables using 
mathematical formulas. SPSS is widely used to calculate descriptive statistics such as mean, 
median, mode, standard deviation, and frequency distributions. It is also used to perform 
inferential statistical tests like t-tests, ANOVA, correlation, regression analysis, and chi-square 
tests. In addition, SPSS is used to create visual outputs such as bar charts, pie charts, line 
graphs, and histograms, and to generate professional statistical reports. 
 
1.4 Advantages of SPSS 
One of the major advantages of SPSS is its user-friendly graphical interface, which makes it 
suitable for beginners and non-programmers. Users can perform complex statistical operations 
through simple menu selections. SPSS can handle large datasets efficiently and provides strong 
data management capabilities such as sorting, filtering, merging, and transforming data. 
Another major advantage is the reliability and accuracy of statistical results, which makes it 
widely accepted in academic and professional research. SPSS also provides high-quality tables 
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and charts that are ready for inclusion in reports and publications. In addition, it offers extensive 
documentation and community support. 
 
1.5 Disadvantages of SPSS 
Despite its strengths, SPSS also has some disadvantages. The software is commercial and 
requires a paid license, which can be costly for students or small organizations. Compared to 
programming-based tools such as R or Python, SPSS offers limited flexibility for advanced 
custom analyses. It can also be slower when working with extremely large datasets. Another 
limitation is that users who rely only on the graphical interface may find it difficult to automate 
repetitive tasks unless they learn SPSS syntax. The software is also less suitable for advanced 
machine learning and big data analytics. 
 
Activity 1: Concept Identification 
Task: 
Identify whether the following activities are performed in Data View or Variable View. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Clear understanding of SPSS working environment. 
 
1.6 Important Features of SPSS 
SPSS provides two primary working views: Data View and Variable View. Data View is used 
for entering and viewing actual data values, while Variable View is used to define variable 
properties such as name, type, label, values, and measurement level. SPSS includes features 
for data transformation such as Compute Variable and Recode. It supports split-file analysis, 
weighting of cases, and handling of missing data. SPSS also allows users to save commands as 
syntax files to ensure reproducibility of analysis. The Output Viewer window displays results 
in the form of tables, charts, and logs. 
 
SPSS Data Structure (Text Diagram) 
Rows  → Cases (Individual records) 
Columns → Variables (Attributes) 
 
        Age   Gender   Score   Income 
Case 1   25      M        78     30000 
Case 2   30      F        85     40000 
Case 3   22      M        69     25000 
 
SPSS System Architecture (Text Diagram) 
+-----------------------+ 
|    Data Sources       | 
| (Excel, CSV, Database)| 
+-----------+-----------+ 
            | 
            v 
+-----------------------+ 
|   SPSS Data Editor    | 
| (Data & Variable View)| 
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+-----------+-----------+ 
            | 
            v 
+-----------------------+ 
| Statistical Processing| 
+-----------+-----------+ 
            | 
            v 
+-----------------------+ 
|     Output Viewer     | 
| (Tables & Graphs)     | 
+-----------------------+ 
 
Main Components of SPSS (Text Diagram) 
Menu Bar → File | Edit | View | Data | Transform | Analyze | Graphs 
 
Data View    <------------>   Variable View 
 
         Output Viewer (Results Window) 
 
File Types in SPSS 
SPSS uses different file formats to store data and results. The .sav file stores the dataset, .spv 
file stores output results, .sps file stores syntax commands, and .por is a portable file format 
used for data transfer between systems. 
 
Applications of SPSS (Text Diagram) 
       Education 
           | 
           v 
Healthcare → SPSS ← Business 
           | 
           v 
     Social Research 
 
 
Part A: SPSS Practical – Step-by-Step Lab Exercises 
Lab Exercise 1: Creating a New Data File 
Aim: To create a new dataset in SPSS. 
Steps: 

1. Open SPSS → Click File → New → Data 
2. Go to Variable View (bottom tab) 
3. Enter variables: 

Name Type Label Measure 

id Numeric Student ID Scale 

age Numeric Age Scale 

gender String Gender Nominal 

marks Numeric Marks Scale 
4. Click Data View 
5. Enter sample data: 
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id age gender marks 

1 20 M 75 

2 21 F 82 

3 19 M 68 
6. Save file → File → Save As → name.sav 

Diagram (Data Entry Flow): 
Variable View → Define Variables 
        ↓ 
Data View → Enter Data 
        ↓ 
Save File (.sav) 
 
Lab Exercise 2: Descriptive Statistics (Mean, Median, SD) 
Aim: To calculate basic descriptive statistics. 
Steps: 

1. Click Analyze → Descriptive Statistics → Descriptives 
2. Move variables like age and marks to the right box 
3. Click Options → Select Mean, Std. Deviation, Minimum, Maximum 
4. Click OK 

Output: Table showing mean, standard deviation, min, and max values. 
Diagram: 
Analyze 
   ↓ 
Descriptive Statistics 
   ↓ 
Descriptives 
   ↓ 
OK → Output Table 
 
Lab Exercise 3: Frequency Distribution 
Aim: To generate a frequency table. 
Steps: 

1. Click Analyze → Descriptive Statistics → Frequencies 
2. Select gender 
3. Click Charts → Bar chart → Continue 
4. Click OK 

 
Diagram: 
Frequencies → Select Variable → Charts → OK 
 
Lab Exercise 4: Correlation Analysis 
Aim: To find correlation between age and marks. 
Steps: 

1. Click Analyze → Correlate → Bivariate 
2. Move age and marks 
3. Tick Pearson 
4. Click OK 

 
Lab Exercise 5: t-Test (Independent Sample) 
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Aim: To compare marks between males and females. 
Steps: 

1. Click Analyze → Compare Means → Independent-Samples T Test 
2. Move marks to Test Variable 
3. Move gender to Grouping Variable 
4. Click Define Groups → Enter values (e.g., M and F) 
5. Click OK 

 
Lab Exercise 6: Creating Graphs 
Aim: To create a bar chart. 
Steps: 

1. Click Graphs → Chart Builder 
2. Choose Bar Chart 
3. Drag variable to X-Axis 
4. Click OK 

 
Lab Exercise 7: Recoding Variables 
Aim: To create categories from marks. 
Steps: 

1. Click Transform → Recode into Different Variables 
2. Select marks 
3. Give new name: result 
4. Define: 

o 0–49 = Fail 
o 50–100 = Pass 

5. Click OK 
 
Activity 2: Short Application Task 
Task: 
Explain why defining variables is important before entering data in SPSS. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Conceptual clarity on data structure. 
 
1.7 SUMMARY 
 
SPSS (Statistical Package for the Social Sciences) is a software tool used for data management 
and statistical analysis. It provides a user-friendly interface for entering and organizing data 
using Variable View and Data View. Users can define variable types, labels, and measurement 
levels. SPSS helps in performing basic statistical tests such as frequencies, averages, and 
simple charts, making it widely used in research, healthcare, business, and education. 
 
1.8 KEYWORDS 
 

SPSS – A software package used for data management and statistical analysis. 
Variable View – The section where variable properties such as name and data type are 
defined. 
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Data View – The spreadsheet-like area where actual data values are entered. 
Measurement Level – The type of data classification such as nominal, ordinal, or scale. 
Descriptive Statistics – Statistical methods used to summarize and describe data. 

 
Activity 3: Reflective Question 
Task: 
Explain how SPSS improves accuracy compared to manual calculations. 
…………………………………………………………………………………………………
…………………………………………………………………………………………………
…………………………………………………………………………………………………
………………………………………………………………………………………………… 
Expected Learning Outcome: 
Understanding the usefulness of statistical software. 
 
Case Study for Self-Assessment: Entering and Viewing Data in SPSS 
Background 
An office conducts a small survey and collects numerical responses. The data needs to be 
stored and viewed systematically. 
Problem Situation 
Before using SPSS: 

 Data was scattered across sheets 
 Errors occurred while editing values 
 Output was difficult to read 

Action Taken 
The office used SPSS to: 

 Enter data in Data View 
 Define variables in Variable View 
 Generate basic output 

Outcome 
Data became organised, accurate, and easier to interpret. 
Relevance to the Lesson 
This case reinforces the exact SPSS concepts covered in the lesson, without 
introducing advanced analysis. 
Analytical Questions 

1. Why is SPSS preferred for handling numerical data? 
2. What is the purpose of Variable View in SPSS? 
3. How does Data View help in data entry? 
4. Why is structured output important? 
5. What problems may arise without statistical software? 

 
1.9 SELF-ASSESSMENT QUESTIONS 
 
A. Short-Answer Questions (5) – with Answers 

1. What is SPSS? 
A software package used for statistical data analysis. 

2. What does SPSS stand for? 
Statistical Package for the Social Sciences. 

3. What is Data View in SPSS? 
A window used to enter and view data values. 
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4. What is Variable View? 
A window used to define variable properties. 

5. What is SPSS output? 
The result generated after data processing. 

 
B. Essay-Type Questions (5) – with Guiding Hints 

1. Explain the purpose and uses of SPSS. 
Hints: Data handling, analysis 

2. Describe the main features of SPSS. 
Hints: Data editor, output 

3. Explain the difference between Data View and Variable View. 
Hints: Data entry vs variable definition 

4. Discuss the importance of SPSS in data analysis. 
Hints: Accuracy, efficiency 

5. Explain the steps involved in entering data in SPSS. 
Hints: Variable definition, data entry* 

 
C. Multiple Choice Questions (5) 

1. SPSS is mainly used for: 
a) Word processing 
b) Data analysis 
c) Slide preparation 
d) Image editing 
Correct Answer: b 

2. Data View is used for: 
a) Defining variables 
b) Entering data 
c) Viewing output 
d) Printing reports 
Correct Answer: b 

3. Variable View is used to: 
a) Enter values 
b) Define variables 
c) Generate output 
d) Create charts 
Correct Answer: b 

4. SPSS output is displayed in: 
a) Data Editor 
b) Variable View 
c) Output Viewer 
d) Design View 
Correct Answer: c 

5. SPSS helps to: 
a) Increase manual work 
b) Reduce accuracy 
c) Analyse data efficiently 
d) Replace databases 
Correct Answer: c 
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